MODULE: CHECK POSITIVE PAY
(PRO-CHEX)

Client User Guide




This document is intended to provide the reader with information related to Check Positive Pay (PRO-CHEX)
Standard, Optional and upgrade features available through Check Positive Pay (PRO-CHEX) Enterprise.
These features are differentiated in this document as follows:

e Standard features will appear in regular font, as shown here.
e Optional features will appear in green, italic font, as shown here.
e Features available with PRO-CHEX Enterprise will appear in blue, bold font, as shown here.

If you see a feature within this documentation not enabled for your organization, contact us at [FI INSERT
PHONE NUMBER] for assistance.

NOTICE:

This document contains confidential proprietary information published by Alkami (formerly ACH
Alert). The information in this document is intended solely for the use of Alkami’s employees and
clients.

All rights reserved. This information may not be disclosed to any third party without the express
written permission of Alkami.

NOTE:

All screenshots used in this User Guide were obtained using Check Positive Pay (PRO-CHEX) in the
Chrome and/or Edge browser. If using Check Positive Pay (PRO-CHEX) in a different browser, certain
screens may display differently than shown in this guide. However, even though screens may appear
slightly different, the functionality remains the same across browsers.

NOTE:

As of 03/04/2023, the FPHQ platform and all modules thereon are supported for the following modern
browser only:
e Chrome: Last 4 versions
Firefox: Last 4 versions
Firefox Extended Support Release: Latest
Edge: Last 4 versions

NOTE:

The FPHQ Platform screens are best viewed and supported for desktops and laptops using approved
browsers.
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CHECK POSITIVE PAY (PRO-CHEX) FEATURES

Check Positive Pay (PRO-CHEX) is a check positive pay service designed to empower account holders
(our “Clients”) with the ability to prevent financial loss due to check fraud. This guide is intended to
provide information to Clients in choosing and using the level of protection best suited for their needs.

The Check Positive Pay (PRO-CHEX) service is highly configurable. This guide outlines all PRO-CHEX
functionality, but some features are only available if the feature has been enabled by the Financial
Institution (F1) and/or the Client user has been granted the appropriate user privilege required to access
the feature. A list of PRO-CHEX Features are set forth below.

Note: All Standard features are also included when the user has opted for the Enterprise upgrade

to PRO-CHEX.
Feature Name | Description Dependency Standard Enterprise Optional
Standard Issue items are used to match None V
Positive Pay against presented items.

The name on the check in the

“pay to the order of” line is

Payee Positive | scored against the payee Standard Positive V V
Pay name provided with the issue Pay Only

item to determine the

likelihood of a match.

This feature allows payee

scoring to be run on all

Payee Score All | transactions and provides the Payee Positive V V
Transactions | payee score along with any Pay

additional exception reasons

during item cleanup.
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Feature Name

Description

Dependency

Standard Enterprise

Optional

Support
Multiple Payee
Names

Custom Payee
Boxing

Reverse
Positive Pay

No Positive Pay

Blocked
Positive Pay

Check Positive Pay
(PRO-CHEX) can accept
multiple payee names in an
issue item file and validate
multiple payee names on
checks presented for
payment. Multiple payee
names can be placed on a
single line or multiple lines.

Payee Positive
Pay
(NOTE: Cannot
be used on
accounts with a
custom payee
box enabled)

v/

v/

In certain circumstances, an
FI may need to designate that
payee analysis focus on a
specific portion of a client’s
check stock. To assist with
this, we have introduced a tool
that allows Alkami (formerly
ACH Alert) personnel to draw
a custom box for those

Custom Payee

accounts. Enabling this Box
functionality in the Admin
Portal can affect certain
features in the Fl Portal. For
more information about this
functionality, please contact
an Alkami support or
implementation team
member.
Issue items are not used, and
all items are presented to the
Client for evaluation. No
alerting occurs unless the item V V
amount exception feature is
enabled.
Requires
. : Allow Deposits
e gronons, | andshou vV | v
of paid items Ielels
: Scheduled
Reports
Accounts are added for fraud
protection purposes only. Requi
. . equires
Issue items are ignored, and "
any checks presented on the Blockegali’/osnwe V V

account will be automatically
returned.
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Feature Name

Description

Dependency

Standard Enterprise

Optional

Item Amount
Exception

Stale Date
Monitoring

Issue File
Mapping

Additional Issue
Fields

Delete Issue
Files

Manual Issue
Entry

Cancel Issue
Items

Issuance Dual
Approval

Allows a maximum transaction
amount to be established for
an account enrolled in reverse
positive pay. If the amount is
exceeded, designated users
are alerted.

Reverse Positive
Pay
or
Standard Positive
Pay

v

v

Allows a maximum number of
days from issue to be
established on an account to
determine how long a check
can be honored for payment.

Standard Positive
Pay
Only

Allows FI and/or Client users
to select the issue file format
they will load and indicate the
location and format of the
necessary data elements.

AN

Allows Fl and/or Client users
to create and use additional
issue fields within issuance
templates.

Client Additional
Issue Fields

Allows client users to
manually enter issue items
through the user interface.

AN

Allows F| and Client to cancel
issue items from the Issue
Warehouse

SN K

If enabled at the FI level,
allows clients to designate
dual approval parameters on
issuance files loaded into the
system.

In addition, further
configurations can be made to
allow Fls to approve issue
files on behalf of their clients
using dual approval.

Approve/Reject
Issue Files

<
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Feature Name

Description

Dependency

Standard Enterprise Optional

Dual
Decisioning

Direct Send
Issue

Issuance Load
Alerts

Issuance Load
Alert Summary
Attachment

Release Issue
File

FI and Client
Notes for Pay or
Return Decision

If enabled at the Fl level,
allows clients to designate
dual approval parameters on
transaction decisioning.

Client Decision
Dual Approval

v

Allows FI to designate Clients
to send issue items directly to
the FI for the FI to deliver to
Alkami (formerly ACH Alert)
via SFTP.

Notifies designated Fl and/or
Client user when an issue file
is loaded and provides status
information.

An additional notification
option to include a .csv
attachment with a breakdown
of minimum and maximum
serial numbers, Issued, Void
and Stop counts and amounts
by Account Number of loaded
issuance items.

Fls may choose to receive a
combined issuance file
representing issuance files
submitted by all Clients on all
accounts. Issuance files that
have been system approved
prior to the Issuance File
Deadline time are released no
later than 10 minutes after the
Issuance EOD cut-off time.

When enabled for the FI
and/or Client, they can add a
note when issuing a Pay or
Return decision on an
incoming exception to be
viewable in the system for the
Client.

© 2024 Alkami Technology, Inc.
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Feature Name

Description

Dependency

Standard Enterprise Optional

Release
Issuance at
EOD

EOD Reminder
Alerts

Paid No Issue
Match

Allow Deposits

Disable Stop
Payments

This feature applies to items
that are System returned only.
Those issued items go back to
an outstanding status and can
be used again in exception
matching.

v

If enabled by the FI, sends
reminder alerts to users
regarding approaching End of
Day cut-off time for Check
Positive Pay (PRO-CHEX).

Allows an account to be
configured to display deposit
information and/or provide
deposit information in
Scheduled Reports and Active
Reconcilement.

Fls may choose to turn off the
ability for Clients to enter or
load issue items with a stop
pay status, and this flag
removes the stop pay status
value from the drop-down
options throughout the
system.
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Feature Name

Description

Dependency

Standard Enterprise Optional

Prevent New
Stops

Client
Pay & Adjust

Pay & Adjust
Amount

Pay & Adjust
Serial #

Client Pay &
Issue

Unmask
Accounts in
Reports

This Enterprise feature only
applies to Fls loading stop
payment files. With this
feature enabled, Alkami
(formerly ACH Alert) leaves all
stop payments in Check
Positive Pay (PRO-CHEX),
and no stop payments are
removed. If a new stop
payment is in the file for a
serial number that exists in
PRO-CHEX, we update the
existing Issued Item to
Stopped. If a new stop
payment is in the file for a
serial number that does not
exist in PRO-CHEX, we will
not load the item.

Allows a Client user to adjust
either the serial number or
amount of a presented item.

Allows the Client to adjust the
amount of a presented item.

Client Pay &
Adjust

Allows the Client to adjust the
serial number of a presented
item.

Client Pay &
Adjust

Allows a Client paying an item
for a no issue exception to
request the system to
automatically generate a
matching issue item to offset
the presented item.

If enabled, account numbers
within the Check reports
generated are unmasked.

© 2024 Alkami Technology, Inc.
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Feature Name

Description

Dependency

Standard Enterprise Optional

Adjusted Items
Report

Confirm Paying
Exceptions

Issue Item
Status Report

Scheduled
Reports

Scheduled
Reports Default
Delay

Designed to allow the Fl to
view all transactions adjusted
by the FI or client within the
Check Positive Pay
(PRO-CHEX) system.

v

Exception identification occurs
in a specific order. For
example, if an exception is
found for an amount
mismatch, the item will be
marked as an exception and
the payee name verification or
stale date monitoring will not
occur. If this option is enabled
and if an item is paid by a user
where the payee and/or date
checking did not occur, an
image of the check is
displayed for the user to view
and confirm the payment
action.

Allows a user to view a list of
issue items by status and date
range.

Allows a Client to receive
system generated reports on a
frequency of paid items,
outstanding issue items or
custom reports.

If enabled, the Fl designates a
default delay for report
generation. The default
appears in the account
configuration screen.
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Feature Name

Description

Dependency

Standard Enterprise Optional

Active
Account
Reconciliation

Statement
Reconciliation

Custom
Statement
Calendars

Import Wizard

If enabled, allows the Client to
compare the actions taken in
Check Positive Pay
(PRO-CHEX) against a
company’s internal accounting
system and perform some
issuance functions. Allows the
Fl to compare the actions
taken in PRO-CHEX against
the bank account/statement
for reconcilement purposes
and to perform issuance and
finalization functions.

For detailed information on
Active Reconciliation,
please refer to the Active
Reconciliation Financial
Institution User Guide.

If enabled, displays a
summary of account
statement balances and
allows for DDA miscellaneous
debits and credits to be used
in account reconciliation.

Active Full
Account
Reconciliation

If enabled, allows the Fl to set
statement calendars with
custom frequencies/end dates
for use in Active Account
Reconciliation

If enabled, allows the Fl to
import Client information into
the FPHQ platform, including
client profiles, accounts, user
privileges and Check Positive
Pay (PRO-CHEX)
configurations.

For detailed information on
the Import Wizard feature,
please refer to the Import
Wizard Financial Institution
User Guide.
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. WELCOME TO POSITIVE PAY

Check Positive Pay (PRO-CHEX) is a check positive pay service designed to prevent financial loss due to
check fraud. The table below lists the Positive Pay types available for each account enrolled in PRO-CHEX,
along with a description of expected behavior.

Check Positive Pay (PRO-CHEX) relies on clients to make daily decisions, when required, for the check activity
occurring on their accounts. When accounts are enrolled, a default setting is established for the system to return
or pay a transaction by the established end-of-day cut-off time. The last column in the table defines the default
settings available for each type of positive pay service.

Positive Pay Default Setting
Type Service Description Options

This service requires the Client to provide a list of checks issued
or voided on an account (Issue Items). The issue items for each
account must include, at a minimum, a check serial number,
amount, and status (Issued, Voided, Stopped). The Fl compares

Standard each check presented for payment (Item) against the list of issue
Positive Pay items. If an exception is identified, designated users are alerted to
make a pay or return decision.

Pay or Return

Note: This is the only form of positive pay allowed to be included
in Item Cleanup.

Clients are required to provide the payee name for each issue
item. The solution compares the name in the issue item against
the name on the “Pay to the Order of” line of the check presented
for payment. A scoring method is used to determine the likelihood
Payee Positive | of a match, and if the score falls below the established threshold,
Pay the item is flagged as an exception. Payee name scoring is
subject to many variables, including image quality. Scoring may
fail items that would otherwise pass if clients fail to perform and
conform to best practices. Please refer to Section X. Payee
Positive Pay Tips & Best Practices for more information.

Pay or Return

Check Positive Pay (PRO-CHEX) can accept multiple payee

Support ; ) 4 . ; ;
. names in an issue item file and can validate multiple payee
Multiple Payee X Pay or Return
Names names on checks presented for payment. Multiple payee names

can be placed on a single line or multiple lines.
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© 2024 Alkami Technology, Inc. Updated 04/30/2024
Proprietary and Confidential Information Page 13 of 199



Positive Pay Default Setting
Type Service Description Options
This service does NOT require clients to provide a list of issued
items. Clients should log in every day to view checks presented
for payment and select the checks to return because the concept
R of an exception does not exist, since no list of issue items is
everse . : )
Positive Pay present to compare |tgms against. However, clients may requegt Pay
the FI establish a maximum check amount per account (Exception
Limit). If this optional setting is enabled, an alert is sent to
designated users ONLY when a check is presented exceeding the
maximum amount established.
Blocked Positive Pay is an Enterprise level feature. Accounts are
Blocked added for fraud protection only. Issued items are ignored, and any Return
Positive Pay | checks presented are automatically returned. Client decisioning is

also disabled.

No Positive Pay

The client does not use Standard or Reverse Positive Pay, but
does use the Enterprise features Active Reconciliation or N/A
Scheduled Reports.

A. Alerting

Check Positive Pay (PRO-CHEX) notifies designated users to take action when required. PRO-CHEX is
designed to ensure notifications are relevant, and each client can advise the FI of their desired
notification levels.

The table below outlines a list of events that trigger an alert to a client and includes a description of the
triggering event.

Alert Type Description
Occurs when a check is presented for payment that does not match the
Exception Alert issue information provided or occurs when an exception limit is exceeded

on an account enrolled in Reverse Positive Pay.

Issuance File Load Alert

Occurs when an issue file is loaded. The alert contains status information
to indicate if the issue file loaded properly or failed to load due to errors.

Issue File Pending Approval

Occurs when the issue file is loaded and the file is being held in
“Suspended” status until approved by a secondary user.

Decision Approval Required | Occurs when check transaction decisions require a secondary approval.
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When an account is enrolled for Positive Pay, one of three levels of notification can be established for
exception alerts. The notification level options and descriptions are provided in the table below. Email
alerts are standard. Clients can also elect to receive text alerts.

Notification Level

Description

Transaction Alerts

One alert sent for each exception identified.

Account Alerts

One alert sent per account when one or more exceptions are identified.

Service Alerts

One alert sent per user when one or more exceptions are identified on one
or more enrolled accounts.

B. Issue ltems

Certain types of positive pay service require clients to maintain a list of issued items for the Fl to
compare presented items against for exception identification.

While issue items can be added after a check has been presented for payment, we recommend clients
enter or load issue items prior to disbursing paper checks to payees, as failure to do so could result in
denial of payments if the check is presented at the teller line for deposit or to be cashed.

When an issued item is entered or loaded into Check Positive Pay (PRO-CHEX), the status and
disposition of the issued item is tracked.

The table below describes the status and disposition labels associated with issue item management.

Labels Description
Issued A status defined by the client that indicates a check was issued.
. A status defined by a client that a check was issued but later voided and not
Voided L
distributed.
A status defined by a client or designated by the Fl, if the FI chooses to control
Stopped

this status.
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Labels Description

A status assigned by the Check Positive Pay (PRO-CHEX) system when an

Available for Matching issue item is entered or loaded by a client.

A status assigned by the Check Positive Pay (PRO-CHEX) system when a check
Used in Matching is presented for payment with a serial number matching a serial number for an
issued item.

A status displayed in the issue warehouse indicating a check has not been

Outstanding presented for the issued item, and the check is still available for matching.

A status displayed in the issue warehouse indicating a check has been
Paid presented against an issue item, and the check was paid by the system, Client,
or Fl.

A status displayed in the issue warehouse indicating a check has been
Returned presented against an issue item, and the check was returned by the system,
Client, or FI.

A status assigned by the Check Positive Pay (PRO-CHEX) system when an
Purged issue item not used in Matching (Outstanding) has been removed from the
system after the purge period has ended. The purge period is defined by the FI.

A status value displayed in Issue File Status indicating a loaded file was deleted
Deleted by the client or Fl user. A history of the file load and delete actions is retained,
but the issue items are removed as if they were never introduced to the system.

If an issue item is updated after loading, history is available in the issue item

SESGIEC warehouse when the drop-down for an issue item is expanded.

When a financial institution cannot process and clear a check normally, the payment becomes an exception
item requiring special handling. If Payee Positive Pay is enabled, the check image is scored through payee
name comparison. Examples of reasons a check can be flagged as an exception include Payee Mismatch,
Amount Mismatch, Voided or Stopped Status, Early Presentment, and other causes.

The client can prevent the likelihood of some issues with presented items by following industry best practices.
For more information about best practices, please refer to Section X. Payee Positive Pay Tips & Best
Practices within this document.

When an item is marked as an exception, the Check Positive Pay (PRO-CHEX) system will follow the default
exception action configured in the account regarding whether to pay or return the presented item, if no action is
taken by the client.

When an item is matched successfully and no exceptions are identified, the presented item is paid.
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Il. CHECK POSITIVE PAY (PRO-CHEX)

DASHBOARD BOX

A. Using the Dashboard

1. The Dashboard is the default landing page within the Client portal. If Check Positive Pay
(PRO-CHEX) is enabled, a PRO-CHEX box will be displayed. Summary information on current
check transactions and status will be displayed for accounts the user has been granted access.
Active links are embedded within the PRO-CHEX box to permit users to navigate from the
dashboard landing page into the PRO-CHEX service module or directly to transactions in the status
selected. Dashboard totals are updated in real time as transaction status values are changed by a

user.

The content displayed in the Check Positive Pay (PRO-CHEX) summary box includes the following:

Check Positive Pay

Exceptions $32,122.55

Set to Pay $28,560.72 (32 ] Set to Return $3,893.93

End of Day Cut-Off Time: Monday 6:00 PM EST
€ Pending Approval $2,993.93

00

Service Name

End of Day Cut-Off Time

Exceptions

Pending Approval

In the example provided, clicking Check Positive Pay (PRO-CHEX) on the left in
the title bar will direct the user to the main menu.

Displayed in the second bar, the time of day indicates when transactions that
require decisions will no longer be eligible for user decisions.

Clicking on the dollar amount hyperlink on the Exceptions line will direct the user
to a filtered view of Transaction History that will display only exceptions that
require a decision.

If Dual Decision Approval has been enabled, the Pending Approval hyperlink will
appear in the Dashboard. Clicking on the dollar amount hyperlink on the Pending
Approval line will direct the user to the Check Transaction Approval screen,
where the user can approve or reject any transactions that are pending approval
by the user. For more information about Decisioning Dual Approval, please
refer to Section VI, Decision Dual Approval.
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Exceptions $32,122.55

Setto Pay $28,560.72
System $28,560.72
User $0.00
FI $0.00

End of Day Cut-Off Time: Monday 6:00 PM EST

Set to Return
System

User

00000

FI

Pending Approval $2,993.93

$3,863.93

$0.00

$2,993.93

$900.00

Check Positive Pay

Q0000

Set to Pay / Set to

Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines

Return will expand the view to display a breakdown of the total for each category.
System Pay or Return indicate transactions that will pay or return if no action is
taken due to the default status. User pay or return indicate a Client user decision
has occurred. Fl pay or return indicate an Fl decision has occurred on behalf of

the FI.
. . Date Range
Transaction History -
EAugust 1, 2021 - August 31, 2021~
Y Filters >
181 debit transactions totaling $261,203.62
Rows 1-25 of 181.
< - 23|45
Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
> 49129 %000¢1111 12274 $127.00 Pay-System 08-31-2021 0
» 49128 0x1111 12274 $27.00  Pay-System 08-31-2021 o
> 49127 %000¢1111 12273 $35.10  Pay-System 08-31-2021 0
» 49126 xoox1111 12272 $20.00  Pay-System 08-31-2021 o}
» 43125 001111 12271 $200.00  Pay-System 08-31-2021 o)}
Transaction History The user can click on the dollar amount link for any category to be directed to a

filtered view of the Transaction History. In the above example, the user has
clicked on the dollar value of Exceptions on the Dashboard and is directed to a
view of exception transactions that require decision.

Please refer to Section VI, Subsection A, Transaction History, for more
information on this function.
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2. From the Client Dashboard, a user can navigate to the Check Positive Pay (PRO-CHEX) Module by
clicking Change Module > PRO-CHEX.

JdiReports ~ = Transaction View Change Module ~

I Check Positive Pay ]
ACH Positive Pay - Debits I
EDI Translation

f Day Cut-Off Time: Monday 6:( ACH Credit Origination Protection
ACH Positive Pay - Credits

0 Voice Biometric Wire Protection

0 ACH Returns and NOCs

B. Creating Client Users

NOTE:

e The Admin user privilege must be enabled.
e This feature is only available if 1) the Fl is allowing Clients to manage their own users, and 2) it
will only display for Client users who have been designated with Client Admin status.

A Client User with Admin user privilege can add additional Client users who will then be authorized to
use Check Positive Pay (PRO-CHEX).

1. From Client Dashboard > Click Manage Users.

Dashboard L Manage Users # Perform ~ Ji Reports ~ i= Transaction View

Version 2.2.0
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2. The Client Users page appears. Click the “Create New User” button.

Create New User [~

Select User

A BwTest, Vivian

2 client, Teresa

Please select an existing user or create a new one.

3. The New User page appears. Fill out all fields available, the click “Create User” button.

Cuthbert Allgood

First Name

Cuthbert

Email Address

cuthberta@finefeathers.com

Last Name
Allgood

Contact Phone Number Cell Phone Number
(555) 555-5555 ‘ (555) 555-5555

4. |If the user is configured for standard security login, the New User interface will display these fields.

Active

Username

95t6aXpUg

First Name

Cuthbert

Email Address

cuthberta@finefeathers.com

Cuthbert Allgood

Last Name
Allgood

Contact Phone Number Cell Phone Number
(555) 555-5555 (555) 555-5555

© 2024 Alkami Technology, Inc.
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5. If the user is configured for single sign-on, the New User interface will display these fields. Please
note that the SSO ID field can have different labels and formats based on the online banking
provider being used. The maximum number of allowable characters in the SSO ID field is limited to

50.

Active Admin (Manage other non-admin users)
S501ID

JDench
First Name Last Name

Judy Dench

Email Address Contact Phone Number Cell Phone Number

(595) 855-4858 (787) 254-1258

jdench@testbank.com

Judy Dench

6. The User profile page appears. Scroll down to the “System Roles” section of the page to select what
roles should be enabled for the user. For more information on managing user entitlements, please

refer to the Fraud Prevention HQ Client User Guide, Sections Il and lll.

System Roles

[all | none]

Notification Delivery Consolidated Pending
Report Approval View

Audit Report

Consolidated
Transaction History View

© 2024 Alkami Technology, Inc.
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7. Within the Check Positive Pay (PRO-CHEX) settings box, the alert method can be chosen. Use the
drop-down to select the alert method desired.

Check Positive Pay Alert Method: |- None - v
None- |
Email
Available Accounts Selected Accounts Email. SMS/Text
|' | SMS/ Text
2940 Doveas Aret fwvwvww 11040 How Timmac iwwwwSE88y 1
Email Client User will receive Check Positive Pay (PRO-CHEX) Alerts via Email only
Email, SMS/Text Client User will receive Check Positive Pay (PRO-CHEX) Alerts via Email and
SMS/Text
SMS/Text grl]lli/nt User will receive Check Positive Pay (PRO-CHEX) Alerts via SMS/Text

8. Choose from the list of available accounts enrolled in Check Positive Pay (PRO-CHEX) the user is
entitled to work with and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts

FFF Escrow (oood444) FFFriends Dooo1111)

=

FFF Expense (30x3333)
=

FFF Payroll (xxxx2222) -

<

9. For more information regarding Client User Privileges, please refer to Section lll. User Accounts
and Privileges.
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lll. USER ACCOUNTS AND PRIVILEGES

Additional information about creating and editing Client users can be found in the
Fraud Prevention HQ User Guide, Sections Il and Ill.

This section covers Client user privileges and alerting methods for the Check Positive Pay (PRO-CHEX)
module.

A. User Privilege Dependencies

Some user privileges are standard, and some are dependent upon features that are enabled by your
financial institution. If you see a privilege below and it does not appear in the Client user interface, the
feature has not been enabled.

Privilege User Feature Dependencies
Adjusted Items Report Client FI Enabled
Approve Issue File Client Fl Enabled
Cancel Issue Item Client Fl Enabled
Change Transaction Status Client Standard
Client Additional Issue Fields Client FI Enabled
DDA Balance Entry Client Fl Enabled
Decision Dual Approval Client Fl Enabled
Edit Issue Item Client Standard
Issue Item Status Report Client Fl Enabled
Issue Load Alerts Client FI Enabled
Issue Templates Client Fl Enabled
Issue Warehouse Client Standard
Item Lookup Client Standard
Load Issue File Client Standard
Version 2.2.0
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Privilege User Feature Dependencies
Manage Issue File Status Client Standard
Manual Issue Entry Client Standard
Paid No Issue Matching Client Standard
Pay and Adjust Client Fl Enabled
Pay and Issue Client Fl Enabled
Reconcile Accounts Client FI Enabled
Scheduled Reports Client Fl Enabled
Transaction History Client Standard
View Issue File Status Client Standard
View Reconciliation Reports Client FI Enabled
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B. Client User Privileges

NOTE:

The Admin user privilege must be enabled.

1. On the Client User page, scroll to Check Positive Pay (PRO-CHEX) service station.

2. Choose from the list of available accounts enrolled in Check Positive Pay (PRO-CHEX) the user is
entitled to work with and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts

FFF Escrow (oood444) FFFriends oom1111)

=

FFF Expense (xxxx3333)
=

FFF Payroll (xxox2222) -

<

3. Selecting Check Positive Pay (PRO-CHEX) Client User Privileges:

a. Selecting all | none
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i. By selecting all, the user is assigned all user privileges.

Uger Privileges
[g | none ]
Approve Issue File
Transaction History
Decision Dual Approval
Scheduled Reports
View Issue File Status
Pay and Adjust
View Reconciliation Reports

Load Issue File

& item Lookup

Change Transaction Status
Cancel Issue Item

Edit Issue Item

Manage Issue File Status
Pay and Issue

Issue Load Alerts

Manual Issue Entry

Issue Item Status Report
Adjusted Items Report

DDA Balance Entry

Client Additional Issue Fields
Issue Templates

Reconcile Accounts

Issue Warehouse

Paid No Issue Matching

ii. By selecting none, previously assigned user privileges are removed.

User Iiivileges
[all | none ]

L] Approve Issue File

LI Transaction History

] Decision Dual Approval

[ Scheduled Reports

[ View Issue File Status

([ Pay and Adjust

([ View Reconciliation Reports

( Load Issue File

(] Item Lookup

[J Change Transaction Status
[ Cancel Issue Item

(] Edit Issue Item

[ Manage Issue File Status
([ Pay and Issue

([ Issue Load Alerts

([ Manual Issue Entry

(] Issue Item Status Report

(] Adjusted Items Report

([ DDA Balance Entry

] Client Additional Issue Fields
(] Issue Templates

() Reconcile Accounts

(] Issue Warehouse

() Paid No Issue Matching
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iii.  Clicking in the box beside each user privilege adds or removes the checkmark from the box.
Adding a checkmark gives the user that privilege, and removing the checkmark removes the
privilege from the user.

Privilege

Description

Approve Issue File

Approve Issue File

Allows the user to approve issue files loaded by other users when a client is
configured for issuance dual approval.

NOTE: Approve/Reject Issue Files must be enabled.

Transaction History

Transaction History

Allows the user to view check transactions presented for payment. If this
privilege is enabled, the user will also have access to an item lookup
sub-menu option.

Decision Dual Approval

Decision Dual Approval

Allows the user to approve transactions awaiting an Approve or Deny
decision.

NOTE: Client Decision Dual Approval must be enabled.

Scheduled Reports

Scheduled Reports
Allows the user to download pre-defined, pre-scheduled reports.

NOTE: Scheduled Reports must be enabled.

View Issue File Status

View Issue File Status

Allows the user to view the status of issue files loaded into the system.

Pay and Adjust

Pay and Adjust

Allows the user to adjust a serial number from the value presented to a
new value and/or the amount from the amount presented to a new
value.

NOTE: Client Pay and Adjust must be enabled.
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Privilege

Description

View Reconciliation Reports

View Reconciliation Reports

Allows the user to view Reconciliation Reports set up by the Fl for
individual accounts.

NOTE: Full Account Reconciliation must be enabled.

Load Issue File

Load Issue File

Allows the user to load issue files via the Client Portal.

Item Lookup

Item Lookup

Ability to look up all recorded data on individual issued items.

Change Transaction Status

Change Transaction Status

Requires Transaction History user privilege. Allows a user to change the
status of a transaction from return to pay or pay to return.

Cancel Issue Item

Cancel Issue Item

Can cancel issue items from the Issue Warehouse.

NOTE: Cancel Issue Item must be enabled.

Edit Issue Item

Edit Issue Item
Allows a client user to modify issue items.

NOTE: Issue Warehouse privilege must be enabled

Manage Issue File Status

Manage Issue File Status

Ability to edit parse errors in the file or delete issue files.

Pay and Issue

Pay and Issue

Allows a client to allow the system to create an issue item they failed
to send in.

NOTE: Client Pay and Issue must be enabled.

Issue Load Alerts

Issue Load Alerts

Will receive success or failure alerts when Clients load issue files.

NOTE: Issue Load Alerts must be enabled.
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Privilege

Description

Manual Issue Entry

Manual Issue Entry
Allows the user to manually create an issue item.

NOTE: Manual Issue Entry must be enabled.

Issue Item Status Report

Issue Item Status Report

Allows the user to view issued items by status for a specific date or date
range.

NOTE: Issue Item Status Report must be enabled.

-

Adjusted Items Report

Adjusted Items Report

Can view items adjusted during the cleanup process or during client
decisioning.

NOTE: Adjusted Items Report must be enabled.

DDA Balance Entry

DDA Balance Entry

Allows the user to enter DDA balances for account reconciliation. Only
applies to Client-Led Active Reconciliation (“Recon Light”)

NOTE: Client Statement Reconciliation must be enabled.

Client Additional Issue Fields

Client Additional Issue Fields

Allows the user to create Additional Issue Fields within Issuance File
Templates.

NOTE: Additional Issue Fields must be enabled.

Issue Templates

Issue Templates

Allows a user to create a template defining the format of the issue file they
will load, including the format and location for the data elements to be
provided in the file. If this privilege is enabled for a user, the user can
manage additional issue fields.

NOTE: Issue File Mapping must be enabled.

-

Reconcile Accounts

Reconcile Accounts

Provides the client user the ability to view past and present
reconciliation periods set up by the Fl for individual accounts.

NOTE: Client Statement Reconciliation must be enabled.
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Privilege Description

Issue Warehouse

Issue Warehouse

Allows the user to view issue items and history.

Paid No Issue Matching

Paid No Issue Matching

Ability to match issue items loaded to the system after cleanup has been

performed to Pay No Issue exception items.

4. Select Save User.

a. Success message appears.

User Saved
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IV. MANAGING ISSUE ITEMS

Certain types of positive pay services require Clients to maintain a list of issued items for the financial
institution to compare presented items against so exceptions can be identified.

While issue items can be added after a check has been presented for payment, it is highly recommended that
Clients enter or load issue items prior to disbursing paper checks to payees, as failure to do so could result in
denial of payment if the check is presented at the teller line for deposit or to be cashed.

If issue items are entered or loaded on accounts configured for positive pay types that do not require a list,
Check Positive Pay (PRO-CHEX) will ignore them.

When an issued item is entered or loaded into Check Positive Pay (PRO-CHEX), the status and disposition of
the issued item is tracked. The table below describes the status and disposition labels associated with issue

item management.

Labels Description
Issued A status defined by the Client that indicates a check was issued.
. A status defined by a Client that a check was issued but later voided and not
Voided L
distributed.
A status defined by a Client or designated by the Fl, if the Fl chooses to control this
Stopped
status.
A status defined by a Client or Fl user to indicate an issued check is to be cancelled
Cancelled

Available for
Matching

Used in Matching

Outstanding

Overwritten

and removed from the outstanding issue items in the Issue Warehouse.

A status assigned by the Check Positive Pay (PRO-CHEX) system when an issue
item is entered or loaded by a Client.

A status assigned by the Check Positive Pay (PRO-CHEX) system when a check is
presented for payment with a serial number matching a serial number for an issued
item.

A status displayed in the issue warehouse indicating a check has not been presented
for the issued item, and the check is still available for matching.

A status displayed if a subsequent issuance file load contained an item which has
overwritten this item with an update to either the Payee Name or Amount.
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Paid A status displayed in the issue warehouse indicating a check has been presented
against an issue item, and the check was paid by the system, Client user, or FI.

A status displayed in the issue warehouse indicating a check has been presented

Returned against an issue item, and the check was returned by the system, Client user, or FI.

A status assigned by the Check Positive Pay (PRO-CHEX) system when an issue
Purged item not used in Matching (outstanding) has been removed from the system after the
purge period has ended. The purge period is defined by the financial institution.

A status value displayed in Issue File Status indicating a loaded file was deleted by a
Deleted Client or Fl user. A history of the file load and delete actions is retained, but the issue
items are removed as if they were never introduced to the system.

If an issue item is updated after loading, history is available in the issue item
Updated ; ; .
warehouse when the drop-down for an issue item is expanded.

A. Test Mode

Clients can request the FI enroll accounts with an inactive status and grant users’ access to the system

to test issue file load. Issue items loaded while in test mode are marked as test issue items and will not

be displayed in the issue warehouse or used for matching against presented checks. Clients must notify
the Fl when testing has been completed and they wish the account to be active.
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Issued items can have a status of Issued, Voided or Stopped.

1.

Issued: The check has been issued and distributed for payment.

Voided: The check has been voided by the maker. A check is usually voided prior to disbursement. A
voided check cannot be used to make a payment or withdraw money from the account.

Stopped: A check that has a stop payment placed on it. A stop payment is placed by a financial
institution to cancel a check that has not yet been processed.

Cancelled: A check that has been issued and a client user or Fl user has opted to cancel the item.
The outstanding issue item will be removed from the Issue Warehouse.

Disable Stop Payments: The FI may choose to Disable Stop Payments in their configuration settings.
The FI may choose to do this because they prefer to update those items in their core banking
system.

If stop payments are enabled, the client user can:

e |oad issue files with stopped status items
e Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided
e Change a previously Stopped item to Issued or Voided via Issue Warehouse

If stop payments are disabled, the client cannot:

e Load issue files with stopped status items
e Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided
e Change a previously Stopped item to Issued or Voided via Issue Warehouse.
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NOTE:

The Manual Issue File user privilege must be enabled.

If the FI enables this feature, Clients can manually enter a list of checks that have been issued. To manually
enter an issue item, the user must be granted the manual issue entry user privilege.

The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the
field to display and how the information entered will be used to identify exceptions when matching issue items to
checks presented for payment.

Field

Criteria

Use

Serial #

Amount

Payee
Name

Status

Issuance
Date

Additional
Issue
Fields

The check number/serial # is always required.

To identify if the check was issued
or presented more than once.

A dollar value is always required.

Used to identify if the amount of a
check has been altered.

The person(s) or entities to whom the check was intended to pay.
The field will support entry of multiple payee names (maximum of
4 allowed) by clicking “Enter” to input another name on the next
line.

This feature is optional, and the field will only appear for
accounts configured for payee positive pay. If this feature is
enabled, when a payee is required in an issuance file, values
consisting of only white space (ex., all spaces) will be
considered the same as an empty value and will not be
accepted.

This field supports both alphabetic and numeric characters.

Multi-Line Payee Names cannot be utilized on accounts that
have a Custom Payee Box enabled.

Used to identify if the name in the
“Pay to the order of” line has been
altered.

Each check should be accounted for, even checks that have
been voided or have had a stop payment issued. The status
value advises the Fl if a check has been issued and distributed,
issued, later voided and not distributed or issued, distributed and
stop payment order was requested later. The issued and void
status values will always be available for selection. The stopped
status will only appear if the Fl has enabled this option for Client
designation.

Used to determine if a check
should be analyzed for matching
(issued) or if a check was
presented for payment that was
previously voided or stopped.

A date the check was issued and valid for payment is always
required. The issuance date will always default to the current
date, but the user can assign a back or future date.

Used to determine if a check is
presented earlier than intended or
later than allowed.

Only available if the Issue Templates user privilege is turned on
for a user. Additional issue fields are typically used if a Client
requires Check Positive Pay (PRO-CHEX) to retain information
related to the issued item for reconciliation purposes.

Used for account reconciliation
purposes. Example: An invoice #
associated with a check.
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1. From the Check Positive Pay (PRO-CHEX) module, click Perform > Manual Issue Entry.

[
!
L

Check Positive Pay = #Manage ~ = # Perform ~  JiReports ~

Issue File Load

mmp| Manual Issue Entry |
Wel CO m e Transaction Approval

- ) L Active Reconciliation
Please use the above menu to sele

Paid No Issue Match

2. The Manual Issue File Entry screen appears.

Manual Issue Entry

Account’ Auto populate next check number:
- not selected - v
Row Serial Number Amount Payee Name’ Status Issuance Date
/I 0.
ISSUED y 03/03/2021

@ Click any row to select that row for editing

Save

Account Select appropriate Account Number from the drop-down menu.

Auto populate When checked, the next check number will auto-populate in the following row. This
next check feature is designed to eliminate serial number entry when checks are issued in
number sequential order.

When unchecked, the next check number will remain blank until it is filled in by the

user.

Row Each issue item will be numbered in the order they are entered. Once the cursor is
placed in the current row, an additional row will appear for the next entry.

Serial Number Type the item serial number for this manual issuance file in the Serial Number field.

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up

and down arrows in the Amount field to select a dollar amount.
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Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee
Name field supports the entry of a single payee, or multiple payees.

This field supports both alphabetic and numeric characters.

Please see Step #3 below for in-depth information about the Payee Name field
and Multiple Payee Names.

Status Issued The check has been issued.
Voided The check has been voided by the maker.
Stopped The check has had a stop payment placed on it.

If the FI has disabled stop payments, the Stopped status option will not appear in
the drop-down menu.

Issuance Date Click on the Issuance Date field and select a date from the calendar that this item was
issued. On accounts configured for Active Account Reconciliation, the Manual Issue

Entry screen will not permit selecting a date prior to the start date of the current
reconciliation period.

3. Payee Names: The Payee Name field supports up to four Payees.

a. Click within the Payee name field to enter Payee Name(s).

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 ISSUED b = 03/02/2024

b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field
box. The feature may not be available based upon the browser used.

Row Serial Number Amount Payee Name’ Status Issuance Date
L 10100 300.00 ISSUED v & 03/02/2024
4_
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c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must
be used to input a second, third or fourth payee on separate lines in the field for it to be
distinguished as different payees.

Row Serial Number Amount Payee Name’ Status Issuance Date
L 10100 300.00 Helen Jones ISSUED v E | 03/02/2024
Michael Jackson
Francine Doe
Lisa Miller

This functionality will not be available if the Fl has enabled Custom Payee Boxing for an
account.

If multiple payees are listed on a single line of the check, putting them on separate lines is not
applicable.

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 Helen Jones & Lisa Mi\leri ISSUED hd = 03/02/2024

d. The Payee Name field currently supports 500 alphanumeric characters in total. This count will
include the carriage returns separating multiple payees. The 500-character limit is for the entire
field, and not per payee.

Although 500 characters are allowed in this field, names might be truncated if using a
fixed width template and the number of characters allowed in that column are less than
500.

e. If Payee Positive Pay is enabled, the Payee Name field will not accept blank entries for items
with Issued status, and will give an error message if an entry is attempted to be saved without a
Payee Name.

Payee Name is required unless status is VOIDED.

4. To edit any row, click in the fields to be edited and make changes.

5. When all manual issuance files have been entered, click Save button.
Version 2.2.0
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6. The Manual Issuance File Status detail page appears.

< Back to Status MANUAL_1617197309551

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items.

@® View items: 2 Items totaling $80,001.00 Load Date: 03/31/2021 09:28:29 EDT
Rows 1 -2 of 2.
Account Number Serial Number Amount Payee Name Status Issuance Date
xox1111 40000 $40,000.00 Formula 1 AVAILABLE_FOR_MATCHING 03/31/2021
wox 1111 40001 $40,001.00 Lewis Hamilton AVAILABLE_FOR_MATCHING 03/31/2021
Delete
Load Date Date and time the file was loaded.
Account Number The account number on each issue item.
Serial Number The serial number of the issue item.
Amount The amount of the issue item.
Payee Name Name of the payee(s) from the issue item.
Status Available_For_Matching The issued item is available for exception matching
against an incoming check.
Duplicate Issuance This issued item is a duplicate and has already been
issued.
Used in Matching This issued item has been used in the exception

matching against an incoming check.
Issuance Date Date the item was issued.

7. Click the Back to Status button to view the Issuance File Status page. For more information,
please refer to Subsection G, Issue File Status.
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8. lssuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the Fl. In
this circumstance, manual entry files must be approved by a second client user or, if no second user
is available to approve the file, the client can request the Fl approve the issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the
Issuance Dual Approval process.

9. Disable Stop Payments: When the Fl has disabled stop payments, client users cannot create new
stopped issue items or modify previously stopped issue items. The Fl can, however, feed stop pay
items from the core banking system.

a. If a user attempts to create a manual entry item with a serial number the FI has loaded a stop
pay on, the system will not accept the item.

< Back to Status MANUAL_1614874619362

File Status

Queued Processed Approved / Rejected Completed Deleted

Some items are ineligible. View list below to see items. Remove ineligible items and reload file

® view items: 3 Items totaling $1.375.00 Load Date: 03/04/2021 11:16:59 EST
Rows 1-3of 3.
Account Number Serial Number Amount Payee Name Status Issuance Date
w3232 100945 $525.00 Moe Green INELIGIBLE_FOR_MODIFICATION 03/04/2021
3232 100946 $500.00 River Rouge INELIGIELE_FOR_MODIFICATION 03/04/2021
w3232 100949 $350.00 Margaret Anjou INELIGIBLE_FOR_MODIFICATION 03/04/2021
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The purpose of issue templates is to make it easy to load issue items into Check Positive Pay (PRO-CHEX)
using files that can be generated out of most accounting systems. PRO-CHEX provides organizations a
variety of flexible options for providing a list of checks that have been issued or voided.

Issue templates allow users to select from a list of file formats supported and identify where the required
data elements are located within the file.

Once a template has been set up, the template can be selected when loading a file to tell Check Positive
Pay (PRO-CHEX) how to use the data contained in the file.

Multiple file templates can be set up, displayed, and used. Fls can create templates for Clients to use, or the
FI can allow Clients to create their own templates.

NOTE:

The Issue Template user privilege must be enabled.

1. From within the Check Positive Pay (PRO-CHEX) module, click Manage > Issue Templates.

Check Positive Pay = #Manage »  # Perform ~  JiReports ~

| Issue Templates I_

Additional Issue Fields

Welcome

Please use the above menu to select an action

i
[
L]
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2. The system displays a list of any existing templates available for view or edit, and a button to
Create New Template. NOTE: Templates created by the Fl cannot be modified by a Client.
Templates created by the Client can be modified by the Client and the Fl. Templates created by the
Fl can be viewed by clicking the eye icon in the Edit/View column.

| Create NewTemplate |
Template File Type
2011 Regression C Comma Separated ]
sV Comma Separated @
s Comma Separated ]
DBFI Fixed Width Fixed Width @
Excel 1 Excel Workbook @
Excel 97-2003 Workbook Excel 97-2003 Workbook @
Quickbooks Type 1 Excel Workbook @
[m] 2008 Regression Comma Separated 7
[m] 2008 Regression A Excel Workbook ”

3. To view or edit an existing template, click the pencil icon for the appropriate template. The template
displays with the date the template was last updated.

X
Edit Template: 2105 Template C Last Updated: 12/13/2021
Template Name File Type’ Template Status

2105 Template C Excel Workbook v Active ~

4. To delete an existing template, click the checkbox next to the Templates to be deleted and click
Delete Selected. Templates that have the Delete option were built by the Client and can be
deleted/edited by the Client user. Templates without the Delete option were built by the Fl and
cannot be deleted/edited by the Client user.
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5. To create a new template,

click the Create New Template button.

Create New Template

Template Name

Number of Header Rows’

Multi-Line Payee Name Separator: *

Do not use a character as a separator if
that character will ever be present in a
Payee Name. Allowed characters in
brackets[; | .- _/]

File Type’ Template Status

- select file type v Active A
Number of Footer Rows’ Template Level’

0 Client o

The upper portion of the template screen will not change, regardless of the file type selected. The template
name, file type, and template status values are required. The header and footer fields are optional.

Template Name Name of the template being created.

File Type Select the appropriate file type. Check Positive Pay (PRO-CHEX) accepts Issuance
File uploads with the following formats:

Comma Separated (.csv)
Fixed Width (.txt)

Excel Workbook (.xlIsx)

Excel 97-2003 Workbook (.xIs)
Pipe Separated (.csv)
Semi-colon Separated (.csv)
Tab Separated (.txt)

File types other than the ones listed above are not accepted.

Once File Type is selected, specific instructions for each file type will appear, based on
the selection. Examples of each file type are shown below.

Comma Separated
(-csv): A delimited text

file that uses a

separate values. Each
line of the file is a data
record. Each record

consists of one or more I —

p22172441,1111111111,280.08,136,20218201,£r0091, 356468, Art, , , , , CHECK
322172441,1111111111,26. 68,137, 28210201, tro992,456087, 5tuff, , , , ,CHECK
322172441,1111111111,586.00,138,20216201, tro093,45879, Misc, , , , , DEPOSIT
322172441,1111111111, 656.0@,139,20218281,tre094, , , , , , ,CHECK
322172441,2222222222,65.00,148,20210201,tr0095, , , , , , , CHECK
322172441,2222222222,156.00,141,20218281,tr0096, , , , , , ,CHECK
322172441,2222222222,489.60,142,20216201,tr0007,Supplies, , , , , , CHECK
322172441,2222222222,54.00,143,20210201,tr9998, , , , , , ,DEPOSIT
322172441,3333333333,480.00,144,20216201,tr0090,457896, , , , , , . CHECK

comma to

[T - L < BT B R T

fields, separated by

commas.
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Excel 97-2003 T ————
Workbook / Excel >

Workbook (XIS, .XISX): A ;EWM 0012212022 Cisco Webex, LLC 111111414 $65.55 1SSUED 151
file created using the & fes P wienten]  smssnn -
Excel program. Each line s s A2t wetr Lomdon o o, 17 | s -
of the file is a data “ e ———— st unesdnars b
record. Each record o o I ’
consists of one or more

fields separated into

columns.

Fixed Width ('tXt) Data 1 1047203/23/2820-88325.65 PPPPPPPPPRRPPPPPPPEPPRPPPPPPPRPEPPPPPPRPPPPPPPRPPPRPPPPPEPPRPPPPPRP
in a fixed-width text file is  |© iooseysmesre o RRKKKKKbKKEK KK KKKk KR KRR KRR
arranged II'] rOWS and i 132?52;‘;;2:5EZ;;7728 1111111131113111111313121321333331331113311311313111311113111111111
columns, with one entry | ¢ ZEIEEIRE, e
per row. Each column ey Y
has a fixed width,

specified in characters,

which determines the

maximum amount of data

it can contain. No

delimiters are used to

separate the fields in the

file.

Pipe Separated (.csv): 1 125|7088|ISSUED|2222222222

A delimited text file that 2 126|8080|ISSUED|2222222222
uses a pipe character ( | )

to separate values. Each
line of the file is a data
record. Each record
consists of one or more
fields, separated by

pipes.

Semi-colon Separated 1 127;7@@@;ISSUED;2222222222
(-csv): A delimited text 7 128:2080:ISSUED; 2222222222
file that uses a

semi-colon to separate
values. Each line of the
file is a data record. Each
record consists of one or
more fields, separated by
semi-colons.
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Template Status

Number of
Header/Footer
Rows

Multi-Line Payee
Name Separator

Tab Separated (.txt): A 1 |23 seee  ISSUED 2222222222

simple text format that 2 124 6000 ISSUED 2222222222
uses a tabular structure

to separate values. Each
line of the file is a data
record. Each record
consists of one or more
field, separated by tabs.

Can be set to Active or Inactive. Active templates are used for loading issue files;
inactive templates cannot be used for issue file loading.

Many accounting systems can export excel or fixed width files. Sometimes those files
have header (beginning) rows or footer (ending) rows containing data not required by
Check Positive Pay (PRO-CHEX).

When setting up a template, the Client can define the number of rows Check Positive
Pay (PRO-CHEX) should ignore at the beginning and end of the file. If the values are
entered incorrectly, an issue file may load with errors or no items.

This feature allows the user to enter a character to be used to separate Multiple Payee
Names on separate lines of an issued item.

Acceptable and allowed characters are limited to the following: ; | , - _ /

Do not use a Multi-Line Payee Name Separator character that will ever be presentin a
Payee Name, or that will be a character used in a specific file type (i.e., Comma
Separated files).

Payee Name Separators are only necessary when payee names are listed on two or
more separate lines of a check.

Please Refer to Section X, Payee Positive Pay Tips & Best Practices, for more
information about Multiple Payee Handling and Multi-Line Payee Separators.
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About Multi-Line Payee Name Separator:

The Multi-Line Payee Name Separator field is optional. This feature allows the Fl to enter a
character to be used to separate Multiple Payee Names on separate lines of an issued check.

Currently, the system restricts the allowed characters to the following: , y = _ | . The user
must be aware that using a separator character appearing elsewhere in the payee name might conflict
with the file itself. Examples of scenarios where problems might arise are listed below:

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a
comma cannot be used in the data field itself, or the .csv will read the comma as a separator before
the next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron”
will cause issues reading the .csv file. In this scenario, the user should select a multi-line payee name
separator character that will not cause an issue, such as a semicolon. “Elain Archeron;Nesta
Archeron” in the Payee Name field of the .csv file will process correctly.

If the user selects a separator character that would ever appear in a payee name field, such as a dash
(-), the system would then separate the data before and after the character as separate payees. For
instance, if the user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common
payee used is “In-and-Out Burger,” the system will interpret four payees (e.g., In, and, Out, Burger). In
this case, the user should select a multi-line payee name separator that will not cause such issues,
such as a pipe (|) or a semicolon (;) for cases of multiple payee names.

Please refer to Section X, Payee Positive Pay Tips & Best Practices for more information about
multiple payee name handling.
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The mapping section below displays based on the file type selected. Not all fields/options seen in
these graphics may be available for your organization based on settings configured by your

financial institution.

Excel and separated files require Clients to define the column data elements that will be found.

X
Create New Template
= r A
Template Name File Type’ Template Status
- select file type W Active W
Mumber of Header Rows’ Number of Footer Rows’ Template Level’
] - 0 Client g
Multi-Line Payee Name Separator: ¥
Do not use a character as a separator if
that character will ever be present in a
Payee Mame. Allowed characters in
brackets[; | .-_/]
This Client has not been setup for client additional issue fields in templates.
Configure in Client level settings and setup client additional issue fields for the Client and try again.
File Mapping
Add  Input Field® File Column? Field Format
Serial Number
Amount’ @ Fractional Dollars (12.34)
) Whole numbers of cents (1234)
Status’ ISSUED - for [S5UED
STOPPED - for STOPPED
-fary
VOIDED or VOIDED
O Account Mumber®
O Issuance Date’
O Payee Mame’
O Routing Number’
v
e - Place the cursor over this label for more information
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Fixed Width files require the Client to define the start and end position in which the data
element is located.

Create New Template

Template Mame

Number of Header Rows’

0

File Type® Template Status
Fixed Width A Active A

Number of Footer Rows’ Template Level®
0 Client w

Multi-Line Payee Name Separator: 7

Do not use a character as a separator if
that character will ever be presentin a
Payee Mame. Allowed characters in

brackets[;

1]

This Client has not been setup for client additional issue fields in templates.

Configure in Client level settings and setup client additional issue fields for the Client and try again.

File Mapping

Add

Save

Input Field”

Serial Number

Amount’

Status’

Account Number?

Issuance Date’

Payee Mame’

Routing Number’

Start Position’ End Position’ Field Format

@ Fractional Dollars (12.34)
CO'Whole numbers of cents (1234)

ISSUED - for ISSUED
STOPPED - for STOPPED
VOIDED - for VOIDED

- Place the cursor over this label for more information
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The mapping section on the lower part of the screen displays the required fields. The Check
Serial # and Amount fields are always required. The Client must specify whether the amount
data in the imported file will or will not contain decimal points. For example, if the Amount value
is set to Fractional Dollars, then 100, 100.0 and 100.00 are all processed the same. If the
Amount value is set to Whole numbers of cents, the system divides by 100 and saves it as a
dollar value. For example, a value of 100 would be saved as $1.00 in the system.

The Client can import additional data by checking the Add box next to the desired data element.

If the Status box is not checked (as shown below), Check Positive Pay (PRO-CHEX) will load all issue
items with a status of Issued. If the Client file represents Voided items as a negative number, the Client
can check the box Treat Negative Amount as Void and PRO-CHEX will status any item in the file with
a negative value as Voided. Issuance with a $0 amount will also be treated as void.

Create New Template
Template Name File Type’ Template Status
Comma Separated b Active b
Number of Header Rows’ Number of Footer Rows’ Template Level
Client hd
Multi-Line Payee Name Separator: *
Do not use a character as a separator if
that character will ever e presentin a
Payee MName. Allowed characters in
brackets [ ; _
This Client has not been setup for client additional issue fields in templates.
Configure in Client level settings and setup client additional issue fields for the Client and try again.
Add  Input Field’ File Column’ Field Format
Serial Number
Amount’ ® Fractional Dollars (12.34)
hole numbers of cents (1234
Status’ Treat Negative Amount As Void’
Issuance with 50 amount will be treated as Void
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Create New Template

Template Name File Type’ Template Status
Fixed Width b Active b

Number of Header Rows’ Number of Footer Rows’ Template Level’
0 i} Client W

Multi-Line Payee Name Separator: '

Do not use a character as a separator if
that character will ever be presant in a
Payee Name. Allowed characters in
brackets[:]|.-_/]

This Client has not been setup for client additional issue fields in templates.

Configure in Clisnt |evel settings and setup client additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ Start Position’ End Paosition’ Field Format
Serial Number
Amount ® Fractional Dollars (12.34)
COWhole numbers of cants (1234)

Status’ Treat Negative Amount As Void®
Iszuance with 50 amount will be treated as Void
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If the Client checks the Status box additional fields displays as shown below. If the Client’s accounting
system exports issue items with an Issued or Voided status, no additional action is required.

If the Status box is checked for a template, and this information is not provided in the issue file loaded,
the system will give each record an ISSUED status. In addition, the STOPPED status may not appear
in the Template configuration screen if the Fl has disabled stop payments.

Status’ ISSUED - for ISSUED
STOPPED -for STOPPED
VOIDED - for VOIDED

If the accounting system used exports issued items with a value of X and voided items with a value of
Y, the user can identify the values as shown below so Check Positive Pay (PRO-CHEX) can translate
the data appropriately when importing the data.

Status’ - - for ISSUED
- for STOPPED

- for VOIDED

A description has been provided below to define system behavior if additional data elements are
included.

Account # If the account box is selected, the user can import one file that contains issue items

for multiple accounts. If the account box is NOT selected, when a Client user loads a file
through the Client portal, Check Positive Pay (PRO-CHEX) will require the user to select the
account the checks were issued on.

Issuance If the issuance date box is NOT checked, Check Positive Pay (PRO-CHEX) will default the

Date

issue date to the date the file was loaded. If the issuance date box is checked, the file must
contain an issuance date for each item. For Excel files, PRO-CHEX translates the data
format used in the file. For separated and fixed width files, the Client must define the date
format being used. If the date format configured includes dashes or slashes (i.e.,
MM/dd/yyyy), the mapped issuance file should include the dashes or slashes (i.e.,
10/29/2024) as shown in the screenshot below. The formats displayed are examples only. A
complete list of date formats can be found at:

https://docs.oracle.com/javase/8/docs/api/javal/time/format/Date TimeFormatter.html#patterns

Issuance Date’

M for menth, d for day of month, y for year
Examples:

yyyy-MM-dd for 2019-12-25

MM/dd/yy for 12/25/19

MMM dd, yyyy for Dec 25, 2019
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Payee Name The Payee Name box appears if one or more accounts are configured for payee
positive pay. If the payee name box is checked, Check Positive Pay (PRO-CHEX)
requires the payee name for accounts configured for payee positive pay. If payee name
is provided for accounts not enrolled in payee positive pay, the payee name data will be
ignored when the file is loaded. For Excel or delimited files, the complete and single
payee name is expected in a single column. For fixed width files, the complete and
single payee name must be contained in the file between the starting and ending
position.

This field supports both alphabetic and numeric characters.

When a payee name is required in an issuance file, values consisting of only
white space (i.e., all spaces) will be considered the same as an empty value and
will not be accepted.

If the Multiple Payee Names feature is enabled, the Issuance Payee name may
display more than one payee. However, Multi-Line Payee Names cannot be used
on accounts that have a Custom Payee Box enabled.
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E. Additional Issue Fields

Additional Issue Fields is an Enterprise feature and is only available if enabled by the Fl, and the
Client Additional Issue Fields user privilege is turned on for a user. Additional issue fields are
not used in any exception matching process. These additional issue fields are available for Client
use, to allow Clients to record additional information within an issuance file to be used for historical or
reconciliation purposes. If this feature is enabled and in use, it will impact the view and behavior of the
Manual Issue Entry and Issue File Template screens. A few examples are shown below.

Manual Issue Entry
Account’ Auto populate next check number: @
clear
Row Serial Number Amount Payee Name’ Status Issuance Date
8604 2550.00 Office Pride ISSUED v | B | 03/02/2024
Deposit Location: 844 - -) Reference #. 00002 o9g
Type: _
ISSUED . 03/02/2024
© Click any row to select that row for editing
Save
File Mapping
Add  Input Field’ File Column’ Field Format
Serial Number
Amount? @ Fractional Dollars (12.34)
O Whoale numbers of cents (1234)
Status’ ISSUED -for ISSUED
STOPPED - for STOPPED
VOIDED - for VOIDED
Account Number?
» Issuance Date’
O Payee Name’
O Routing Number’
O Deposit Location _
Reference # -
Type 4=
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Check Positive Pay (PRO-CHEX) allows creating up to 6 additional issue fields within an issue
template.

Additional issue fields 1 and 2 are reserved for use by the Fl to set institution-wide additional issue
fields to be used by all enrolled clients.

Issue Fields 3 through 6 are available for Client-specific use and can be tailored to fit the recordkeeping
needs of the individual Client. These fields can be configured by the Fl at Client’s request or by the
Client user. Both Fl and Client users can delete Additional Issue Fields 3 through 6. FI Level Additional
Fields 1 and 2 can only be deleted by an Fl user.

Additional issue fields, once set up for client use, are displayed as configuration options in any File
Templates created or edited. In turn, once enabled, additional issue fields are displayed when viewing
file status or transaction status on any issued items.

1. From within the Check Positive Pay (PRO-CHEX) module, click Manage > Additional Issue Fields.

Check Positive Pay £ Manage -~ # Perform - ol Reports -

Issue Templates

Additional Issue Fields I_

l
Welcome

Please use the above menu to select an action
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Issue

Label

2. The Additional Issue Fields page appears.

Additional Issue Fields

Issue Field” Label® Delete
FI Global 1 Type
FI Global 2 Account
Client 1 v -
Client 2
Client 3
Client 4

€ Click any row to select that row for editing

Save

Additional Issue Fields

Issue Field’ Label? Delete
FI Global 1 Type
FI Global 2 Account
Client 1 A Internal Ref # L
- Select One- v

@ Click any row to select that row for editing

Save

Field FlI Global 1 and FI Global 2 are reserved for Fl labels. Client-1 to Client-4 may be used
by the FI or clients and are customizable to the Client. Select the Additional Issue Field
desired by clicking the drop-down menu.

The name of the additional issue field the Client wishes to set up. The label must be
unique to the client, and the client labels may not match any labels already configured
by the FI.

The maximum field length is 250 characters, including spaces.
3. Once a Client clicks the drop-down menu to select an Additional Issue Field, another row appears so

further Additional Issue Fields can be added, until all 4 available Additional Issue Fields have been
setup.

4. Once all Additional Issue Fields have been created, click Save button to complete the process.
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Existing Additional Issue Fields can be edited by clicking on the Additional Issue Field drop-down or
by clicking within the Label field.

Existing Additional Issue Fields can be deleted by clicking the Trash icon in the Delete column on the
Additional Issue Fields page.

Once established, Additional Issue Fields are displayed within both the existing and new Client’s File
Templates as fields that can be mapped when submitting Issuance File data. The user should see
the additional issue fields set up at the bottom of the list.

The Additional Issue Fields are displayed when the Client submits files via Issuance Manual Entry
and are also displayed when viewing items in the Issue Warehouse.
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NOTE:

e The Load Issuance File user privilege must be enabled.

e If Multiple Payee Names feature is enabled, Check Positive Pay (PRO-CHEX) supports more
than one payee name in the Payee Name field of issuance files. Please see Step #2 below for
more information.

e Multi-Line Payee Names cannot be used on accounts that have a Custom Payee Box
enabled.

e If Payee Name is a required field in the issuance template used, issuance files in which the
payee name field contains values consisting only of white space (ex, all spaces) will be
considered the same way as an empty value and will not be accepted.

e Issue file loading will strip and ignore dollar signs on dollar amounts, and double and single
quotations around data fields.

e For best results, users should not load issue files with mixed account numbers unless they
have access to all the listed accounts. Loading issue files with account numbers for which
the user has no access will cause errors.

e There is a 100-character limit on issuance file names.

e In the case of an issuance file containing Voids or Stops which are being loaded to overwrite
previously issued (outstanding) items, the system will update the status of the issued items
but will keep the original amount of the issued item, even if the Void/Stop amounts are listed
in the issuance file.

Check Positive Pay (PRO-CHEX) allows Client users to load issue files into the system for use in matching.
PRO-CHEX accepts these files in a variety of formats, used in conjunction with file templates (covered in the
previous subsection).

1. From the Client Portal:

a. Check Positive Pay (PRO-CHEX) module, click Perform > Issue File Load.

Check Positive Pay £ Manage - # Perform ~ ol Reports ~

[ Issue File Load ]_

Manual Issue Entry
We | C O m e Transaction Approva

Active Reconciliation

Please use :l'ﬁE above menu to select an
Paid No Issue Match
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b. The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- select template - w Create New Template

Select template that matches issue file format

c. Select the Template drop-down box to select from a list of existing templates. Select one of the
available templates listed. If only one template is available for a client, the drop-down box selects
that template by default.

Issue File Load

Template to Use With Issue File Account?

Excel Workbook 2 w - not selected - v Create Mew Template

- not selected -

FFF Escrow - xcoodd44
FFF Expense - xxxx3333
FFF Payroll - xoo02222
Select account and template that matches issue file format| FFFriends - oo 111

View Selected Template

d. If the template selected was created without the Account field enabled, a drop-down box will
display so that an Account can be selected. Select from the list of accounts. If only one account
is available for a client, the drop-down box will select that account by default.

Issue File Load

Template to Use With Issue File

- select template - v Create New Template

- select template -

1234

Ccsv

DEFI Fixed Width

Excel 97-2003 Workbook
Excel Workbook 2
TestTemplated
tester
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e. The file upload interface appears. Click the Browse button to select the appropriate file.

Issue File Load

Template to Use With Issue File Account’

Admin FI Level Template v The Cne and Only - 0001111 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template
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f.  Once the file is selected, it displays in the upload interface.

Issue File Load

Template to Use With Issue File Account’

Admin FI Level Template v The One and Only - 00001111 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

Elb

PCC1_Issue 10182022-001.xlsx Remove | Upload m

Remove The file is removed from the page.
Browse Use Browse to locate the file you want to load.
Upload The file will be uploaded.

g. The Status Bar displays the Current Status of the file.

< Back to Status WIKP1 Issue 1028-001.xlsx

File Status

Queued Processed Approved / Rejected Completed Deletad

File is processing . .
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h.

If errors are encountered during the initial processing of the issuance file, the Parse Errors
display appears, allowing the user to view the error detail within the file. The most common
reason this error would appear is because the file contains improper formatting. At this point, the
user will have the option to:

e Correct those errors.

e Delete individual errors. This feature only displays if there are errors in the file and is only
available until errors have been corrected and the file is saved.

e Delete all errors. This feature only displays if there are errors in the file and is only available
until errors have been corrected and the file is saved.

o This will retain the totals and counts for audit history.

e Discard the file. This feature appears when there is an error in the file. This option is not
available after corrections have been made and saved.

This will remove the file and its contents from the system.

< Back to 5tatus ASBC1_Evens_Issue w errors 03042024-001.xlsx View Template
File Status
Queued Processed Approved / Rejected Completed Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 03/07/24, the issuance file will be automatically discarded.
@ Edit 4 Errors
Rows 1 -4 of 4.
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
35 2468024680 1]
36 2468024680 ]
a7 2468024680 7]
£t 2468024680 ]
€ Click any row to select that row for editing

In this case, the account numbers in the issuance file were entered incorrectly and need to be
corrected before the file can be fully processed and loaded.
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i. Click on any fields highlighted in red to make updates or changes.

@® Edit 4 Errors Delete Al Errors
Rows 1 -4 of4,
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
z1111 11568 30 Richard Canova ISSUED 2021-04-15
- select accounr w 11568 5 30 . ISSUED v = 0471572021 =
7 | Richard Canova m
- select account - P
OctaTest - xooxB888
The One and Only - xocc1 111 .
4] PC Test - oo 360 11567 $260.00 Office Pride ISSUED 04/15/2021 m
Gilbert's Grapes - xxxx6732

In this example, the user is presented with an account number drop-down so they can choose
the correct account number for the issuance item.

j- Once all errors are corrected, the red highlights are no longer visible, and the file can be
reprocessed by clicking the Save and Submit button. This feature is only available until all errors
are corrected, deleted, or discarded.

® Edit 4 Errors

Rows 1 -4 of 4.

Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete

7 The One and Only 11568 $30.00 Richard Canova ISSUED 04/15/2021 (i)
- x%00t1111

6 Ean HEEF $260:66 Sffice-Pride IS5HER 152824 4

5 The One and Only 11566 $600.00 Jonathan Copeland ISSUED 04/15/2021 [i1]
- %0111 Michael Copeland

4 The One and Only 11565 £65.55 Cisco Webex, LLC ISSUED 04/15/2021 1]
=0001111

 Click any row to select that row for editing

Discard File Save and Submit
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k. The file will be returned to processing.

< Back to Status ASBC1_Evens_Issue w errors 03042024-002.xlsx

File Status

Queued Processed Approved/Rejected Completed Deleted

File is pending approval.

I If the file processes successfully, the user can view the details on all the items in the file.

< Back to Status ASBC1_Evens_Issue w errors 03042024-002.xlsx

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see items.

@® View items: 4 Items totaling $955.55 Load Date: 03/04/2024 9:20 AM EST
Rows 1 - 4 of 4,
Account Number Serial Number Amount Payee Name Status Issuance Date
W0od680 Q070 $65.55  Cisco Webex, LLC AVAILABLE_FOR_MATCHING 03/04/2024
axxxd680 Q071 $600.00 Jonathan Copeland and Michael Copeland AVAILABLE_FOR_MATCHING 03/04/2024
woodaso 9072 $260.00  Office Pride AVAILABLE_FOR_MATCHING 03/04/2024
H0oda80 Q073 $30.00 Richard Canova AVAILABLE_FOR_MATCHING 03/04/2024
Delete

If there are no errors in the file during the initial load, the file will automatically display as
approved and complete.
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If an issuance file needs to be deleted for any reason, click on the Delete button and the file will be
removed. Deleting a file will retain item counts and totals as audit history. NOTE: Files are only eligible for
deletion if every item in the file is still in an available for matching status. If just one item in the file

has been paid, the file cannot be deleted.

Issuance Files Status
Y Filters
files totali 27,
Ro f
Issuance Load File
ID ID File Name Status Status Message
4123 2418 CSWIssue DELETED Deleted By Client
0228_3.csv User

Date Range
Erebruary 28, 2020~
?
9.84
LUad ) " Transaction Transaction
Date/Timel: Count Total View/Manage
02/28/2020 14:23:52 g $6,354.64 View
cer W

2. Multiple Payees:

Check Positive Pay (PRO-CHEX) can support customers with multiple payee names on issued items.
The system scores multiple names on a check against information provided in the issuance file.

a. When the Client user loads an issue file into the system, the loaded file is processed using the
Issue Template set up within Check Positive Pay (PRO-CHEX). The Issue Template allows for
selection of a Multi-Line Payee Separator, a character chosen to separate the names of multiple

payees in the issue file.

b. If multiple payees are listed on a single line of a check, no action needs to be taken.

c. If multiple payees are listed on two or more separate lines on a check, the multiple payee
separator character (which should match the one designated in the template), must be used
between each name. In the example below, the Multi-Line Payee Name Separator designated in
the Issue Template is a pipe (|). The issue items shown are entered with the pipe separator

between each name, with no spaces.

1 2 3 4 5 6 T 8 9| 10 (11 12 13 14 15 16 17
1 Type Num Date Name Itemn Account Paid Amount Original Amount
2
3
4 Bill Pmt -Check '93-34 06/07/2020 Jonathan Copeland|Michael Copeland 1111111111 $65.55
r Nesta Archeron|Elain Archeron|Micah |
& Bill Pmt -Check 9385 06/07/2020 |Archeron 1111111111 $600.00

When the issue file is loaded, the system then separates the data before and after the character

as separate payees.

Please refer to Subsection D of this Section, Issue Templates, for more information about
Multi-Line Payee Name Separators and how best to use this feature.
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Multi-Line Payee Names cannot be utilized on accounts that have a Custom Payee Box

enabled.

3. Direct Send Issue Files: Recommendations:

If supported by the Fl, this feature allows the client to send issue files to their financial institution via
SFTP or another file transfer method, so that the FI can load those issue files to Check Positive Pay
(PRO-CHEX) for processing. Please note the following guidelines:

Subject

Recommendations

File Naming

There is a 100-character limit for issuance file names.

Direct Send Issuance File
Mapping

Direct Send Issuance Files should be mapped to match the Default
Template for Direct Load Issuance File selected for the Client.

<Change Client Add New Account

Accounts for ASBank Client 1

Total Account

Default Template For Direct Load Issuance File <

—_—
View Selected Template RECEICINERENGLIECY

CSVIssue RT Num v

Only shows templates with account number columns

Direct Send Issuance File
Mapping / Using a different
template than the default

A direct send issuance file can be loaded and mapped to a different issue
template if that template name is included in the brackets with the client
code, with a plus (+) sign in front.

Example: Issuance_Date [6789+CSV1].csv, YYYYMMDD_[Client Code].csv

Direct Send Issuance File
Mapping / Account
Numbers

Account Numbers must be included in the issue template assigned.

Direct Send Issuance File
Mapping / Issuance Date
Format

The issuance date in the file must match the date format set up in the issue
template assigned. If a file is loaded where the issuance date format does
not match the assigned issue template, the system will update the issuance
items with the current date.
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Subject

Recommendations

Direct Send Issuance File
Template / Account
Configurations

The Direct Send Issuance File Template must have mapping set up to
accommodate all account configurations. If one account is set for Payee
Positive Pay and one account is set for Standard Positive Pay, then the
Payee Name field should be mapped in the template. Even though the
Payee Name is not a required field for accounts enrolled in Standard
Positive Pay, the template should be able to accommodate Payee Name if
items are loaded for an account configured for Payee Positive Pay.

Example: In the graphic below, there are issue items for two different
accounts, each configured differently. Account 12121212 is set for Standard
Positive Pay and 12345678 is set for Payee Positive Pay. The file will load
without incident if no Payee is included for the Standard Positive Pay
account (even though the issue template defines the position/location),
because Check Positive Pay (PRO-CHEX) knows the Payee Name is not
required for Account 12121212. However, if the Payee Name is not provided
for Account 12345678, the file will fail.

= DirectSend7[Client1].txt . +

File Edit View

95965100012121212
9597158812345678 DePayeelame

Direct Send Issuance /
Account Reconciliation /
Issuance Dates

If a Direct Send Issuance is loaded for an account configured for Active
Account Reconciliation, any items dated prior to the start date of the current
reconciliation period will automatically be updated to the current date when
loaded.

Direct Send Issuance Load
Alerts

If Client users have been configured to receive alerts, an alert email will be
received once the direct send issuance file has been transferred to the
system and the file has successfully loaded. If the file loads with errors, the
alert email informs the FI that the file load failed. In this particular case, the
Fl user should check the Issuance File Status Page in Check Positive Pay
(PRO-CHEX) before taking action. If the issue file status column indicates
the load did fail, the Fl user should review their direct send issue file
carefully, correct any problems, and resubmit the file. If the status column
indicates that the file has “edits_pending,” click View to open the issue file
and make edits within PRO-CHEX.
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4. Issuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the Fl. In
this circumstance, loaded issue files must be approved by a second client user or, if no second user
is available to approve the file, the client can request the Fl approve the issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual
Approval process.

10. Disable Stop Payments: When the Fl has disabled stop payments, client users cannot create new
stopped issue items or modify previously stopped issue items. The Fl can, however, feed stop pay
items from the core banking system.

a. If a userloads an issue file with serial numbers the Fl has loaded a stop pay on, the system will
not accept the file.

< Back to Status CHC1 Issue 0304-001.xlsx

File Status

Queued Processed Approved / Rejected Completed Deleted

Some items are ineligible. View list below to see items. Remove ineligible items and reload file

@ View items: 2 Items totaling $875.00 Load Date: 03/04/2021 11:36:51 EST
Rows 1-2 of 2.
Account Number Serial Number Amount Payee Name Status Issuance Date
w3232 100947 $475.00 Michael York INELIGIBLE_FOR_MODIFICATION 03/04/2021
3232 100948 $400.00 Elizabeth Tudor INELIGIELE_FOR_MODIFICATION 03/04/2021
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The Issue File Status feature provides Client users the ability to view and/or manage issue files loaded or
manually entered by the client. The disposition or status of the file is available. If enabled by the Fl, Check
Positive Pay (PRO-CHEX) also offers an option for FI and/or Client users to receive issue load alerts when
an issue file is loaded successfully or loaded with errors. (Please refer to Appendix A — PRO-CHEX

Message Alerts to see examples of these alerts.) Authorized client users can also manage these files as
outlined in the next section.

1. View Issue File Status

NOTE:

The View Issuance File Status user privilege must be enabled.

a. Within the Check Positive Pay (PRO-CHEX) module, click View > Issue File Status.

Check Positive Pa £ Manage # Perform - diReports - iEView ~
-I Issue File Status ]
Issue Warehouse
We | C O m e' Transaction History
Please use the above menu to select an action Item Lookup
Reconciliation Periods
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b. The Issuance Files Status page appears.

Date Range
Issuance Files Status & Jul 27, 2023
Y Filters >
1 files totaling $26,708.23
Rows 1-10of1.
Issuance LoadID  File Name Status Load Date/Timeli Transaction Count  Transaction Total View/Manage
> 21623 ASBC1_Evens_Issue 07272023-001.xlsx FI APPROVED  07/27/2023 8:43 AM EDT 35 %26,708.23 Manage
c. To filter the date range of files shown, click on the Date Range drop-down.
Date Range
Issuance Files Status & Jul 27, 2023 -
Y Filters start Date? End Date’ Tomorrow
07/27/2023 07/27/2023
July 2023 August 2023
RO Sy Mo Tu We Th Fr Sa Su Mo Tu We Th Fr S  resterday
Issuance LoadID  File Name Status 25 26 27 28 13 30 1 1 2 3 4 5 lastyDays
2 3 4 s 6 7 & 6 7 8 9 10 11 12 ThisMonth
> 21623 ASBC1_Evens_Issue 07272023-001 .xlsx FI_APPROVE

g9 10 11 12 13 14 15 13 14 15 16 17 18 1%
Last Month

Custom
23 24 25 ZGEZS 29 27 28 29 30 31 1 2

@ User Instructions
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d. To narrow the search results, click Filters and a window containing additional search criteria will

appear.
Date Range
Issuance Files Status = Jul 27,2023
Y Filters v
Issuance Load ID Status Amount
Apply
Issuance Load ID The ID number associated with the specific file.
Status Client_Approved The file was approved by the client.

Client_Discarded

Client_Rejected

Deleted

Edit_Pending

Failed
Fl_Approved

Fl_Rejected

Client discarded means a client user decided to discard the
issue file before it was fully processed into the database.

If Issuance Dual Approval is configured for a client, Client
Rejected means a client user rejected the issue file during the
dual approval process.

A deleted file has been processed into the system but was
removed by an Fl or Client user. The file information will still be
in the system and can be found in the Issue warehouse.

A file in this status was loaded with errors. Before the file can be
processed into the database and be displayed in the issue
warehouse or be used in matching, the errors will need to be
cleaned up or removed from the file.

When a file is loaded with errors, the file will be purged after 3
business days. The date that the file will be purged will be
shown in the Issue File Status screen.

< Back to Status ASBC1_Evens_Issue 06012023-001.xIsx

Queued Processed Approved / Rejected Completed Deleted

The file failed to load.
The file was approved by the FI.

If Issuance Dual Approval is configured for a client, Fl rejected
means an Fl user rejected the issue file during the dual approval
process.
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Amount

Ineligible_ltems

Loading
Processing

Queued

Suspended

System_Approved

System_Discarded

Test_Approved

The file contains ineligible items. Ineligible items can include
issued items with the same serial number as an existing
issuance item that has been paid, an existing issuance found in
a stopped status where stop editing has been disabled, or the
issuance item in the file is in a STOPPED status, and stops are
disabled by the FI. These items will not be processed but will not
prevent the other items in the Issue file from being loaded.

The file is loading.
The file is processing.

The file is in line awaiting a status change.
The file has been suspended.

“Suspended” status can be related to the Issuance Dual
Approval feature. Please refer to Subsection H. Issuance
Dual Approval, for more information about this feature.

The system is set to default approve the file.

Discarded files are files a client user loaded to Check Positive
Pay (PRO-CHEX) and had errors to be cleaned up. If the errors
are not cleaned up by the deadline displayed under the progress
bar, which is three days, the system will discard the file and will
not maintain a record of the file.

In test mode a client user can load issue files to make sure the
issue template was created correctly and the file loaded
correctly. This function informs the user if the file will process in
the regular user interface, but items are not available for
matching in test mode.

Enter a specific amount for the transaction.

Amount Range

Min Amount

Max Amount

Click the hyperlink above the Amount field to enter an amount
range or a maximum or minimum amount of transaction.

Minimum dollar amount of transaction.

Maximum dollar amount of transaction.

e. Once search criteria are selected, click Apply to narrow your search results.
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f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue
files, the results are displayed on multiple pages. Use the navigation buttons at the top of the
search results to review all results.

—~ £ - I CC T
28 files totaling $218,855.7

L

Rows 1 - 25 of 28,

Issuance Load ID  File Name

Status Load Date/Timeli Transaction Count Transaction Total View/Manage

Issuance Load ID

File Name

Status
Load Date/Time

Transaction Count

Transaction Total

View

Manage

The ID number assigned by Check Positive Pay (PRO-CHEX) when a file
is loaded. The Fl uses this value when contacting Alkami (formerly ACH
Alert) regarding an issuance file loading problem they cannot troubleshoot
themselves. These pieces of information should be provided in any
helpdesk ticket opened.

The file name assigned by the Client at load time. If the transactions were
manually entered the file name will appear with a prefix of MANUAL
followed by a system generated number sequence for ease of
differentiation.

Please see #4 in this section for a list of possible Status codes.

The date (MM/DD/YYYY) and time (HH:MM:SS) this file was loaded.

The number of transactions in the file.
The total dollar amount of the transaction.

Displays the View button if a file has no errors or is ineligible to be edited.
Authorized Fl users can click View to get to the Delete button to delete a
file. See below for more information.

Displays Manage button if the file contains errors that can be edited. See
below for more information.
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2. Click the arrow (>) next to the Client Code to view more useful detail on each issuance file.

Issuance Load Transaction Transaction
Load ID File Name Status Date/Timel: Count Total View/Manage
v 20465 ASBank_CSV _Issue_0426_ ASBC1_.csv SYSTEM_APPROVED 04/26/2022 9:33 AM 16 $1,004,372.00 Manage
EDT
File Id: 6173
Template Name: CSV Issue
v 20449 MANUAL_1650898055281 SYSTEM_APPROVED 04/25/2022 10:47 AM 1 $600.00 Manage
EDT
File Id: 6157
File ID The ID number assigned by Check Positive Pay (PRO-CHEX) once an
issuance file is processed and committed to the database. If an Issuance
Load ID is present but a File ID is not, the file was received but did not
load properly or has not been processed all the way to the database.
The File ID is useful when contacting Alkami (formerly ACH Alert) Help
Desk about a problem with a file.
Template Name Issue Template used to load the issue file.
Status Message Displays error messages, approval or rejection data, or indicates if an

issue file has been deleted.
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Click View button to view the individual issue files. The [File Name] page appears.

< Back to 5tatus

File Status

Queued Processed Approved Completed Deleted

WEKP1 Issue 0302-002.xIsx

File processing is complete. View list below to see iterms.

File cannct be deleted because it has items already used in matching

® View items: 15

Account Number

oo 111

oo 111

oo 111

oo 111

001111

oo 111

oo 111

Items totaling $12,246.81

Rows Sof1

Serial Number Amount Payee Name Status Issuance Date
13788 $65.55 Cisco Webex, LLC USED_IN_MATCHING 03/02/2021
13789 5$600.00  Jonathan Copeland USED_IN_MATCHING 03/02

Michael Copeland
13790 $260.00 Office Pride USED_IN_MATCHING
13791 $75.00 Richard Canova USED_IN_MATCHING
13792 $933.00 Waller Lansden Dortch & Davis, LLP USED_IN_MATCHING 03/02/2021
13793 $24.00 Advanced Medical USED_IN_MATCHING 03/02/2021
13794 $6,130.00 Citizens Union Bank USED_IN_MATCHING 03/02/2021

Load Date: 03/02/2021 11:36:23 EST

File Status Bar

Load Date

Account Number

Serial Number
Amount
Payee Name

Status

Issuance Date

Displays progress of issue file. This feature automatically refreshes and keeps the

user informed on the status
Approved or Failed.

of the file’s progress as it goes from Queued to

The date and time loaded of each item within the file.

The Account Number of each item within the file.

The serial number of each item within the file.

The dollar amount of each item within the file.

If Applicable, the name of the payee of each item within the file.

Available for Matching

Used in Matching

New Issuance ltem

Ineligible for Modification

Duplicate Issuance

The date of the issued item.

Items marked as Available for Matching are issue
items that have loaded to the system but have not
been matched to a presented item.

Items marked as Used in Matching are issue items that
a presented item has been matched to.

This status will only display in a file not loaded to the
database for processing.

Items ineligible for modification are items matched to
presented items and are either in a Current Status of
paid or returned and can therefore no longer be
modified.

Duplicate issuance items are issue items that duplicate
previously loaded issue items exactly.
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3. Manage Issue File Status

NOTE:

The Load Issuance File user privilege must be enabled.

The View Issuance File Status user privilege must be enabled.
The Delete Issue File Status user privilege must be enabled.
The Manual Issue Entry user privilege must be enabled.

a. Click the Manage button to edit errors within an issue file. The [File Name] page appears.

i Correct Items.

1) Fields highlighted in red have an error and are blocking the issue file from loading all the
way to the system.

2) When a highlighted field is clicked, the user can either select the correct data from a
dropdown or enter it in directly in the field.

3) Once all errors have been corrected, the user can click Save and Submit at the bottom,
so the file is reprocessed.

@ Edit 9 Errors
Rows 1-%0of9.
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
5555555555 9255 65.55 Cisco Webex, LLC -28
- select account - b 9255 g 65.55 ~ . ~ = 05/28/2020 o
4 Cisco Webex, LLC T
P

9256 5600.00 Jonathan Copeland 05/28/2020 i
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Delete Iltems

1) Individual items can be deleted from the errors screen if the option is available.

2) Click the trashcan in the Delete column to delete any individual items.

3) Once items have been deleted, click Save and Submit at the bottom, so the file is
reprocessed.

a) The user can also click Delete All Errors at the top of the delete column.

4) This will allow the rest of the file to process into the system.

< Back to Status

File Status
Queved
Errors occurred during loading. View list bela
® Edit 9 Errors
Line
Number Account

4 5555555555

5 5555555555

6 5555555555

Issue 0529-001.xlsx

Processing Processed Approved Complete

Rows 1-%0of9,

Serial Number Amount Payee Name”
9255 $65.55 Cisco Webex, LLC
59256 5600.00 Jonathan Copeland
9257 £260.00 Office Pride

Deleted

ow to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discardec

Issuance Date

05/28/2020

05/28/2020

05/28/2020

Delete
i
i

i
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iii. Discard a File

1) An entire issue file can also be discarded.

a) Click the discard button at the bottom of the screen.

b) Another option is to allow the system to discard the file automatically after three (3)
business days.

In both instances, the system will act as if the file never existed and any issue information
from the file will not appear in any reporting or view.

SETEAmgnlE Issue 0529-001.xlsx
File Status

Queued Processing Processed Approved Complets Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded

@® Edit 9 Errors

Rows 1-9of9.

NLlj_li':Eer Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 $65.55 Cisco Webex, LLC 05/28/2020 i
3 3555555555 9256 5600.00 Jonathan Copeland 03/28/2020 i}
& 5555555555 9257 £260.00 Office Pride 05/28/2020 i
T 3555555555 9258 [} Richard Canova 03/28/2020 i}
& 5555555555 9259 £933.00 Waller Lansden Dortch & Davis, 05/28/2020 i

LLP
9 3555555555 9260 [} Richard Canova 03/28/2020 i}
10 5555555555 9281 £53.36 Richard Canova 05/28/2020 i
i 3555555555 9262 324.00 Advanced Medical, Inc. 03/28/2020 i
12 5555555555 9263 $6,130.00 Citizens Union Bank (v} 05/28/2020 i

© Click any row to select that row for editing

Discard File Save
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iv. Delete a File

1) Users are also able to delete an issue file if none of the items in the file have been used in
matching by clicking on the Delete button.

a) When afile is deleted, the items will appear in issue views and reporting.

< Back to Status PGO1 Issue 0303-002.xlsx

File Status

Queued Processed Approved Completed Dreleted

File processing is complete, View list below to see items.

@® View items: 15 [tems totaling $12,246.81 Load Date: 03/03/2021 15:07:38 EST

Rows 1-150f 15,

Account Number Serial Number Amount Payee Name Status Issuance Date
woox3783 2665 $65.55 Cisco Webex, LLC AVAILABLE_FOR_MATCHING 03/03/2021
w0378l 2666 $600.00 Jonathan Copeland AVAILABLE_FOR_MATCHING 03/03/2021

Michael Copeland

w0378l 2667 $260.00 Office Pride AVAILABLE_FOR_MATCHING 03/03/2021
003783 2668 $75.00 Richard Canova AVAILABLE_FOR_MATCHING 03/03/2021
003783 2669 $933.00 Waller Lansden Dortch & Davis, LLP AVAILABLE_FOR_MATCHING 03/03/2021
003783 2670 324.00 Advanced Medical AVAILABLE_FOR_MATCHING 03/03/2021
woox3783 2671 $6,130.00 Citizens Union Bank AVAILABLE_FOR_MATCHING 03/03/2021
w0378 2672 $53.36 Covey Seminars AVAILABLE_FOR_MATCHING 03/03/2021
003783 2673 $193.93 Cuyahoga County Clerk AVAILABLE_FOR_MATCHING 03/03/2021
w0378 2674 $2,800.00 Michael Farrell AVAILABLE FOR_MATCHING 03032021
003783 2675 $150.00  Mesta Archeron AVAILABLE_FOR_MATCHING 03/03/2021
Elain Archeron
003783 2676 3150.00 Jake Chambers AVAILABLE FOR_MATCHING 03/03/2021
woox3783 2677 $750.00 ABC Carpentry AVAILABLE_FOR_MATCHING 03/03/2021
w0378 2678 $35.00 Office Pride AVAILABLE_FOR_MATCHING 03/03/2021
003783 2679 $26.97 FedEx AVAILABLE_FOR_MATCHING 03/03/2021
Delete

4. |ssuance Dual Approval:

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the Fl. In
this circumstance, manual issue entry files or loaded issue files must be approved by a second client
user or, if no second user is available to approve the file, the client can request the Fl approve the
issue file.

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual
Approval process.
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Check Positive Pay (PRO-CHEX) offers the ability to support dual approval for issuance file loads, including
manual issue entries and updates to issue items within the Issue Warehouse. If enabled by the Fl and
configured for a client, manual issue entry files or issue files loaded by the client are held in “suspended”
status until approved or rejected by a secondary user.

NOTE:

e Approve/Reject Issue Files permission must be enabled by the FI.
e The Approve Issue File user privilege must be enabled.

1. If a Client User has manually entered issue items or loaded an issue file requiring dual approval,
another client user must approve the issue file or manual entry file. Once the file is loaded and
pending approval, a message is sent via email or SMS within 30 seconds to client users with the
Approve Issue File user privilege to alert them of files pending approval.

2. Within the Check Positive Pay (PRO-CHEX) module, click View > Issue File Status.

Check Positive Pay £ Manage ~ # Perform - ol Reports - = View ~

-I Issue File Status ]

Issue Warehouse

We | C O m e Transaction History

Item Lookup

Please use the above menu to select an action
Reconciliation Periods

3. The Issuance Files Status page appears. Files requiring dual approval will show a status of
“Suspended”. Click the Manage button to review the file.

Date Range
Issuance Files Status 8 Mar 04, 2024 -
Y Filters >
Issuance Load ID  File Name Status Load Date/Timeli Transaction Count Transaction Total View/Manage
> 21949 ASBC1_Evens_Issue w errors 03042024-001.xlsx ~ SUSPENDED  03/04/2024 9:15 AM EST 35 526,?0;’:‘“ Manage
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4. The Issue File review page displays a File Status box at the top of the screen which outlines the
Current Status of the file. The status bar will highlight “Approved/Rejected,” and will note if the file is
pending approval. Approve and Reject buttons display in the File Status box.

< Back to Status ASBC1_Evens_Issue w errors 03042024-001.xlsx

File Status

Queued Processed

File is pending approval. View list below to approve items.

Approved / Rejected

Com

pleted Deleted

Approve  Reject

5. Alist of each issue item contained in the file displays below the File Status box. Each status displays
as “New Issuance Item.” The client user can review the entries to determine if the file should be
approved or rejected. The client user can also delete the file prior to and after approval by clicking
the Delete button at the bottom of the screen.

- 2_52608? iterns: 15 Items totaling

Account Number Serial Number Amount

w3783 2665 $£65.55
w3783 2666 $600.00
o373 2667 $260.00
o373 2668 £75.00
o373 2669 $935.00
o373 2670 £24.00
003783 2671 $6,130.00
03783 2672 $53.36
003783 2673 $193.93
03783 2674 $2,800.00
003783 2675 $150.00
w0oE3ITES 2676 $150.00
w0037 2677 $750.00
w0oE3ITES 2678 $35.00
w0037 2679 $26.97

Rows 1-150f 15

Payee Name

Cisco Webex, LLC

Jonathan Copeland
Michael Copeland

Office Pride

Richard Canova

Waller Lansden Dortch & Davis, LLP

Advanced Medical

Citizens Union Bank

Cowvey Seminars

Cuyahoga County Clerk

Michael Farrell

Mesta Archeron
Elain Archeron

Jake Chambers

ABC Carpentry

Office Pride

FedEx

Status

NEW_ISS!

NEW_ISS!

NEW_ISS!

MNEW_ISS!

NEW_ISS!

MNEW_ISS!

MEW_IS5!

MEW_IS5

MEW_IS5!

MEW_IS5

MEW_IS5!

NEW_ISS

NEW_ISS

NEW_ISS

NEW_ISS

Load Date: 03/03/2021 15:07:38
ESTl

Issuance Date

UANCE_ITEM 03/03/2021

UANCE_ITEM 03/03/2021

UANCE_ITEM 03/03/2021
UANCE_ITEM 03/03/2021
UANCE_ITEM 03/03/2021
UANCE_ITEM 03/03/2021
UAMCE_ITEM 03/03/2021
UAMCE_ITEM 03/03/2021
UAMCE_ITEM 03/03/2021
UAMCE_ITEM 03/03/2021

UANCE_ITEM 03/03/2021

UANCE_ITEM 03/03/2021
UANCE_ITEM 03/03/2021
UANCE_ITEM 03/03/2021

UANCE_ITEM 03/03/2021

Delete
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6. If the file is to be approved, click the Approve Button. Once the file is approved, the file status
displays that the file processing is complete.

< Back to Status ASBC1_Evens_Issue w errors 03042024-001.xIsx

File Status

Queusd Processed Approved Completad Deleted

File processing is complete. View list below to see items.

a. After the approval is complete, the issue items display the status “Available for Matching.” The
Delete button will still be available to delete a file after approval.

@ View items: 15 Irems totaling $12,246.81 Load Date: 03/03/2021 15:07:38 EST
Rows 1-150f 15,
Account Number Serial Mumber Amount Payee Name Status Issuance Date
003783 2665 $65.55  Cisco Webex, LLC AVAILABLE_FOR_MATCHING 03/03/2021
WO3TE3 2666 $800.00  Jonathan Copeland AVAILABLE_FOR_MATCHING 03/03/2021
Michael Copeland
003783 2667 $260.00  Office Pride AVAILABLE_FOR_MATCHING 03/03/2021
w3783 2668 $75.00  Richard Canova AVAILABLE_FOR_MATCHING 03/03/2021
003783 2669 $933.00 Waller Lansden Dortch & Davis, LLP AVAILABLE_FOR_MATCHING 03/03/2021
WO3TE3 2670 52400 Advanced Medical AVAILABLE_FOR_MATCHING 03/03/2021
0003783 2671 $6,130.00 Citizens Union Bank AVAILABLE_FOR_MATCHING 03/03/2021
03783 2672 $53.36 Covey Seminars AVAILAELE_FOR_MATCHING 03/03/2021
03783 2673 $193.93 Cuyahoga County Clerk AVAILAELE_FOR_MATCHING 03/03/2021
wooc3T83 2674 $2,800.00 Michael Farrell AVAILAELE_FOR_MATCHING 03/03/2021
003783 2675 $150.00 MNesta Archeron AVAILAELE_FOR_MATCHING 03/03/2021
Elain Archeron
03783 2676 $150.00  Jake Chambers AVAILAELE_FOR_MATCHING 03/03/2021
03783 2677 $750.00 ABC Carpentry AVAILAELE_FOR_MATCHING 03/03/2021
wooc3T83 2678 £35.00 Office Pride AVAILAELE_FOR_MATCHING 03/03/2021
003783 2679 $26.97  FedEx AVAILABLE_FOR_MATCHING 03/03/2021
Delets
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b. Returning to the Issuance Files Status page, the file now displays a status of “Client Approved.”

. Date Range
Issuance Files Status - J
=March 3, 2021 -
¥ Filters >
Issuance Load ID File Name Status Load Date/Timeli Transaction Count Transaction Total View/Manage
> BB31 MAMUAL 1614805777127 CLIENT_APPROVED 03/03/2021 16:0%:37 EST 1 $525.00 Manage
> BE38 PG Issue 0303-002.xlsx CLIENT_APPROVED 03/03/2021 15:07:37 EST 15 $12,245.81 Manage
7. If the file is to be rejected, click the Reject Button.
a. Once the file is rejected, the file status displays that the file has been rejected by [client
username]. The individual issue items no longer display in the issuance file status.
< Back to Status WKP1 Issue 1207-003.xlsx
File Status
Queued Processed Rejected Deleted
File has been rejected by FFFTom|ones.,
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b. Returning to the Issuance File Status page, the file now displays a status of “Client Rejected.”

. Date Range
Issuance Files Status -
EDecember 1, 2020 - March 3, 2021 ~
Y Filers b4
es tota $12.17
Issuance Load 1D File Name Status Load Date/Timel: Transaction Count Transaction Tota View/Manage
> 74 WEKP1 Issue 1207-003.xdsx CLIENT_RE|ECTED 12/07/202017:15:47 EST 15 $12171.81 View

NOTE:

If Issuance Dual Approval is enabled for a client, any updates made to issue items through file
loading, manual issue entry, or modifying issue items in the Issue Warehouse will be passed
through Issuance Dual Approval to be reviewed and approved by a secondary user.

If an issuance file is currently in “Suspended” status, the file is not released at EOD; but rather,
the file remains in this status indefinitely until approved or rejected.

If an issuance file is currently in “Suspended” status, and the client level setting for Issuance
Dual Approval is disabled, or client user privileges are removed before the affected issuance
files are approved or rejected, the file remains in the Suspended status but cannot be managed
by the client user. In this circumstance, an Fl user can still approve or reject the file to move it
out of the Suspended status.
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. Issue Warehouse

Check Positive Pay (PRO-CHEX) allows Fl and Clients to see the status of all issued items. Authorized
Client users can modify items in the Issue Warehouse. Clients can use the Issue Warehouse to search
for issued items for a Client or specific account using the filtering options available.

NOTE:

The View Issuance Status user privilege must be enabled.

1. Within the Check Positive Pay (PRO-CHEX) module, click View > Issue Warehouse.

Check Positive Pay

£ Manage ~  # Perform ~  JiReports ~

Welcome

Please use the above menu to select an action

[ 1ssue Warehouse J

= View «

Issue File Status

Transaction History
Item Lookup
Reconciliation Periods

2. The Issue Warehouse page appears.

Issue Warehouse

Date Range
& Jul 01, 2023 - Jul 31, 2023 ~

© 2024 Alkami Technology, Inc.
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Y Filters >
3 transactions totaling $2,899.00
Rows 1-30of3
- 2
Item ID Account Number  Serial Number Payee Name Issue Type Match Status Amount Load Date/Timeli Issuance Date  Update
> 4201385 03333 511247 ISSUED QUTSTANDING $698.00  07/14/2023 2133 PM EDT 06/30/2023 7
> 4261373 003333 511233 ISSUED OUTSTANDING $2,001.00  07/14/2023 2:33 PM EDT 07/24/2023 ya
> 4261372 003333 511232 ISSUED OUTSTANDING $200.00  07/14/2023 2:33 PM EDT 06/30/2023 ya
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3. To filter the date range of items shown, click on the Date Range drop-down.

Date Range
Issue Warehouse B Jul 27, 2023 -
? Filters Sta_rl. D_aL.E- End Date’ Tomorrow
07/27/2023 Q7/27/2023
July 2023 August 2023
ROW sy Mo Tu We Th Fr Sa Su Mo Tu We Th Fr sa  Yesterday
. I 25 26 27 28 29 30 1 1 2 3 4 5 Llast7Days
2 3 4 5 6 7 B8 6 7 B 9 10 11 12  This Month
9 10 11 12 13 14 15 13 14 15 16 17 18 19
Account serial 16 17 18 19 20 21 22 20 21 22 23 24 25 26 s en
ItemID Number Number Payee Name ! = - =S < Customn

23 24 25 ESE 28 29 27 28 2% 30 31 1 2

» 4261501 ooxd4680 7534 Oliver Orville

4. To narrow the search results, click Filters and a window containing additional search criteria will

appear.
Date Range
Issue Warehouse B )ul27. 2023 -
Y Filters v
Account? Match Status Date Range Filter Type
Any v C Issue Date @® Load Date
Amount Amount Range Issue Type
% Any W
Serial Number Serial Number Range
Apply
Account Type an account name or the last 4 digits of the account number.
Serial Number Type the item serial number for a specific issued item.
Amount Enter a specific amount for the transaction.

Amount Range Click the hyperlink above the Amount field to enter an
amount range or a maximum or minimum amount of
transaction.

Min Amount Minimum dollar amount of transaction.
Max Amount Maximum dollar amount of transaction.
Version 2.2.0
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Serial Number

Issue Type

Match Status

Type the item serial number for a specific issued item.

Serial Number
Range

Min Serial #

Max Serial #

Issued
Voided
Stopped
Paid

Returned

Outstanding

Click the hyperlink above the Serial Number field to enter a
serial number range or a maximum or minimum serial
number.

Minimum serial number

Maximum serial number

The check has been issued for payment.

The check has been voided by maker.
The check has a stop payment placed on it.

There was a presented item for the issued item, and it has
been paid.

There was a presented item for the issued item, and it has
been returned.

There has been no presented item for the issued item, and it
remains outstanding.

NOTE:

e Issuance data is available for 1 year as the default setting, but this can be configured
differently by the FI.
e If Additional Issue Fields are being used, a section to filter by that data will display.

5. Once search criteria are selected, click Apply to narrow your search results.

6. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items,
the results are displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.
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Account
ItemID MNumber

Serial
Number

Load

Issue . Issuance
Payee Name Type Match Status Amount Date/Timeli Date Update

Item ID

Account Number

Serial Number

Payee Name

Issue Type

Match Status

Amount
Load Date/Time

Issuance Date

Update

The ID number assigned by Check Positive Pay (PRO-CHEX) when a file is
loaded. The Fl uses this value when contacting Alkami (formerly ACH Alert)
regarding an issuance file loading problem they cannot troubleshoot themselves.

Displays the Account Number for the item.

Displays the issued item’s serial number.

Displays the name of the payee for the item.

Issued The check has been issued for payment.

Voided The check has been voided by maker.

Stopped The check has a stop payment placed on it.

Paid There was a presented item for the issued item, and it has been
paid.

Returned There was a presented item for the issued item, and it has been
returned.

Outstanding There has been no presented item for the issued item, it remains
outstanding.

Displays the dollar amount for the issued item.
Date (MM/DD/YYYY) and time (HH:MM:SS) the item was loaded.

The date of the issued item.

Click the pencil icon to update the item’s Amount, Status, or Issuance Date.

If Issuance Dual Approval is enabled for a client, any updates made to issue
items through file loading, manual issue entry, or modifying issue items in
the Issue Warehouse will be passed through Issuance Dual Approval to be
reviewed and approved by a secondary user.
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7. Click the arrow (>) next to the Client Code to view more detail on each issued item. The information
shown in this drop-down is an audit history of all the activity that has occurred on the issue item.

Account Serial Issue Load Issuance
ItemID  Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
~ 3393032 xxxx3579 113687 Richard Canava ISSUED OUTSTANDING $30.00 04/22/202212:13PM 0472272022 ya
EDT
Status Payee Amount Issue Date Updated By Updated Date/Time
ISSUED Richard Canova $30.00 04/22/2022 sdelaere1 04/22/2022 12:13 PM EDT
Status Issued The check has been issued for payment.
Voided The check has been voided by maker.
Stopped The check has a stop payment placed on it.
Payee Displays the payee name of the issue item.
Amount Displays the dollar amount for the issued item.
Issue Date The date of the issued item.
Updated By The user who updated the issue item.
Updated Date/Time The date and time this issued item was updated.

8. Modifying Issue Items.

a. lIssue items can be modified by users with a Load Issue File or Manual Issue Entry privilege.
Issue items can only be modified if the Match Status = Outstanding. Click the edit pencil button
under the Update column to update the issued item.

Account Seria Issue Load . . Issuance
ItemID  Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
> 2276362 wootl1l 9263 Citizens Union Bank (v) ISSUED OUTSTANDING $6,130.00 05/29/2020 10:04:33  05/28/2020 ya
EDT -
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9. The Update Issue Item pop-up window appears.

Update Issue Item
Serial Number Amount Payee Name’ Status Issuance Date
9263 6130 Citizens Union Bank (v} ISSUED v B | 05/20/2020
A
Save
Serial Number Check serial number. This cannot be updated on an existing issued item.
Amount Amount of the issued item. The amount can be updated.
Payee Name The name of the Payee associated with the specific issued item. The payee name

can be updated.

Status Issued The check has been issued.
Voided The check has been voided by the maker.
Stopped The check has a stop payment by the maker.

If the Fl has disabled stop payments in their
configuration, Stopped may not be an option in the
drop-down menu on this pop-up screen.

Cancelled The check is being cancelled by the maker. Please see next
paragraph below.

Issuance Date The date of the issued item. The issuance date can be updated.

10. Issue Item Cancel: An outstanding issue item can be updated to Cancelled status. Only outstanding
issue items have the option to be changed to Cancelled. Once the issue item is updated to
Cancelled, the cancelled item disappears from all views except Item Lookup, Active Reconciliation (if
enabled), and Audit Report for historical purposes.

Update Issue Item

Serial Number Amount Payee Name’ Status Issuance Date
113687 30 Richard Canova ISSUED v = 04/28/2022
y: ISSUED

VOIDED
CANCELLED

Save
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11. Click Save.

12. A copy of the Issue Warehouse can be downloaded by clicking the Download As CSV button at the
bottom of the Issue Warehouse screen.
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J. Item Lookup

Check Positive Pay (PRO-CHEX) provides Clients with the ability to look up all recorded data on
individual issued items with the Iltem Lookup feature.

1. Within the Check Positive Pay (PRO-CHEX) module, click View > Item Lookup.

Check Positive Pay ~ #Manage ~  # Perform v  JiReports ~ = &= View ~

Issue File Status
Issue Warehouse
Welcome

Item Lookup |

Please use the abhove menu to select an action — [

Reconciliation Periods

2. The Item Lookup page appears. All fields are mandatory.

Item Lookup
Account? Serial Number
- not selecied - b
Account Select the Account drop-down to display a list of the Client’s Accounts.
Serial Number Enter the serial number of the item.

3. Once search criteria are selected, click Apply to complete the item lookup.
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4. Search results for the item are displayed. Within this screen, the lifecycle of the issued item is

displayed.

Item Lookup

Account’

The One and Only - 01111 (ASBank Client 1 - ASBC1) v

Account Number: x00<1111

Transaction Date: 04-15-2021
Payment Date: 04-15-2021
Transaction ID: 45566

Debit Amount: $27.00

Current Status: Pay-System

Transaction Date: 04-15-2021
Payment Date: 04-15-2021
Transaction ID: 43567

Debit Amount: $127.00

Current Status: Pay-System

Issuance Date: 04/15/2021

Updated Date/Time: 04/15/2021 13:34:17 EDT
Load Date/Time: 04/15/2021 13:34:17 EDT

Serial Number: 11548

Original Serial Number: 11548
Original Amount: $27.00
Issuance Payee Name: FedEx
Issuance Serial Number: 11548
Issuance Amount: $180.00

Issuance Status: IS5UED

Original Serial Number: 11548
Original Amount: $127.00
Issuance Payee Name: FedEx
Issuance Serial Number: 11548
Issuance Amount: $180.00

Issuance Status: ISSUED

Update By: mflestwood1
Transaction Id: 45566

Issue Type: ISSUED

View Check Image

Exception Reason: Amount Mismatch
Payee Match Score: Error analyzing payse name

Disposition Created: 04/15/2021 15:00:00 EDT

Exception Reason: Duplicate Presentment
Payee Match Score: Error analyzing payse name

Disposition Created: 04/15/2021 15:00:00 EDT

Payee Name: FedEx
Match Status: PAID
Amount: $180.00
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K. Other Options Prior to Item Presentment

If a Client needs to make changes to an item prior to item presentment, there are three options for doing
so within Check Positive Pay (PRO-CHEX). Examples of changes that would fall under this category would
be when items originally Issued are updated to Voided or Stopped status, or to overwrite existing item
information such as changes in amount and/or payee. If the Fl has disabled stop payments, it will affect
whether a client user can perform these functions in some instances. Please see Subsection B.
Status Values within this Section for more information.

1. Modifying Issue ltems
Issue items can be modified in the Issue Warehouse. Please refer to previous Subsection I. Issue
Warehouse, for more information.

2. Manual Re-Entry

To change individual items previously submitted, a Client user can overwrite the previous item as
follows:

a. Within the Check Positive Pay (PRO-CHEX) Module, click Perform > Manual Issue Entry.

][]
i

Check Positive Pay  #Manage ~ = # Perform ~  JliReports ~

Issue File Load

mem) | ManualIssueEntry |
We I C O m e Transaction Approval

Active Reconciliation

Please use the above menu to sele
Paid No Issue Match
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b. The Manual Issuance File Entry page appears. For definitions of the fields available on this
screen, please refer to Subsection C of the current Section.

Manual Issue Entry

Account? Auto populate next check number:
- not selected - v
Row Serial Number Amount Payee Name’ Status Issuance Date
05/29/202
ISSUED v 05/29/2020

@ Click any row to select that row for editing

Save

c. Create a Manual Entry for the item to be changed. The serial number must match the previously
submitted item. Fill out all fields, updating the fields to be overwritten with the correct information.

d. When all pertinent manual issuance items have been re-entered, click Save button.

e. The Manual Issuance File detail page appears. For definitions of the fields shown on this screen,
please refer to Subsection C of the current Section.

<R ENE MANUAL_1614805777127

File Status

Queued Processed Approved Completed Deleted

File processing is complete. View list below to see item.

@® View item: 1 Item totaling $525.00 Load Date: 03/03/2021 16:09:37 EST
Rows 1-10f1.
Account Number Serial Number Amount Payee Name Status Issuance Date
003783 100945 $525.00 Moe Green AVAILABLE_FOR_MATCHING 03/03/2021
Delete
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3. File Reloads

To change multiple items that were previously submitted, a Client can use the Issue File Load
function to reload and overwrite previous items in an Issue File.

a. Once you have prepared your Issue File with all items to be overwritten, including the corrected
information in the appropriate fields, upload the Issue File. Refer to Subsection F. Loading

Issue Files, for more information.

all activity that has occurred on the issue item.

Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse
(please refer to Subsection I within this Section for information on how to access the Issue
Warehouse). Once within the Issue Warehouse screen, click the arrow (>) next to the Client Code to
view more detail on each issued item. The information shown in this drop-down is an audit history of

As you can see in the figure below, three issue items that have been updated/changed. The
updates/changes from the most recent entries will overwrite the previously loaded issue item.

Date Range
Issue Warehouse =
=uly 21, 2020«
Y Filters >
30 transactions totaling $24,443.62
Rows 1- 25 of 30.
Account Serial Issue Load i s Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timel3 Date Update
v 2278881 woox3210 3454 FedEx WOIDED QUTSTANDING $26.97 07/21/2020 08:55:38  07/21/2020 ra
EDT
Status Payee Amount Issue Date Updated By Updated Date/Time
VOIDED FedEx $26.97 07/21/2020 SallyAcme 07/21/2020 13:08:1% EDT
155UED FedEx $26.97 07/21/2020 Sallyacme 07/21/2020 08:55:38 EDT
» 2278880 wox3210 2453 Office Pride ISSUED QUTSTAMDING $35.00 07/21/2020 08:55:38  07/21/2020 3
EDT -
W 2278879 0003210 24892 ABC Carpentry ISSUED OUTSTANDING 3850.00 07/21/2020 08:55:38  07/21/2020 pa
EDT ’
Status Payee Amount Issue Date Updated By Updated Date/Time
ISSUED ABC Carpentry $850.00 07/21/2020 SallyAcme 07/21/2020 13:09:50 EDT
1S5UED ABC Carpentry £750.00 07/21/2020 SallyAcmet 07/21/2020 08:35:38 EDT
v 2278878 woox3210 3491 Jake Chambers STOPPED OUTSTANDING $150.00 07/21/2020 08:55:38  07/21/2020 ya
EDT
Status Payee Amount Issue Date Updated By Updated Date/Time
STOPPED Jake Chambers $150.00 07/21/2020 SallyAcme 07/21/2020 13:08:44 EDT
155UED Jake Chambers $150.00 07/21/2020 SallyAcme1 07/21/2020 08:535:38 EDT

© 2024 Alkami Technology, Inc.

Proprietary and Confidential Information

Version 2.2.0
Updated 04/30/2024
Page 94 of 199




L. Other Options After Item Presentment

1.

Pay & Issue

Single Pay & Issue is an Enterprise feature allowing a client to direct the system to create an
issue item they failed to send in. This is used for balancing.

Mass Pay & Issue

This feature provides a way to handle system creation of multiple issue items instead of the
user clicking Pay & Issue for each individual issue item if the Client failed to send an entire
file and it resulted in a lot of No Issue exceptions. It also provides a mass pay decision,
instead of addressing them individually.

Pay & Adjust

This feature allows the user to adjust a serial number from the value presented to a new value
and/or the amount from the amount presented to a new value.

If a client user does not have the Pay & Adjust user privilege, the Pay & Adjust button should
not display in the user interface for that user.

Please refer to Section VI, Managing Check Presentment, for more information.
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V. EXCEPTION IDENTIFICATION

Check Positive Pay (PRO-CHEX) is configured to identify exceptions on issue items in a specific order. Once
the first exception is triggered on an issue item, the system does not evaluate the item further. If an item is
flagged with an exception and is deferred to the Client user for decision, further analysis will not be performed.
Client users should be conscious when paying an exception that other validations may not have been

performed, so they should examine the item.

Listed below are the possible Exceptions and the order in which they are flagged by Check Positive Pay
(PRO-CHEX). The Exception Code and Reason below can be customized by financial institution so the
example below may vary slightly from exception codes or reasons that appear in the Client interface.

Exception
Order

1

2

10

Exception Code
Account Blocked

Issuance not found

Issuance already used

Issuance voided

Issuance stopped

Issuance amount
mismatch

Amount over limit

Issuance date in future

Issuance stale dated

Issuance payee mismatch

Reason

Account is Blocked.

Check presented where no issue item is found to match against.

Check presented with a serial number previously presented.

Check presented with a serial number of an issue item marked
with a void status.

Check presented with a serial number of an issue item marked
with a stop status.

Check presented where amount of check differs from issue
amount.

Transaction amount is over the limit.

Check presented with a date before the issuance date on the
issued item.

Check presented with a date exceeding the specified number of
stale days for the account.

Check presented where payee name differs from issue payee
name.
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Exception .
Order Exception Code Reason

This message will only appear to customers of FI's in Fl or

11 Exception reason missing Hybrid Matching mode. This exception reason is only used if the
reason coming into Check Positive Pay (PRO-CHEX) has not
been mapped in Check Positive Pay (PRO-CHEX).

When an account is set to Reverse Positive Pay, and the Treat
All Checks as Exceptions option is configured, all incoming
checks are marked as an exception and presented in the ltem
Warehouse for review and decisioning.

12 Treated as Exception
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VI. MANAGING CHECK PRESENTMENT

The primary objective of Check Positive Pay (PRO-CHEX) is to give users the opportunity to make pay and/or
return decisions on checks presented for payment on accounts enrolled for the service. The decision function is
performed in the Transaction History screen.

NOTE:

e Transactions are stored for 12 months.

The Transaction History user privilege must be enabled to access this screen.

e If the user has been granted the Change Status user privilege and the transaction is available
to decision, the Pay and Return buttons will be available for use.

e Transactions that will be paid will have green shading as a background.

Transactions that will be returned will have yellow shading as a background.

e Transaction status cannot be changed after EOD cut-off time.

Check Positive Pay (PRO-CHEX) provides a function for Clients to search and view the status of checks
presented on enrolled accounts, and to make decisions on presented items. Client users can use
Transaction History to search for presented check items for a specific account using the filtering options
available. The default filter setting is Exceptions Only. Additional transactions may be available to view
and decision (such as reverse positive pay items); however, they will not be displayed unless the
Exception filters option is set to Show All Transactions.
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1. View Transaction History

Within the Check Positive Pay (PRO-CHEX) module, click View > Transaction History. The Transaction
History page displays all current-day transactions for all accounts to which the user has access.

Y Filters

Transaction ID

> 1260078

> 1260077

» 1260076

Transaction History

Mass Pay & Issue Payee Review (16)

Date Range
= Jul 27, 2023 -
>
70 debit transactions totaling $59,841.30
Rows 1 -25 of 70.

Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
X00A4B80 7534 $000.00  Pay-System 07/27/2023 Y §
Y4680 7533 530,00 PaySystem 07/27/2023
04680 7532 $300.00  Pay-System 07/27/2023 $

Mass Pay & Issue

Payee Review

Transaction ID

Account Number

The Mass Pay & Issue button directs the user to the Mass Pay & Issue
Screen, which provides a way to handle system creation of multiple issue
items instead of the user having to click Pay & Issue for each individual
issue item if the Client failed to send an entire file and it resulted in a lot of
No Issue exceptions. It also provides a mass pay decision, instead of
addressing them one at a time.

Please refer to subsection B. Optional Actions in this section for more
information.

The Review Payee button directs the user to the Payee Review screen to allow
users to visually inspect presented items to ensure fraudulent transactions that
may not have triggered any exceptions are identified.

Please refer to subsection C. Review Payee in this section for more
information.

Unique ID assigned by the Check Positive Pay (PRO-CHEX) system when
transactions are loaded.

Account number the check was presented against.
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Serial Number

Credit

Debit

Current Status

Date

Change Status

Exception

The check number presented for payment.

Clicking on the serial number displays the front and back images of the check. If
an eye icon appears in the serial number column, this denotes an item
processed with no serial number. Clicking on the eye icon displays the check
image, if available.

NOTE: While check-related MICR, amount, and payee data are retained for
at least 365 days, Check Positive Pay stores check images for up to 60
calendar days.

This column will display if deposit information has been entered into the system.

This column displays checks.

Pay Pay-System The system is set to default pay this check.

Pay-FI The check was paid by the FI.

In the case of payment items loaded by the
Fl considered in a “Force Pay” status
using the Standard Force Pay template,
these items display with the FI-Pay status
and are ineligible for changes to the
transaction status.

Pay-User The check was paid by the Client User.

Pending-Pay The check was paid by the Client User but
awaits approval or rejection because the
Client is enrolled in Decision Dual Approval.

Return Return-System The system is set to default return this check.
Return-Fl The check was returned by the FI.
Return-User The check was returned by the Client User.

Date the check was presented for payment or loaded to Check Positive Pay
(PRO-CHEX).

If the user has been granted the Change Status user privilege and the
transaction is eligible for a decision, a Pay or Return button will appear for use.
If the transaction is not eligible for a decision, the button will display as
Ineligible.

Various Icons inform the user of the item exception(s). Hovering over the icon
gives the user a quick glance at the exception reason. Likewise, users can click
the drop down arrow to the left of the transaction to see what the specific
exception is for the transaction.
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Icon

©O 8 & O 0 Q L

bo

Exception Code

Issuance Not Found

Issuance Already Used

Issuance Voided

Issuance Stopped

Issuance Amount
Mismatch

Amount Over Limit

Early Presentment

Issuance Stale Dated

Issuance Payee
Mismatch

Exception Reason
Missing

Treated as Exception

Exception Reason

Check presented where no issue item is found to match
against.

Check presented with a serial number previously presented.

Check presented with a serial number of an issue item marked
with a void status.

Check presented with a serial number of an issue item marked
with a stop status.

Check presented where amount of check differs from issue
amount.

Transaction amount is over the limit.

Check presented with a date that is before the issuance date
on the issued item.

Check presented with a date that exceeds the specified
number of stale days for the account.

Check presented where payee name differs from issue payee
name.

This message will only appear to customers of Fl's that are in
Flor Hybrid Matching mode. This exception reason is only
used if the reason that is coming into Check Positive Pay
(PRO-CHEX) has not been mapped in PRO-CHEX

When an account is set to Reverse Positive Pay, and the Treat
All Checks as Exceptions option is configured, all incoming
checks are marked as an exception and presented in the Item
Warehouse for review and decisioning.

a. To filter the date range of items shown, click on the Date Range drop-down.

Date Range
Transaction History B Jul 27, 2023 -
Mass Pay & Issue Payee Review (16) Start Date! End Date’ Tomorrow
07/27/2023 Q7/27/2023
July 2023 August 2023
70 debittransac Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr sa  Yesterday
ROW 25 26 27 28 29 30 1 1.2 3 4 5 Last 7 Days
l 2 3 4 5 & 7 & & 7 B 9 10 11 12 This Month
9 10 11 12 13 14 15 13 14 15 16 17 18 19
- Last Month
16 17 18 19 20 21 32 20 21 22 33 24 35 6
Custom
Transaction ID Account Number Serial Number Credit 23 24 25 EEE 28 29 27 28 2% 30 31 1 2
Y
» 1260078 WOABE0 7534 m Cancel
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b. To narrow the search results, click Filters and a window containing additional search criteria will
appear.

Y Filters

Account’

Amount

$

Serial Number

Positive Pay Type

Any

Transaction History

Mass Pay & Issue Payee Review (16)

Date Range
£ Jul 27, 2023 -
v
Exceptions ] Default Items
Any v Any v
Amount Range Exception Type Transaction Status
Any v Pay
Pay-System
Serial Number Range Pending Dual Approval Pay-FI
Pay-User
Any v Return
Return-System
Transaction Type Return-FI
v . Return-User
Any hd
Use the "Ctrl" key to select multiple status
Transaction ID types above
Apply SR

Account

Amount

Serial Number

Positive Pay
Type

Type an account name or the last 4 digits of the account number into the field to view
transactions for one specific account or select an account from the drop-down menu.

Enter a specific amount for the transaction.

Amount Range Click the hyperlink above the Amount field to enter an amount

range or a maximum or minimum amount of transaction.

Min Amount Minimum dollar amount of transaction.

Max Amount Maximum dollar amount of transaction.

Type the item serial number for a specific issued item.

Serial Number Range Click the hyperlink above the Serial Number field to enter a
serial number range or a maximum or minimum serial

number.

Min Serial # Minimum serial number

Max Serial # Maximum serial number

This filter defaults to Any. Select the Positive Pay Type drop-down to filter by:

Standard: Transactions on accounts set up for Standard Positive Pay
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Exceptions

Exception Type

Pending Dual
Approval

Transaction
Type

Transaction ID

Items

Transaction
Status

Reverse: Transactions on accounts set up for Reverse Positive Pay

Blocked: Transactions on accounts set up for Block Positive Pay

None: Transactions on accounts set up for No Positive Pay

This defaults to viewing Exceptions only. Select the Exceptions drop-down to filter by:
Exceptions Only: Only exceptions are displayed.

Show all Transactions: Exceptions and non-exceptions are displayed.

No Exceptions: Only non-exceptions are displayed.

The user can opt to set an option to be the default for future filtering by clicking the Default
checkbox once the selection has been made.

This user documentation displays the standard exception reason labels; however, each Fl
can customize these during implementation, so what is seen in the documentation may
differ from what users see in the service if their Fl has customized the labels.

If the FI has enabled Decision Dual Approval, this field may be available in the filter
window. The user may select from the drop-down to filter transactions based on whether
or not they are pending approval.

e Yes — will display only transactions that are pending approval.
e No — will display only transactions that are not pending approval

The default will be set to “Show All”.

For more information regarding Decision Dual Approval, please see Section VIII,
Decision Dual Approval.

This filter defaults to Any. Select the Transaction Type drop-down to filter by:
Check: Check transactions only

Deposit: Deposits only

A unique number assigned to the transaction when loaded.
Defaults to Any Items. Select the drop-down to select one of the following:

e Any ltems: This includes all items, including client pay and adjust items.
e Adjusted Items: Checks that were paid by a client user and either the amount
and/or serial number was adjusted.

Pay Pay-System The system is set to default pay this check. If a user takes no
action before EOD, the check will pay.
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Pay-Fl

Pay-User

Pending-Pay
Return

Return-System

Return-Fl

Return-User

The check was paid by the FI.

In the case of payment items loaded by the Fl in a “Force
Pay” status using the Standard Force Pay template, these
items display with the Fl-Pay status and are ineligible for
changes to the transaction status.

A user changed the transaction status from a Return to a Pay
status.

The check was paid by the Client User but awaits approval or
rejection because the Client is enrolled in Decision Dual
Approval.

The system is set to default return this check. If the user takes
no action before EOD, the check will be returned.

The check was returned by the FI.

A user changed the transaction status from a Pay to a Return
status.

c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue
items, the results are displayed on multiple pages. Use the navigation buttons at the top of the
search results to review all results.

45 debit transactions totaling £34,896.60

Rows

nnnnn

P

- 25 of 45.

e. Summary Debit and/or Credit transaction totals are also displayed at the top of the screen above

the navigation buttons.
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Transaction History

Date Range
& Mar 04, 2024 ~

Mass Pay & Issue Payee Review (12)

Y Filters
Transaction ID Account Number
v 1276023 Xxx4680

Account Name: Evens

Positive Pay Type: payee

Issuance Payee Name: Natalie North
Issuance Serial Number: 9108
Issuance Amount: $30.00

Issuance Date: 03/04/2024

Original Serial Number: 9108
Original Amount: $30.00

v 1276022 XXxx4680

Account Name: Evens

Positive Pay Type: payee

Issuance Payee Name: Markus Melton
Issuance Serial Number: 9107
Issuance Amount: $260.00

Issuance Date: 03/04/2024

Original Serial Number: 9107

Original Amount: $300.00

?
21 debit transactions totaling $2,801.68
Rows 1-21of 21
Serial Number Credit Debit Current Status Datel Change Status Exception
9108 $30.00 Pay-System 03/04/2024
Payment Date: 03/04/2024 Adjust Notes (0)

Payee Analysis: Pass

[¥e]}
[=1
)

$300.00 Return-User 03/04/2024 $4

Return Date: 03/04/2024 5:30 PM EST Adiust Notes (0)
Return Reason: Wrong Amount
Loaded Exception Reason: Amount Mismatch

Payee Analysis: Fail

f. Click the arrow (>) next to the Client Code to view more detail on each issued item. The
information shown in this drop-down is an audit history of the activity on the issue item.

Account Name

Positive Pay Type

Issuance Payee Name

Issuance Serial
Number
Issuance Amount

Issuance Date

Original Serial Number

The name assigned to the account.

This indicates the type of positive pay that the account is set for:
Standard, Reverse, and Payee are the different types that could display here.

Name of payee submitted with the transaction presented for payment.

Serial number on the issued item uploaded by the client.

Amount on the issued item uploaded by the client.
Date the issued item uploaded by the client.

Serial number submitted with the transaction presented for payment.
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Original Amount

Return Date
Payment Date

Return Reason

Loaded Exception
Reason

Originally Cleared Date
Originally Cleared
Amount

Originally Cleared
Status

Payee Match Score

Payee Analysis

Adjust

Notes

Amount submitted with the transaction presented for payment. This number may
be different than displayed in the top line. For instance, if an item was adjusted in
pre-scrub by the Fl or if the Fl is allowing Clients to adjust.

Date the item was returned.
Date listed within the transaction file.

Reason for return. Client users can click on the Return Reason hyperlink to open
a pop-up window to select a different return reason as needed.

v 1276018 XXXX4680 9103 $180.00 Return-User 03/04/2024

@pay § o2

Account Name: Evens Return Date: 03/04/2024 5:30 PM EST

Positive Pay Type: payee Return Reason: Payee Name Mismatch |

Issuance Payee Name: Imelda Irwin Loaded Exception Reason: Stop

Issuance Serial Number: 9103 Payee Analysis: Fail
Issuance Amount: $180.00
Issuance Date: 03/04/2024

Original Serial Number: 9103

Original Amount: $180.00

When an item is in Pending-Pay status and awaiting approval or rejection
because the account is set up for Decision Dual Approval, the Return Reason
hyperlink will be disabled.

This user documentation displays the standard exception reason labels;
however, each Fl can customize these during implementation so what is seen in
the documentation may differ from what the User may see in the service if their
Fl has customized the labels.

Please refer to Section V. Exception Identification to view a list of all standard
exception labels.

In the case of Duplicate Presentment exceptions, the Originally Cleared Date will
display the cleared date of the originally presented item.

In the case of Duplicate Presentment exceptions, the Originally Cleared Amount
will display the cleared amount of the originally presented item.

In the case of Duplicate Presentment exceptions, the Originally Cleared Status
will display the status of the originally presented item.

Payee scoring is addressed in the account configuration screen. The score
displayed here is the score assigned by the payee analysis engine when the
payee name on the check was compared to the payee name provided on the
issue item file.

Will display as Pass or Fail based on payee scoring.

This button will allow users to adjust a serial number from the value presented to
a new value and/or the amount from the amount presented to a new value.
Please see subsection B. Optional Actions for more information on this
function.

This feature allows Fl and Client users to make notes regarding a transaction in
Pay or Return status. The Note button displays how many Note entries have
been made on a transaction. Click on the Notes button to enter in pertinent
information regarding a transaction.
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2. Change Transaction Status

a.

If the user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay or Return button appears for use. If the transaction is not eligible for a decision,
the button will display as Ineligible. Reasons for the “Ineligible” message could include the item
being a deposit, the item already being decisioned or left at the system default, or the item being
a Force Pay item loaded by the Fl using the Standard Force Pay template.

3. Change Status — Pay

s

a. Ifthe Current Status on an issued item is set to Return, the Client can opt to change the status to
Pay if the Client determines the check should be paid.
b. Click the Pay button under the Change Status column.
Transaction ID Account Number Check Number Credit  Debit Current Status Dateli Change Status Exception

7740764

xxxx1115 7345 $900.00  Return-User 04/07/2023 0

The Change Status button will then change to Return, and the Current Status column will update
to “Pay-User.”

4. Change Status — Return

a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to
Return if the Client determines the check should not be paid.
b. Click the Return button under the Change Status column.
v 7740763

XHX1115 7344 $30.00  Pay-System 04/07/2023 ;]
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c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check
Return. Please note that the list of return reasons displayed are the system default but may vary
depending on the way the financial institution defines them.

Amount Incorrect
Duplicate
Fraudulent

Prior Stopped
Prior Void

Refer to Maker
Serial # Incorrect
Signature Irregular
Signature Missing

Stale Date

Suspect Item -
Review Required

Select a check return reason:

Amount Incorrect
Duplicate
Fraudulent

Prior Stopped

Prior Void

Refer to Maker
Serial # Incorrect
Signature Irreqular
Signature Missing

Stale Dated

Sawve

The dollar amount is incorrect.

This item has already been presented.
Fraudulent item.

This item has a stop payment placed on it.
The item was previously voided.

Refer to the maker of the check.

The serial number on the item is incorrect.
The signature does not match.

The item is missing a signature.

The presented item has a date greater than the number of stale days allowed on
the corresponding issued item.

The item is suspicious and possibly fraud — please review further.
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a. Click Save. The system displays a success message.

Check will be returned

b. The Change Status button will then change to Pay, and the Current Status column will update to

Return-User.”

5. For transactions that list the Duplicate Presentment exception reason, the user can view the
duplicate and previously presented check items to visually inspect the checks. Click on the Duplicate

Presentment hyperlink to open the Check Image window.

v Check 7114 Xxxx4680 5/22/23 900.00 Pay-System
Transaction ID: 1158611 Payment Date: 05/22/2023
Positive Pay Type: payee Loaded Exception Reasont Duplicate Presentment
Issuance Payee Name: Oliver Orville Originally Cleared Date: 05/21/2023 8:00 PM EDT
Issuance Serial Number: 7114 Originally Cleared Amount: $900.00
Issuance Amount: $933.00 Criginally Cleared Status: Paid
Issuance Date: 05/22/2023 Payee Analysis: Fail

Original Serial Number: 7114

Original Amount: $900.00

o0

Notes (0)
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6. The Check Image window opens, with the Duplicate Exception item and Previously Presented item
displaying so that the user can visually inspect both items. Click the Show Back button to view the
back of the checks.
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7. The backs of the Duplicate Exception item and the Previously Presented item appear. The user can
visually inspect the images. Click the Show Front button to return to the front view of the checks.
Click the Close button to return to the Transaction Warehouse view.
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8. In the expanded transaction view, both the current and previously presented check data displays for

comparison.
v Check 7114 XX 4680 5/22/23 900.00 Pay-System ow
Transaction ID: 1158611 Payment Date: 05/22/2023 Adiust Notes (0)
Positive Pay Type: payee Loaded Exception Reason: Duplicate Presentment
Issuance Payee Mame: Oliver Orville Originally Cleared Date: 05/21/2023 8:00 PM EDT
Issuance Serial Number: 7114 Originally Cleared Amount: $900.00
Issuance Amount: $933.00 Criginally Cleared Status: Paid
Issuance Date: 05/22/2023 Payee Analysis: Fail

Original Serial Number: 7114
Original Amount: $900.00
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9. A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the
bottom of the Transaction History screen.

1. Confirm Paying Exceptions (May or may not be implemented by the FI)

a. When the first exception is triggered on a presented item, additional validations are not
performed. If the system detects a user pay decision on a check that additional validations were
not performed (such as payee name analysis which is the last validation to occur), an image of
the check is presented to allow the user to visually inspect the check. The user must click the
confirm button to finalize the pay decision.

b. If the user decides to pay an item that is set to return, a pop-up window appears to confirm that
this is the action they wish to take. The window displays an image of the check and other details
for the user to review before confirming that they want to pay the item.
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Click Pay to pay a check.

Confirm Check

. - - - """ ""—"-"=""""""""""-"="—""""—=-—--"-"-"—-"=-—--—-"=—-—"=—-=-7 ™
James C. Morrison Test ’tem .
: ‘l{?uﬂ(:-‘_\n._\\}.-hcrc :;in.;lc ** oid ** Check Number 113747 :
| YouCiv.sate 1234 Abri 29, Z024 i
| Date |
| n'"'"""""""""""": |
Yoot Nedical Advance - '
: Order Of a ' $ 2&400 :
| feessmsssssscscscssesonsnens “
| |
 amount _TWenty our and No cents |
| Dellars |
| . |
| memo_IQN: signawre _ Sy 1DE] aCTE |
e e _

Exception Reason: Issuance Payee Mismatch

Issuance Serial Number: 113747 Issuance Amount: $24.00
Issuance Payee Name: Advanced Payee Match Score: 13
Medical

Cancel

n3ccd?eLbLinn 4357943579 443747 000000 eL00s

Amount and Serial Number may be adjusted after Confirm

1) A pop-up window with check information displays for the user’s review.

2) Once the user has reviewed the information presented, they can decide to Confirm so
that the check will be paid or to Cancel so that the check will be returned.

2. Pay & Issue

a. This Enterprise feature must be enabled by the financial institution and the user must have the
Manual Issue Entry, Load Issue File and Change Transaction Status user privileges. If an
exception is triggered because no issue item exists and the user pays the check, the user is
presented with a link allowing them to tell the system to create a matching issue item.
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b. If Client Pay & Issue is enabled, the expanded view on the item displays an Add Issue button.
Click the button to proceed.

v 20537 o1 111 9718 $36.10  Pay-System 07-21-2020 ¢

Positive Pay Type: Payee Payment Date: 07-20-2020

Add Issue
Criginal Serial Number: 9718 Exception Reason: No Issue Item

Criginal Amount: $36.10

i.  The Add Issue Item pop-up displays. The Serial Number, Amount, and Status fields are
locked from editing. Click in the Payee Name field to enter a payee name, or in the Issuance
Date field to select the date of the issued item.

Add Issue Item:

Serial Number Amount Payee Name’ Status Issuance Date
G718 36.1 Office Pric:E| ISS5UED = 07/21/2020
P
Save

1) Click Save. A success message appears.

NOTE:

e Items with duplicate presentment exceptions will not present the option to Add Issue from
within Transaction History, as another item has been presented and paid with that serial
number.

e The system will not allow the “Add Issue” function for a check with no serial number.

e “Add Issue” is not available for transactions in Reverse Positive Pay accounts.
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3. Mass Pay & Issue

a. This Enterprise feature must be enabled by the financial institution and the user must have the
Manual Issue Entry, Load Issue File and Change Transaction Status user privileges. Clients on
standard or payee positive pay should ALWAYS enter or load issue items prior to distributing
checks to avoid denial of payment at the teller line. However, should a client fail to enter or load
issue items and many No Issue Exceptions occur as a result, this feature allows the user to have
issue items systematically created for each item without clicking on each exception item
individually and to pay all items at once instead of individually.

b. If Mass Pay & Issue is enabled, a button displays at the top of the Transaction History screen:
“‘Mass Pay and Issue.”

Date Range
Transaction History & Mar 04, 2024 ~
Y Filters >

c. The Mass Pay & Issue page appears. A list of issue items displays with checkboxes for each
issue item.

< Back

Mass Pay & Issue

Rows 1 - 25 of 35.

n 2

Select
[all | none] Account Number Serial Number Amount Datel? Current Status

O XXx%4680 9144 $900.00 03/04/2024 Pay-System

(] XXxXx4680 9143 $30.00 03/04/2024 Pay-System

O XXx%4680 9142 $300.00 03/04/2024 Pay-System

O XXx%4680 9141 $700.00 03/04/2024 Pay-System

(] X00AGE0 9140 $166.00  03/04/2024 Pay-System

O XXx%4680 9139 $90.00 03/04/2024 Pay-System
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d. Individual issue items can be clicked for Pay and Issue. Once all issue items are selected, click
“Pay and Issue Selected” button at the bottom left of the screen.

Pay & Issue Selected _ Pay & Issue All 35

e. To approve all issue items to Pay and Issue, click “Pay & Issue All [number]” button. The Mass
Pay & Issue page displays 25 issue items per page. The “Pay & Issue All [number]”’ button will
Pay & Issue all the available issue items on all pages. The button displays the total number of
issue items available.

Pay & Issue Selected - Pay & Issue All 35

f. A “Confirm Mass Pay & Issue” pop-up window appears. Click Cancel to return to the Mass Pay &
Issue screen, or click Confirm to continue.

Confirm Mass Pay & Issue

Mark 29 checks as paid and add issue item

Click Cancel to return or Confirm to continue

A success message appears.

29 checks paid and issues added

NOTE:

e The Mass Pay & Issue button is also available within the Consolidated Transaction History
screen. Please refer to the FPHQ Client User Guide for more information.

e The system does not allow the “Add Issue” function for a check with no serial number.

e “Add Issue” is not available for transactions in Reverse Positive Pay accounts.
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4. Pay & Adjust

a. This Enterprise feature must be enabled by the financial institution and the user must have the
Manual Issue Entry, Load Issue File and Change Transaction Status user privileges. The Fl may
allow users to adjust a serial number from the value presented to a new value and/or the amount
from the amount presented to a new value.

b. If Client Pay & Adjust is enabled, a link displays under the Pay button: “Adjust”

Transaction ID Account Number Serial Number Credit Debit Current Status Datels Change Status Exception

1276019 XXXX4680 9104 $90.00  Pay-System 03/04/2024

Account Name: Evens Payment Date: 03/04/2024 - Adjust Notes (0)

Positive Pay Type: payee Payee Analysis: Pass
Issuance Payee Name: Jason Jones

Issuance Serial Number: 9104

Issuance Amount: $90.00

Issuance Date: 03/04/2024

Original Serial Number: 9104

Original Amount: $90.00

i. Click Adjust.

1) The Adjust pop-up screen displays. The fields available in Adjust are contingent upon
what the FI has enabled. In this example, the Adjust screen includes check amount and
serial number. Enter the correct serial number and/or amount.

Adjust Check Amount and Serial Number:

Serial Number:

Amount;

Save
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2) Click Save. The Transaction History page displays the adjusted serial number and/or
adjusted amount.

z
Transaction ID Account Number Serial Number Credit Debit Current Status Datels Change Status Exception
v 1276019 XXXXA680 9104 $90.00 Pending-Pay 03/04/2024
Account Name: Evens Payment Date: 03/04/2024 Adijust Motes (0)
Positive Pay Type: payee Payee Analysis: Pass

Issuance Payee Name: Jason Jones
Issuance Serial Number: 9104
Issuance Amount: $30.00
Issuance Date: 03/04/2024
Original Serial Number: 9104

Original Amount: $90.00

3) When the serial number is changed using Pay & Adjust, any issuance items previously
matched and used by this transaction will be marked as “Available for Matching”,
releasing the issuance for matching by future transactions. In addition, issuance
matching will be performed using the new serial number and if any issuance is found it
will be marked as “Used in Matching.”

NOTE:

If a client user does not have the Pay & Adjust user privilege, the Pay & Adjust button should not display
in the user interface for that user.
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C. Review Payee

Although payee analysis is a good technology, it is not a perfect technology. The Review Payee functionality
has been introduced to allow users to visually inspect presented items to ensure fraudulent transactions that

may not have triggered any exceptions are identified.

1. If Payee Positive Pay is configured by the FI, the Review Payee feature may be available in
Transaction History. Review Payee allows users to easily view non-exception items for transactions
on accounts enrolled in Payee Positive Pay.

2. From within Transaction History, the Payee Review button appears at the top of the screen with the
total number of non-exception items available for review in parentheses. Click the Review Payee

button to proceed.

Transaction History

Mass Pay & Issue Payee Review (13) [ ]

Date Range
& Mar 04, 2024 ~

Y Filters >
80 debit transactions totaling $74,995.17
Rows 51 - 75 of 80.
1 2 4
z

Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
» 1276019 00680 $90.00 Pending-Pay 03/04/2024
> 1276018 XHOXA680 $180.00 Return-User 03/04/2024 oL
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3. The Payee Review screen appears. The Payee Review page displays all current day non-exception
transactions for all accounts to which the user has access.

< Back

Payee Review

Y Filters

Transaction Information

Transaction ID: 1276023
Account Number: W04680
Serial Number: 5108
Amount: $30.00
Issuance Payee: Natalie North
Transaction ID: 1276012
Account Number: WXHXA680
Serial Number: 3097
Amount: $53.36

Issuance Payee: Craig Callahan

Image

?
Rows 1-12of 12.
Change Status

MNon-Negotiable
T T T T T T T T T T T T T T T T T T T T T T T T -
| James . Momison |
| 12345 AnyWhere Circle CHECK NO DATE AMOUNT |
| Your City, State 12345 GT0R 0370472024 T 3000 |
: ** Void ** Void ** Void ** :

Pay To the . P —" f M
: Ortllfel' of Natalie Nnr\h-r, |—'|| :'15\'1 — |—' ]l ['_. ,—” [Ir_‘ ."_l :

' f

: TES T 1TLEN |
| Amount Thirty_and No defiis |{ |L / ! ] | '| — |
! o\ 4 U U =iyl |
| Memo _ISN: 46103819 signature —S E] aete !
M o o o o o o — — — —— — — — ——— ——— ——————————————— -

[HE L L TH cLEA02LEAO"S W08 0000003000

James C. Morrison
12345 AnyWhere Circle
Your City, State 12345

Test Capture Only

Mon-Megotiable

CHECK NO |

ANMOUNT
9097 [$ 5500

[ DATE I
03 /04 /2024

Pay Craig Callahan
ToThe
Order

Fifty five and No cents

Transaction ID

Account Number

Serial Number

Amount
Issuance Payee
Image View

Change Status

Unique ID assigned by the Check Positive Pay (PRO-CHEX) system when

transactions are loaded.

Account number the check was presented against.

The check number presented for payment.

The amount of the check.

Name of payee submitted with the issuance presented for payment.

The front image of the check will display for review

The Return button is available for the user to change the status of the

transaction to Return.

© 2024 Alkami Technology, Inc.
Proprietary and Confidential Information

Version 2.2.0

Updated 04/30/2024

Page 120 of 199




4. To narrow the review screen results, click Filters and a window containing filter criteria will appear.

Payee Review

Y Filters v

Account’ Serial Number Serial Number Range

Any v

Amount Amount Range

$

Account Type an account name or the last 4 digits of the account number into the field to view
transactions for one specific account, or select an account from the drop-down menu.
Amount Enter a specific amount for the transaction.
Amount Range Click the hyperlink above the Amount field to enter an amount

range or a maximum or minimum amount of transaction.

Min Amount Minimum dollar amount of transaction.
Max Amount Maximum dollar amount of transaction.
Serial Number  Type the item serial number for a specific issued item.

Serial Number Range  Click the hyperlink above the Serial Number field to enter a
serial number range or a maximum or minimum serial number.

Min Serial # Minimum serial number

Max Serial # Maximum serial number

5. Once search criteria are selected, click Apply to narrow your results.

6. Results are displayed in pages of 25 items. If the Review Payee screen contains more than 25
items, the results are displayed on multiple pages. Use the navigation buttons at the top of the
review screen to review all results.

Rows 1 -25of 29
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7. To change the transaction status to Return, click the Return button.

Transaction Information

Account Number:

Issuance Payee:

Image Change Status
1276012 .
Jumes €. Mormison Test Capture Only
XXxx4680 12345 AnyWhere Circle Non-Negotiable
Your City. State 12345 =0
9097 i [ DATE [ cHECKNO. | AMOUNT ]
37047202 9097 > 55.
R 03 /0472024 09 [$ 5500 |
Craig Callahan Pay Craig Callahan

g;d“ Fifty five and No cents

ISN: 46103808

nigea?aLban

** Void ** Void ** Void **

S beloere

¢LBA0 2LEA09097 0000005500

and click the Save button to proceed.

8. A pop-up window will display to select a check return reason. Select the appropriate return reason,

Select a check return reason:

® Amount Incorrect

' Duplicate Presentment
' Fraudulent

) Prior Stopped

O Prior Void

() Refer to Maker

() Serial # Incorrect

' Signature Irregular

i Signature Missing

) Stale Dated

Save

© 2024 Alkami Technology, Inc.
Proprietary and Confidential Information

Version 2.2.0
Updated 04/30/2024
Page 122 of 199



9. Once the return reason is saved, the user will be returned to the Review Payee screen, and the
Return button will be displayed as an Undo button. If the user determines that the Return should be
undone, clicking the Undo button will change the status back to Pay, and the screen will revert the
button to Return.

Transaction Information Image Change Status
Transaction ID: 1276012 ~

Tames C. Moariso
Account Number: 30004680 o et Test Capture Only

PO N Mon-Megotiable

. Yaur City, State 12345 £
Serial Number: 9097 [ DATE [ cHECKNO | AMOUNT ]
03 /0472024 9097 b 55.00

Amount: $53.36 I ]$
Issuance Payee: Craig Callahan Pay Craig Callahan

g;“' Fifty five and No cents

** Void ** Void ** Void **
1SN: 46103808 S be]_(:ere
nigch?eLL A tLEAD ZLEBO*S0S7 +0O0D0O0055004

Transaction ID: 1276009

James €. Mortis -
Account Number: XHKXx4680 ,';“:: ._\“Y“.-',‘,::;nt-i“.h_ . Test Capture Only

. \'ulllt'il_x-. State 12345 Non-Negotiable
Serial Number: 9094 DATE CHECK NO AMOUNT
{04 7202 B 93333

Amount; $933.00 0310412024 9094 § o333
Issuance Payee: Mary Moses . Mary Moses

Ovlesr

.
Nine hundred thirty three and 33 cents

** Void ** Void ** Void **

ISN: 46103805 S DeLaere

nigeh?eLLan tLEA0 LEADH0SL +#O000093333

10. Click the Back button at the top of the screen to return to the Transaction History screen.

< Back ==

Payee Review

Y Filters >
Rows 1-11of 11
Transaction Information Image Change Status
Transaction 1D: 1276012 .
Account Number: WOEXA680 :11"1:: (,‘“':I\":-::::_n‘_mc Test Capture Only
Your City, State 12345 Non-Negotiable
Serial Number: 9097 I DATE I CHECKNOD. | AMOUNT I
P PSR @ e
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11. The user is returned to the Transaction History view and may see the following alert message:

In order to view your changes, please refresh your
browser and review your filters.

12. Refresh the browser window to view the changes to the Transaction History screen. The user should
see the previously changed item with the status of Return-User.

> 1276012 XXxx4680

[X=}
=]
[X=)
=~

$53.36  Return-User 03/04/2024

D. Notes

1. If enabled, the Notes feature allows Fl and Client users to make notes regarding a transaction. The
Notes button displays the number of Note entries added to a transaction. Click the Notes button to
enter in the information regarding the transaction.

z
Transaction ID Account Number Serial Number Credit Debit Current Status Datel: Change Status Exception

v 1276019 XXXXABE0 9104 $90.00 Pending-Pay 03/04/2024
Account Name: Evens Payment Date: 03/04/2024 —

Positive Pay Type: payee Payee Analysis: Pass
Issuance Payee Name: Jason Jones

Issuance Serial Number: 9104

Issuance Amount: $90.00

Issuance Date: 03/04/2024

Qriginal Serial Number: 9104

Original Amount: $90.00
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2. The Transaction Notes screen appears. Users can enter notes within this interface, and a log of

notes added to a transaction appears in the lower part of the screen.

Transaction Notes

Client Mote Text 1

Save

Created Date

2024-03-04T19:37:09.549080Z

Created By

FI USER - IdelaereAS1

MNote

Transaction Note 1

Cancel
3. The user can click the Cancel button to cancel without placing notes on the transaction.
Transaction Notes

Client Note Text 1

Save

Created Date Created By Note

2024-03-04T719:37:09.549080Z FI USER - IdelaereAS1 Transaction Note 1
Cancel
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4. Once a Notes entry is completed, the user must click Save to record the entry.

Transaction Notes

Client Note Text 1

Save

Created Date

2024-03-04T19:37:09.549080Z

Created By

FI USER - IdelaereAS1

Note

Transaction Note 1

Cancel
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5. The created note will now display in the audit history log at the bottom of the screen, along with any
other notes previously added to this transaction.

Transaction Notes

Created Date Created By Note
2024-03-04T19:42:05.608331Z CLIENT USER - sdelaere1 Client Mote Text 1
2024-03-04T19:37:09.549080Z FI USER - IdelaereAS1 Transaction Note 1

Cancel

6. The user can enter up to 4,000 characters in the Transaction Notes window. Multiple notes can be
added within the 4,000 character limit.
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7. Click the X button at the top right of the Transaction Notes window to close the window.

Transaction Notes

a4

Created Date
2024-03-04T719:42:05.6083317

2024-03-04T19:37:09.549080Z

Created By
CLIENT USER - sdelaerel

FI USER - IdelaereAS1

Note
Client Note Text 1

Transaction Note 1

Cancel

NOTE:

e Notes can be added to transaction after EOD processing.
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VIl. MATCH PAID ITEMS

Check Positive Pay (PRO-CHEX) supports the ability for FI and Client Users to match issue items loaded to the
system after cleanup has been performed to Paid No Issue exception items.

NOTE:

date, matching is not allowed.

e The Paid No Issue Matching user privilege must be enabled.
e If Reconciliation is enabled and both the issuance and payment date precede the period start

e Items will not appear in the Paid No Issue Match screen until EOD has passed.

A. Paid No Issue Match

1. From the Check Positive Pay (PRO-CHEX) module, click Perform > Paid No Issue Match.

Check Positive Pay % Manage ~ | # Perform ~
Issue File Load

Welcome

Please use the above menu to sel¢

Manual Issue Entry
Transaction Approval

Active Reconciliation

Paid No Issue Match

i Reports ~

) ¢

2. The Paid No Issue Match screen displays with the current month date range by default. To filter the
date range, click on the Date Range drop-down, select the desired range, and click the Apply button.

© 2024 Alkami Technology, Inc.
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Date Range
Paid No Issue Match = Jul 27, 2023 «
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Account Start Date’ End Date TR
07/27/2023 07/27/2023
July 2023 August 2023
ROW Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa  Yesterday
Select 25 26 27 28 29 30 1 i 2 3 4 5 last7Days
[all | none] Serial Number Payment Date Paid Amouwl 5 3 4 5 &5 7 & s 7 8 9 10 11 12 This Month
5 o g 10 11 12 13 14 15 13 14 15 16 17 18 19
Select an account to search 3 5 R DY
1% 17 18 19 20 21 22 20 21 22 23 24 25 26
Custom
23 4 25 I E 28 29 27 28 29 30 3 1 2
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3. Inthe Client portal, the Paid No Issue Match screen must be filtered by Account to display data.
Type an account name or the last 4 digits of the account number to generate the SmartSearch filter.

Date Range

Paid No Issue Match & jul 27, 2022 -
Account’

testd
Select Account Rows 1 - 25 of -2

TestRecon - }ox3579

L | e g - D uyiene wu Paid Amount Issue Amount Issue Date Issue Type Payee Name
Select an account to search for available transactions to match

4. Once the Account filters has been entered, the screen displays all outstanding issue items that can
be matched to Paid No Issue items previously cleared. The first line in each row presents information
on the outstanding issue item, and subsequent lines will be one or more paid no issue items that can

be matched to the outstanding item.

Paid No Issue Match Date Range

Eapril 1, 2022 - April 30, 2022~

Account’
clear
Rows 1-110f11.
Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type  Payee Name
O 113696 04/21/2022 $ 750.00 ® 5750.00 04/22/2022 ISSUED ABC Carpentry
O 113695 $150.00 04/22/2022 ISSUED Jake Chambers
04/21/2022
04/21/2022
O 113624 $150.00 04/22/2022 ISSUED Mesta Archeron Elain Archeron
04/21/2022
04/21/2022
O 113693 £ 2800.00  04/22/2022 ISSUED Michael Farrell
04/21/2022 % 2800.00 ®
04/21/2022 % 2800.00 ®
(] 113692 $193.93 04/22/2022  ISSUED Cuyahoga County Clerk
04/21/2022 $293.03 &
04/21/2022 $293.03 ®
Select [all | none] The user can opt to select individual transactions by clicking the checkbox
at the left of the row. If an issue item has more than one matching
incoming transaction, the radio button for the transaction the user wants to
tie to the issue item must also be selected.
The client can also select all transactions by clicking “all” in the Select
column. The client can de-select all transactions by clicking “none”.
Serial Number The serial number of the item.
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Paid Amount Amount of the paid no issue item.

Clicking the eye icon next to the paid amount will allow the user to view the
check image of the paid no issue item.

Issue Amount The amount of the outstanding issue item.
Issue Date The date of the outstanding issue item.
Issue Type Issuance type of the outstanding issue item. Matching can be performed to

Issued, Voided, or Stopped unmatched issuance items.

Payee Name The payee name listed on the outstanding issue item.

5. The user can view check images of the paid no issue items to compare to the outstanding issue item
to determine if the items are indeed a match. Click the eye icon next to the paid amount for any paid

item to view.
Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type Payee Name
_ 113696 04/21/2022 $75000 @ $750.00 04/22/2022  ISSUED ABC Carpentry
[ 113695 $150.00 04/22/2022 ISSUED Jake Chambers
04/21/2022 $ 150.00 @_
04/21/2022 $150.00 @
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6. A pop-up window with images of the front and back of the check displays. If there is more than one
paid items, examine both check images to confirm if either is a match. Click the Close button to close
the check image view.

Check Image
O amesC. Momison  _ g ~ & Testitem o
: I’zu.w: i\n}\\-‘here(jrcle m ** Void ** Check Number 113697 :
| Your City, State 12345 Noa-Negotishle Date AP".I 21‘ 2022 I
| I
I JTTTTTTTTTTTTTmssssmsmememn
| Pay To th E '
: Osrlgarootf ° FQJE* ' $ 180.00 :
e T
: Amount On€ I\unJr QJ E;q'\ly mﬁJ NO cCnis :
| Dollars |
| I
| Memo DN: "l'ooo“'? Signature _b Del_qere [
e o o e e e o e e e — -

nicdd?eLb i L357943579r L L3697 0000080004

v
g5
X9Ware LLC B
5 R
=] m ;
§ = T3 :
2z 3 850 =
2—.56%5"’3&
‘3’“@'36858 g
Eg";g:ﬁ'ﬁ‘g- e
= N T
g% 8 8Rg 5
| - =]
g =3
=1
071 aJemieX

Close

7. Once a match is found, click the checkbox at the left of the row to activate that row for matching.
Click the radio button of the paid no issue item that matched the outstanding issue item. Single or
multiple rows can be activated and selected for matching.

Select
[all | none] Serial Number Payment Date Paid Amount Issue Amount Issue Date Issue Type Payee Name
113697 $180.00 04/22/2022 ISSUED FedEx
04/21/2022 $180.00 @
04/21/2022 $ 180.00 ®
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8. Once selections are made, click the Match Selected button at the bottom of the Paid No Issue Match
screen to complete the match.

113686 04/21/2022 $270.00 @ $260.,00 04/22/2022  ISSUED Office Pride

O 113685 $600.00 04/22/2022 ISSUED Jonathan Copeland Michael Copeland
04/21/2022 $600.00 @
04/21/2022 $600.00 @

I Match Selected }

9. The Confirm Matching screen displays. Select Confirm to match any selected Issuance and
Transaction items. Click the Cancel button to cancel without matching.

Confirm Matching

Match 2 selected Issuance and Transaction items

Click Cancel to return or Confirm to continue

10. Once Confirm is clicked, the system displays a success message.

2 transactions submitted to be matched to issuance
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11. The paid transaction now shows the matched issue item data in Transaction History.

Transaction ID Account Number

54164 XXXX3579

Positive Pay Type: payee

Issuance Payee Name: Office Pride
Issuance Serial Number: 113686
Issuance Amount: $260.00

Issuance Date: 04/22/2022

Original Serial Number: 113686

Original Amount: $270.00

z
Serial Number  Credit Debit Current Status Dateli Change Status
1 $270.00 Pay-System 04/21/2022 P

Payment Date: 04/21/2022

Loaded Exception Reason: Issuance Not Found

Exception

o

Disposition Created: 04/21/2022 6:00 PM EDT

12. Viewing the check data in the Item Lookup interface shows the complete audit history of the

transaction.

Item Lookup

Account’

Account Number: xxxx3579

Transaction Date: 04/21/2022
Payment Date: 04/21/2022
Transaction ID: 54164

Debit Amount: $270.00

Current Status: Pay-System

Issuance Date: 04/22/2022

Serial Number

Serial Mumber: 113686

Original Serial Number: 113686
Original Amount: $270.00
Issuance Payee Name: Office Pride
Issuance Serial Number: 113686
Issuance Amount: $260.00

Issuance Status: ISSUED

Update By: sdelaerel

Updated Date/Time: 04/22/2022 12:13 PM EDT Transaction Id: 54164

Load Date/Time: 04/22/2022 12:13 PM EDT Issue Type: ISSUED

View Check Image

Exception Reason: Issuance Not Found
Payee Match Score: No payee match needed

Disposition Created: 04/21/2022 &:00 PM EDT

Payee Name: Office Pride
Match Status: PAID

Amount: $260.00
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VIIi. DECISION DUAL APPROVAL

Check Positive Pay (PRO-CHEX) can support dual approval for client decisioning. If enabled by the FI and
configured for a client, any transactions in a Return status that are decisioned by the client will be held in

“Suspended” status until approved or rejected by a secondary user.

NOTE:

e Client Decision Dual Approval permission must be enabled by the Fl.
e The Decision Dual Approval user privilege must be enabled.

If Decision Dual Approval is enabled and a Client User decisioned any transaction in the Transaction History to
the status of User-Pay, or adjusted the serial number or amount of any transaction, approval is requested to
approve the change of the transaction status. The secondary client user must approve the transaction decision.

1. Within the Check Positive Pay (PRO-CHEX) module, click Perform > Transaction Approval.

[}
Y
4

Check Positive Pay  #Manage ~ | # Perform ~  JiReports ~

Issue File Load

Manual Issue Entry

Welcome -[ Transaction Approval |

Active Reconciliation

Please use the above menu to sel¢
Paid No Issue Match
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2. The Check Transaction Approval screen displays.

Check Transaction Approval

Select
[all |

Account
none ]

Number Number
? O WX 4680 9132
? [ XO4680 9104
> O ¥xXxx4680 e

Current Serial

Requested Serial Current Requested Current Reques::ed
Number Amount Amount Date Status Statusli Exception
$55.00 03/04/2024 Return- Pay Q
User
$90.00 $190.00 03/04/2024 Pay-System  Pay
$933.00 03/04/2024 Return- Pay

User

Select [all | none]

Account Number

Current Serial Number

Requested Serial
Number

Current Amount

Requested Amount

Date
Current Status
Requested Status

Exception

The client user can select individual transactions by clicking the checkbox
at the left of each row. The client can also select all transactions by clicking
“all” in the Select column. The client can de-select all transactions by
clicking “none”.

Displays the masked account number for the item.
The current serial number of the item. The client user can click the

hyperlink in the serial number to view the check image. An eye icon
denotes an item that has no serial number.

The updated serial number, if changed by the client user performing the
decisioning.

Original amount of the transaction.

The updated amount, if changed by the client user performing the
decisioning.

Date of the transaction.
Current Status of the transaction.
The status of the transaction, if approved.

If the transaction is an exception, an exception identifier appears in this
column.
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3. Clicking the arrow (>) at the far left of each row expands the view for more information about the

Transaction ID: 1276057
Requested By: sdelaerel

Loaded Exception Reason: Issuance Not Found

User

transaction.
Select
rE;:el] Account Current Serial Requested Serial Current Requested Current Requeszted
Number Number Number Amount Amount Date Status Statusli Exception
v O XX¥xX4680 9132 $55.00 03/04/2024 Return- Pay Q

Transaction ID
Requested By

Loaded Exception

Reason

transactions are loaded.

The exception identified when the transaction was loaded.

Unique ID assigned by Check Positive Pay (PRO-CHEX) when

The client user who requesting the change of transaction status.

4. After examining the transactions pending approval, the client user can select items to approve or
reject by clicking the Approve or Deny buttons at the bottom of the screen.

5. If a transaction is Approved, a Confirm Approval pop-up window appears. The user can click the
Confirm button to confirm the approval of the transaction status change, or click the Cancel button to

return to the Check Transaction Approval Screen.

Confirm Approval

Approve status change of 1 check

Click Cancel to return or Confirm to continue
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6. If atransaction is Rejected, a Confirm Rejection pop-up window will appear. The user can click the
Confirm button to confirm the rejection of the transaction status change, or click the Cancel button to
return to the Check Transaction Approval Screen.

Confirm Rejection

Reject status change of 1 check

Click Cancel to return or Confirm to continue

7. Updating Transactions in Pending-Pay Status:

In the case of No Issue transactions that are in Pending-Pay status awaiting approval or rejection,
the user may do the following:

a. Add Issue: A transaction currently in Pending-Pay status can be updated in the Transaction
History page by expanding the view on the transaction and clicking the Add Issue button.

Before changes, the transaction appears without payee information as shown below.

Select
rE;:el] Account Current Serial Requested Serial Current Requested Current Requeszted
Number Number Number Amount Amount Date Status Statusli Exception
O HOAGE0 9132 £55.00 03/04/2024 Return- Pay Q
User
Transaction ID: 1276057
Requested By: sdelaerel
Loaded Exception Reason: Issuance Mot Found
i In Transaction History, click the Add Issue button.
1276057 Xxxx4680 9132

$55.00 Pending-Pay 03/04/2024 Q
Account Name: Evens Return Date: 03/04/2024 5:30 PM EST e Notes (0)

Positive Pay Type: payee Return Reason: Duplicate Presentment
Original Serial Number: 9132 Loaded Exception Reason: Issuance Not Found

Original Amount: $55.00
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ii. Complete the Add Issue pop-up screen by entering a Payee Name and clicking the Save

button.
Add Issue Item:
Serial Number Amount Payee Name’® Status Issuance Date
9132 55 Henry Fordham ISSUED =] 03/04/2024

e

* Account Configured for Recon: To select a date other than today. 'X' out and add issuance after the Pay request is approved

Save
iii.  The changes are then reflected in the Transaction Approval screen, as shown below.
Select
(all | Account Current Serial Requested Serial Current Requested Current REC{UE‘StE‘d
none] Number Number Number Amount Amount Date Status Statusli Exception
v ] Xxxx4680 9132 $55.00 03/04/2024 Return- Pay Q
User
Transaction ID: 1276057 Issuance Requested
Requested By: sdelaere1 Requested Issuance Amount: $55.00
Loaded Exception Reason: Issuance Not Found Requested Issuance Date: 03/04/2024
Requested Issuance Status: ISSUED
Requested Issuance Payee Name: ISSUED
b. Items currently in Pending-Pay status will not allow the user to adjust the serial number or
amount.
NOTE:

If a transaction decision is currently awaiting approval from a secondary client user and the
transaction is not approved or rejected by EOD, the transaction will revert to its original status. For
instance, if a transaction is set to default return and a client user decisions the item to be paid, if that
decision is not approved by EOD, the item will revert to the default return status.
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IX. REPORTS

NOTE:

Reports are available for one (1) year.

A. Adjusted Items Report

NOTE:

The Adjusted Items Report user privilege must be enabled.

1. The Adjusted Items report allows the client user to view all transactions adjusted by the FI or client

within the Check Positive Pay (PRO-CHEX) system.

2. From the Check Positive Pay (PRO-CHEX) module, click Reports > Adjusted ltems.

Check Positive Pay ~ ®#Manage ~ ¢ Perform ~

sliReports -

Adjusted Items |

Welcome

Please use the above menu to select an action

Issue Item Status
Reconciliation

Scheduled
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3. The Adjusted ltems page appears.

Adjusted Items

Y Filters
Account RIT
Number Number
W00exdB80 322172441
W00exdB80 322172441
W00exdB80 322172441
W00exdB80 322172441

Original Serial
Number

7518

7506

7504

7501

Serial Number

Change

7518

7506

7504

7501

4 transactions totaling $7,693.00

Rows 1-4of4,
Encoded Amount
Amount Changed To
$3,000.00 $30.00
$8,130.00 $6,130.00
$999.00 $933.00
$650.00 $600.00

Amount of Adjustment
Needed

$2,970.00

$2,000.00

$66.00

$50.00

Dateli By

07-27-

2023

07-27-

2023

07-27-

2023

07-27-

2023

Date Range
£ |ul 27,2023~

>

Adjustment Made

FI

FI

FI

FI

4. The Date Range field defaults to showing one day of transactions. To filter a longer date range of

transactions shown, click on the Date Range drop-down.

Adjusted Items

Y Filters
Account RIT
Number Number
W00exdB80 322172441
W00exdB80 322172441
W00exdB80 322172441

Original Serial
Number
7518

7506

7504

Serial Number
Change
7518

7506

7504

Start Date’
07/27/2023
4 transactio
o July 2023
RO sy Mo Tu We Th Fr
Encode 25 26 27 28 29 30
Amour
2 3 4 5 6 7
$3,000 9 10 11 12 13 14
16 17 18 19 20 21
58130 23 24 25 zsa 28
30 31
$9G0.00 e

End Date”
07/27/2023

August 2023
58 5u Mo Tu We Th

15 13 14 15 18 17
22 20 021 22 23 24
23 27 28 29 30 3

Fr

1
18

25

Date Range
£ |ul 27,2023 «

Tomorrow
Yesterday

Last 7 Days
This Month
Last Month

Custom
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5. To narrow search results, click Filters and a window containing additional search criteria appears.

Date Range
Adjusted Items & Jul 27, 2023 -
Y Filters v
Account? Amount Adjustment Made By
k2 Any v
Serial Number
Apply
Account Type an account name or the last 4 digits of the account number.
Amount Enter a specific amount for the transaction.

Serial Number

Adjustment Made
By

Amount Range Click the hyperlink above the Amount field to enter an amount

range or a maximum or minimum amount of transaction.

Min Amount Minimum dollar amount of transaction.

Max Amount Maximum dollar amount of transaction.

Type the item serial number for a specific issued item.

Serial Number
Range

Min Serial #
Max Serial #

Click the hyperlink above the Serial Number field to enter a
serial number range or a maximum or minimum serial number.

Minimum serial number

Maximum serial number

Select a user from the drop-down menu to filter to display only changes made by that
user. Users can include Fl or client users.

6. Once search criteria are selected, click Apply to narrow your search results.
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7. Adjusted Items transactions are displayed in pages of 25 items. If the report contains more than 25
transactions, the results are displayed on multiple pages. Use the navigation buttons at the top of the
report results to review all results.
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Rows 1 - 25 of 35.

Account R/T Original Serial Serial Number Encoded Amount Amount of Adjustment Adjustment Made
Number Number Number Change Amount Changed To Needed Datel: By
Account Number Displays the Account Number for the adjusted item.

R/T Number Displays the routing number associated with the adjusted item.

Original Serial Number Displays the item’s original serial number.

Serial Number Change Displays the serial number after the item was adjusted.

Encoded Amount Displays the original encoded amount of the item.

Amount Changed To Displays the amount of the transaction after the item was adjusted.
Amount of Adjustment Displays the total dollar amount difference between the encoded amount
Needed and the adjusted amount.

Date Displays the date the item was adjusted.

Adjustments Made By Displays the name of the user who adjusted the item.

8. The entire Adjusted Items Report can be downloaded as a CSV file (Comma Separated
Value). Click on the Download as CSV button at the bottom left of the Adjusted Items Report
screen.
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B. Issue Item Status Report

NOTE:

The Issue Item Status Report user privilege must be enabled.

1. Within the Check Positive Pay (PRO-CHEX) Module, click Reports > Issue ltem Status.

Check Positive Pay  #Manage ~  # Perform ~ = JiReports ~ = View ~

Adjusted Items

mmmp| Issue Item Status |
Welcome Reconciliation

Scheduled

Please use the above menu to select an action
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2. The Issue ltem Status Report page appears. The page defaults to Outstanding items but can be

changed to Paid items or Returned items.

Issue Item Status

Issue Item Status

Issuance Status Start Date End Date
= B  04/07/2023
® Qutstanding
O Paid [ Summary Information Only Account?

O Returned
- ,&_r}.’ o
O Stops

O Voids

Issuance Status Outstanding Any items that have not been matched and decisioned yet.
Paid Any items that have been matched and paid.
Returned Any items that have been matched and returned.
Stops Any items that have a stopped status
Voids Any items that have a voided status.

Start Date The start date is only applicable when filtering by Paid or Returned Issuance
Status.

End Date The end date will default to the current date.

Summary Information Will show summary, rather than detailed, information on the displayed data.

Only

Account To further narrow down the results the report can be filtered by a specific

account.

Once search criteria are selected, click Apply to narrow your search results.

Search results are displayed in pages of 25 items. If the search contains more than 25 transactions,
the results are displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.

- i

e .
30 transactions totaling $566,41

e em.
]

fows 1 - 25 of 30,
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5. The Issue Item Status report will populate below the search window based on filters selected.

a. Filtering for Outstanding Issuance Status:

Account Number Serial Number Payee Name Amount Issuance Date
w00 1111 9263 Citizens Union Bank () $6,130.00 05/28/2020
w1111 9262 Advanced Medical, Inc. £24.00 05/28/2020
w1111 9261 Richard Canova $53.36 05/28/2020
w1111 9259 Waller Lansden Dortch & Davis, LLP £933.00 05/28/2020
w1111 9258 Richard Canova £1.00 05/28/2020
o111 9257 Office Pride £260.00 05/28/2020
o111 9256 Jonathan Copeland 600,00  05/28/2020
o111 9255 Cisco Webex, LLC $65.55 05/28/2020

Account Number Displays the masked account number.

Serial Number Displays the serial number for the item.

Payee Name Displays the payee name, if applicable.

Amount Displays the amount of the issuance item.

Issuance Date Displays the date of the issuance item.
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b. Filtering for Paid Issuance Status:

Account Number Serial Number Payee Name Issuance Amount Issuance Date Transaction Amount Payment Date
*¥xxx1010 4113 ABC Carpentry $750.00 06/23/2022 $750.00 06/23/2022
¥Xxx1010 4112 Jake Chambers $150.00 06/23/2022 £150.00 06/23/2022
¥Xxx1010 4110 Michael Farrell $2,800.00 06/23/2022 $2,800.00 06/23/2022
¥XxX1010 4109 Cuyahoga County Clerk $193.93 06/23/2022 £$193.93 06/23/2022
¥XxX1010 4108 Covey Seminars $53.36 06/23/2022 $153.36 06/23/2022
¥XxX1010 4107 Citizens Union Bank $6,130.00 06/23/2022 $8,130.00 06/23/2022

Account Number Displays the masked account number.

Serial Number Displays the serial number for the item.

Payee Name Displays the payee name, if applicable.

Issuance Amount Displays the amount of the issuance item.

Issuance Date Displays the date of the issuance item.

Transaction Amount Displays the amount of the presented item.

Payment Date Displays the payment date of the item.
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c. Filtering for Returned Issuance Status:

Account Number Serial Number
xox1010 4114
XXXK1010 4111
WK1 113783
w1111 113782

Payee Name Issuance Amount Issuance Date
FedEx $180.00 06/23/2022
Nesta Archeron $150.00 06/23/2022

Elain Archeron

ABC 123 $700.00 06/06/2022

Jake Jones $150.00 06/06/2022

Transaction Amount

$180.00

$180.00

$800.00

$260.10

Return Date

06/23/2022

06/23/2022

06/23/2022

06/23/2022

Account Number
Serial Number
Payee Name
Issuance Amount
Issuance Date
Transaction Amount

Return Date

Displays the masked account number.
Displays the serial number for the item.
Displays the payee name, if applicable.
Displays the amount of the issuance item.
Displays the date of the issuance item.
Displays the amount of the presented item.

Displays the return date of the item.
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d. Filtering for Stops:

Account Number Serial Number Payee Name Issuance Amount Issuance Date
¥Xx¥3333 306 $306.00 06/16/2022
¥Xx¥3333 304 $304.00 06/16/2022
¥Xx¥3333 303 $303.00 06/16/2022
¥Xx¥3333 302 $302.00 06/16/2022
¥Xx¥3333 301 $301.00 06/16/2022

Account Number Displays the masked account number.

Serial Number Displays the serial number for the item.

Payee Name Displays the payee name, if applicable.

Issuance Amount Displays the amount of the issuance item.

Issuance Date Displays the date of the issuance item.

e. Filtering for Voids:

Account Number Serial Number Payee Name Issuance Amount Issuance Date
XxXxx9999 501 $501.00 06/10/2022
XX¥x6666 259 Gwen Lively $60,000.00 06/16/2022
XXXX6666 258 Gwen Simpson $19,393.00 06/16/2022
XXXX6666 257 James Brown $280,000.00 06/16/2022
XUHXBEEE 287 Jennifer Lopez $225.00 06/09/2022

Account Number Displays the masked account number.

Serial Number Displays the serial number for the item.

Payee Name Displays the payee name, if applicable.

Issuance Amount Displays the amount of the issuance item.

Issuance Date Displays the date of the issuance item.
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6. If the Summary Information Only checkbox was selected, the Issue Item Status report populates with
summary information as shown in the graphic below.

Account Number Account Name Check Status Total Items Total Dollar Amount

w1111 WEP Main Qurtstanding Issued Items 281 $267,978.96
Wo22322 WEP Payrall Qurtstanding Issued Items 17 $9,311.53
Wi 3333 WP Expense Qurstanding Issued Items 3 3146475

Grand Total: 5278,755.64

Account Number Displays the masked account number.

Account Name Displays the name of the account.

Check Status Displays the status of the issued items.

Total Items Displays the total amount of items with a particular check status for a
specific account.

Total Dollar Amount Displays the total dollar amount of all items in the row.

Grand Total DkiJspIays the grand total dollar amount of all items displayed in the rows
above.

7. The entire Issue Item Status Report can be downloaded as a CSV file (Comma Separated Value).
Click on the Download as CSV button at the bottom left of the Issue Item Status Report screen.
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C. Scheduled Reports

The Scheduled Reports is an Enterprise level feature in Check Positive Pay (PRO-CHEX) designed to
provide information related to outstanding issue items and paid items on a frequency. Scheduled reports
can be configured to be delivered to the financial institution for forward delivery to the Client and/or they
can be obtained through the Client portal. For more information on the standard report templates, please

see the Appendix E for details.

Date Range

Scheduled Reports

EMay 1, 2020 - May 31, 2020~

Y Filters >
Rows 1-250f 4
Report Name Report Status Request Type Download Report
*  CL 3 o011 _test-issuance_30235_2020-05-28.csv GEMERATED SYSTEM Download
¥ CL3 002222 test-issuance_3022_2020-05-28.csv EMPTY SYSTEM
¥ CL 3 0o 1111 _test-transaction_3021_2020-05-28.csv GEMERATED SYSTEM Download
¥ CL3 002222 test-transaction_3020_2020-05-28.csv EMPTY SYSTEM
*  CL 3 oo 1111 _test-isswance_2960_2020-05-27.csv DOWMNLOADED SYSTEM Download
¥ CL3 002222 test-issuance_2955_2020-03-27.csv EMPTY SYSTEM
*  CL 3 o011 _test-isswance_2899_2020-05-26.c5v GEMERATED SYSTEM Download

Based on the report templates configured for each account, a client user can also choose to generate
interim reports. Interim reports provide the information between the last frequency the report was
generated through the current date the interim report is being generated.
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1. To schedule a new report, click the Generate Interim Reports button.

Scheduled Reports

Y Filters

Report Name

» ASBC1_000td680_StdofmtDn012_78502_2024-02-28.txt
»  ASBCT_0omd680_StdofmtoD00S_78495_2024-02-27.xt
¥ ASBC1_0od680_Stdofmt0D002_784904 2024-02-27.txt
¥ ASBCT_xx4680_Stdofmt0D010_78493_2024-02-27.txt

ASBCT ood680_ChoctawFormat1_78492_2024-02-27.txt
ASBCT ooxd580_test-transaction_78472_2024-02-27.csv
ASBC1 04680 _test-separators_7B467_2024-02-27.txt
ASBCT ooxd580_test-transaction_78427_2024-02-27.csv
ASBCT _ooxd6B80_test-issuance_78412_2024-02-27.c5v

ASBC1 oxd680_fnbo-transaction_78400_2024-02-27 csv

WooW W g g

ASBCT 0o0d6B0_BAI_TB3T1_2024-02-27.1xt

Rows 51 - 62 of 62,

Report Status

DOWNLOADED
DOWMNLOADED
DOWNLOADED
DOWNLOADED

EMPTY
EMPTY
EMPTY
EMPTY
EMPTY
EMPTY
FAILED

EMPTY

Request Type

USER_REQUEST

USER_REQUEST

USER_REQUEST

USER_REQUEST

USER_REQUEST
SYSTEM
SYSTEM
SYSTEM
SYSTEM
SYSTEM
SYSTEM

SYSTEM

Date Range
& Feb 27, 2024 - Mar 04, 2024 -

>

Download Report

Download

Download

Download

Download

- Generate Interim Reports
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2. The Interim Reports window appears.

Interim Reports

Account’ Template’ Start Date

Any b - Select One - b B | 03/03/2024

O] Generate Another

End Date

B | 03/03/2024

3. Select the appropriate account from the Account drop-down menu.

Interim Reports

Account? Template? Start Date
‘ Any A | - Select One - v L= 03/03/2024
Any

ALERT-929-1 - xxxx6778
ALERT-929-6 - xxxx 4687
AP Test Acct - oo 7503
Alert-1016 - xx0x1610
Cina Terre - x¥¥¥5555

Generate Report

U Generate Another

End Date

B | 03/03/2024

4. Select the desired template from the Template drop-down menu. Template options are limited to
scheduled report templates configured on the selected account and will vary based on what type of

reports the client and the FI have agreed upon.

Interim Reports

Account? Template? Start Date
Evens - xood o680 w | - Select One - - | = 03/03/2024
- Select One -

reverse csv

Stdofmt 00012
Stdofmt 00021
global issuance rate Another
Stdofmt 00020

End Date

B | 03/03/2024

© 2024 Alkami Technology, Inc.
Proprietary and Confidential Information

Version 2.2.0
Updated 04/30/2024
Page 153 of 199




5. Select desired start and end dates for interim reports. Once all fields have been selected, click the
Generate Report button. If the user is generating multiple reports, the user can click the Generate
Another checkbox before clicking the Generate Reports button.

Interim Reports

Account’ Template’ Start Date End Date

B | 03/03/2024

Evens - x0od680 W Stdofmt 00020 W = 03/01/2024 =

g o
- Generate Another

6. If the user is generating more reports, a success message appears at the bottom of the Interim
Reports pop-up window, and the window stays open to add information for another Interim Report.
Once the information for the last Interim Report has been entered, unselect the Generate Another

checkbox and click Generate Reports to continue.

Interim Reports

Account? Template? Start Date End Date

Evens - xox4680 b Stdofmt 00020 o B 03/01/2024 B 03/03/2024

Generate Report

Generate Another

Report Queued for generation successfully
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7. The Interim Reports pop-up screen automatically closes, and the Scheduled Reports screen
displays. The Interim Reports requested by the user appear on the Scheduled Reports list.

Date Range
Scheduled Reports S Feb 27, 2024 - Mar 04, 2024 -
Y Filters >
Rows 1- 25 of 63.
Report Name Report Status Request Type Download Report
»  ASBCI oowxd680_Stdofmt00020_73068_2024-03-04.txt GEMNERATED USER_REQUEST Tl
NOTE:

Scheduled reports are generated within the configured report period, even when an account has no
activity for the report period. In these cases, the system will produce a blank report.
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NOTE:

The Reconcile Accounts user privilege must be enabled.
The View Reconciliation Reports user privilege must be enabled.

Check Positive Pay (PRO-CHEX) provides the Active Reconcilement function, an Enterprise feature,
designed for a user to compare the actions taken in PRO-CHEX against a company’s internal
accounting system and bank account/statement. Reconciling accounts is a standard and good business
practice. It is required to ensure company accounting records and bank account activity align and which
issued checks have been paid and which remain outstanding. Since PRO-CHEX is the system of record
for housing issued items, performing exception identification, and accepting pay/return decisions from
the company, PRO-CHEX records should align with the company’s internal accounting records and the
account activity shown in online banking or bank statements.

For more information about the Active Reconciliation feature and the functions available to client
users (if enabled), please refer to the Active Reconciliation Client User Guide.

The client user can access Reconciliation reports or view past and present Reconciliation Period activity.

1. Reconciliation Reports

a. Within the Check Positive Pay (PRO-CHEX) Module, click Reports > Reconciliation.

Check Positive Pay  # Manage ~  # Perform ~ i Reports ~

i

Adjusted Items

Issue Item Status

We | CO me -[ Reconciliation ]

Scheduled

Please use the above menu to select an action
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b. The Reconciliation Reports page displays.

Date Range
Reconciliation Reports B Jul 21,2023 -Jul 27, 2023 -
Y Filters >
Rows 1-6ofé6.
Report Name Report Status Request Type Download Report
»  ASBCI _0om6789_recon_61275_2023-07-24.csv GEMERATED SYSTEM Download
¥ ASBC1_xo0xx6789_fnbo-recon_61274_2023-07-24.csv GEMERATED SYSTEM Download
> ASBCI _0om6789_test-recon_61273_2023-07-24.csv GEMERATED SYSTEM Download
c. To filter the date range of the reports shown, click on the Date Range drop-down.
Date Range

Reconciliation Reports

Y Filters

Start Date’

07/27/2023

Rov
Report Name

No Reconcil 23

Report Status Su Mo

26

4

3

July 2023
Tu We Th Fr

27

28 2% 30

5 &6 7

22

25

End Date”

07/27/2023

Su

20

7

Mo

21

28

August 2023

Tu We Th

1

8

15

22

29

23

30

3

10

17

24

31

Fr

4

1

18

25

1

B Jul 27,2023 -
Tomorrow
Yesterday
Last 7 Days
This Month
Last Month

Custom
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d. To narrow the search results, click Filters and a window containing additional search criteria
appears. The Reconciliation Reports list can be filtered by Account by entering the first few
characters of the account number or account name to activate the SmartSearch filter.

Date Range
Reconciliation Reports & Jul 27, 2023 -
Y Filters v

Account? Report Status
testr Any hd

Select Account

Apply

TestRecon - xxxx3579

Rows 1-250f0.

e. The results can be further filtered by selecting a Report Status from the Report Status drop-down

menu.
Date Range
Reconciliation Reports & Jul 27, 2023 -
Y Filters v
Account? Report Status
Any b
clear Downloaded
Empty
Failed
Generated
Report Status Generated This means that the report was created successfully and
that it contains data based on the chosen report template.
Downloaded Downloaded means that the report has been downloaded by
a user.
Failed Failed means that the report did not generate properly.
Empty Empty means that the report ran, but there was no data to

pull into the report for the given time period.

f.  Once search criteria are selected, click Apply to narrow your search results.

g. Reconciliation Report items are displayed in pages of 25 items. If the report contains more than
25 items, the results are displayed on multiple pages. Use the navigation buttons at the top of the
report results to view all results.
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Report Name Report Status Request Type Download Report
¥ ACME_xmxx4321_test-recon_3605_2020-07-21.csv GEMERATED SYSTEM Download
> ACME_xxx4321_test-recon_5514_2020-07-20.csv GEMERATED SYSTEM Download
¥ ACME »ooxd321_test-recon_3436_2020-07-17.csv GEMERATED SYSTEM Download
Report Name The name of the report file.
Report Status Refer to paragraph d. within this section for Report Status definitions.
Request Type The Request Type indicates whether the report was automatically generated by

the system as part of the schedule setup for the report to run on.

Download Report Click to download a copy of the Report in the designated format.

Button

h. Click the arrow (>) button next to the Report name to view more detail on each Reconciliation
Report. The information shown in this drop-down is an audit history of all the activity that has
occurred on the Reconciliation Report.

Reconciliation Reports

Y Filters

Report Name

Generated Date: Tue, 21 Jul 2020 09:13:50

Downloaded Date: Tue, 27 Jul 2020 15:52:03

Report Status Request Type

¥ ACME_oom4321_test-recon_3605_2020-07-21.csv DOWNLOADED SYSTEM

Requested Date: Tue, 21 Jul 2020 09:13:50

Download Report

Download

Requested By: FFHOQ_AFPP

Date Range
Ejuly 1, 2020 - July 31, 2020~

>

Generated Date
Downloaded Date
Requested Date

Requested By

Date the report was generated.
Date the report was downloaded.

Date and Time report was requested.

User or system who requested the report.
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2.

Viewing Reconciliation Periods:

o

Within the Check Positive Pay (PRO-CHEX) Module, click View > Reconciliation Periods.

Check Positive Pay

# Manage ~  # Perform ~ i Reports ~

Welcome

Please use the above menu to select an action

=

View ~

Issue File Status
Issue Warehouse
Transaction History

Item Lookup

Reconciliation Periods ]

b. The Reconciliation Report Account Page displays a list of the accounts that have been
provisioned with Account Reconciliation. The user can search by account number or name if a
long list of accounts is displayed. Click the Select button on the appropriate account to proceed.

Account #

XXXX6789

XIOXETT8

Select Reconciliation Account

Total Reconciliation Accounts: 29

Name

Recon23.1

ALERT-929-1

‘ Select

Select

13

From the Reconciliation Report page for the specific account, the user can select to view any

closed or active reconciliation period displayed in the list. Click Change Account to return to the
list of Accounts or click the Select button to choose a reconciliation period.

< Change Account
Select Reconciliation Period for Account Recon23.1

Start Date End Date Previous Outstanding Status

03/21/2023 02/26/2024 $0.00 Active Select
03/18/2023 03/20/2023 $0.00 Closed select
03/17/2023 03/17/2023 $0.00 Closed ‘ select
03/16/2023 03/16/2023 $0.00 Closed Select
03/15/2023 03/15/2023 $0.00 Closed Select
03/14/2023 03/14/2023 $0.00 Closed select
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d. The Reconciliation statement for the chosen period displays. An example of the screen view is
provided below. Depending on the type of reconciliation the account is set for, the user may see
tabs at the top of the screen to view Check reconciliation, Deposit reconciliation and/or
Statement reconciliation.

For more information about the Active Reconciliation function, please refer to the Active
Reconciliation Client User Guide.

Check Summary

Start Date

Serial Number
5032
5033
5024
5035
5036
5037

5038

Issued Date

Reconciliation for WKP Main

End Date

05/25/2020

Outstanding Start Balance

$118,777.50

Outstanding Activity Total

+%89,709.36

Outstanding End Balance

$208,486.86

Issue Amount
________

JJJJJ

JJJJJJJ

________

New Issues

Paid Mo Issues

Paid Stop/Void

Paid Checks

Stop Payments

Voided

Cancelled

Purged Qurstanding

Previous Paid Mo Issues Received
Amount Mismatch Adjustment

Period Activity Total

Status Status Date
CUTSTANDING
OUTSTANDING
WOIDED 09/25/2020
CUTSTANDING
OUTSTANDING
CUTSTANDING

OUTSTANDING

Paid Amount

,,,,,

uuuuu
______
uuuuu
______
vvvvvv

uuuuu

+ $89,709.36
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X. PAYEE POSITIVE PAY TIPS & BEST PRACTICES

For client users to have the best user experience possible, we have outlined some best practices to help make
the onboarding process more efficient.

- - -z -

Check Positive Pay (PRO-CHEX) payee name scoring can handle a variety of check styles, fonts, and
even hand-written names on a payee line. However, scoring does not indicate with 100% certainty
whether the payee name on a check matches the payee name provided with the issue item.

The technology scores on the likelihood of a match and fails or passes an item based on the scoring
threshold set. The system supports a range of 0-1000. The lower the threshold is set, the more likely
fraudulent items will pass. The higher the threshold is set, the less likely they are to pass, but the
flipside is items where there is an exact match could trigger unnecessary exceptions.

Check Positive Pay (PRO-CHEX) default threshold is set at 800. This is a system default each financial
institution can have raised or lowered based on their risk tolerance. In addition to establishing a global
scoring threshold, Fls can customize the default on an account-by-account basis.

Each institution should consider incorporating language into their client agreements to explain that
payee comparison is a scoring methodology that can be impacted by a variety of factors and therefore,
as their financial institution, you make no representations or warranties that the technology is going to
score items correctly each time.

While Check Positive Pay (PRO-CHEX) does allow Fl users to pre-scrub exceptions and override false
exceptions after visually inspecting the check, Fls can help their clients reduce the number of false
exceptions by recommending they use the best possible check design and formats as outlined in the
best practices below.
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Customers will find the most success following these suggestions in their check designs and format.

Paper weight should be 24” MICRBond (to ensure better image quality when physically captured
with reader).

Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in
the payee field. Any background patterns, images or watermarks on the check stock that are
within the area of the data to be recognized can interfere with recognition results. [Please refer
to Figures 1.1 and 1.2 at the end of this subsection for good and bad examples]

Check stock should be consistent for each account.
Minimum 200 dpi resolution is required; 200 to 300 dpi is the recommended range.
Printing with an ink jet or laser printer produces best results.

Handwritten Items: Payee positive pay’s effectiveness may be reduced with handwritten checks
due to observed variations in handwritten numbers and letters.

Check printing should be consistent with the payee information in the same location per account.

Checks should be fixed width (fixed spacing) 10-point font or higher for the Payee Block and
Amount. Font size 12 or 14 will produce best results. [Please refer to Figures 1.3 and 1.4 at the
end of this subsection for good and bad examples]

Sans Serif fonts are preferred (no bold). For example, Courier New, Courier, Lucida Console,
Terminal, Letter Gothic are all acceptable fonts. Courier New is preferable. [Please refer to
Figures 1.3 and 1.4 at the end of this subsection for good and bad examples]

“PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally
at the same level to the left of the payee name. Payee Name should be printed to the right of
“PAY TO THE ORDER OF” starting from the position of the keyboard “PAY” or lower. [Please
refer to Figures 1.5 and 1.6 at the end of this subsection for good and bad examples]

Payee name should be a maximum of 100 characters, left aligned and single line spacing should
be used. [Please refer to Figures 1.7 and 1.8 at the end of this subsection for good and bad
examples]

Up to four payee names are permitted. [For more information about multiple payee handling,
please refer to Subsection D, Multiple Payee Handling, within this section]
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The payee name and amount should be surrounded by an area of white space with a minimum
of 2 empty lines. This minimizes the interference of any irrelevant printed information on the item
and allows for some shifting/offset of the data’s location during the scanning process. [Please
refer to Figures 1.7 and 1.8 at the end of this subsection for good and bad examples]

Payee name should not be italicized, bolded or underlined and words should be separated by
one (1) single blank space. [Please refer to Figures 1.7 and 1.8 at the end of this subsection
for good and bad examples]

Payee Name should be printed only once on the check, within the Payee Block. Do not split the
Payee Block into two non-adjacent parts (the Name and the Address). [Please refer to Figures
1.7 and 1.8 at the end of this subsection for good and bad examples]

Uppercase characters produce the best results. [Please refer to Figures 1.7 and 1.8 at the end
of this subsection for good and bad examples]
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Figure 1.1

Good Example: A lightly-colored check stock with no logos in the payee field.

: Clicnt XYZ My Bank No. 1012
{ 123 First Strect 123 Bank Raad ST
Louisvilke, KY 40212
(5021231234 Pate 1000 12004
|
[
Oriier Of - NBC Haby Store N =% b S **200.00
Two Hundred - and G0 100 A T I ek SRS |0 s DO S0P PR ) o Dallars
i
[
|
|
| Memo: For purchase order #1234 Pre-approved Check - No Signature Required
i = i
000000 &2 L EdiLEETEAN0LILEE PR
Figure 1.2

Bad Example: A check with a background that is too dark and may cause issues when scanning.

ABC Company 1001
123 Main Street

Cityville, ZA 00000 Date: 03/01/2019

- Damuel Srankfin

*00000M0 &2 K E23L5678980423L 56789
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Figure 1.3

Good Example: Payee Block and Amount use fixed width spacing, 12-14 font size sans serif fonts.

ABC Company
' 123 Main Street 1001
Cityville, ZA 00000
Date: 03/01/2019
Amount:| FIVE THOUSAND THREE HUNDRED AND 29/100 $.5300.29

Pay to the order of: MARK IV SERVICES
505 ROAMN STREET

MAINVILLE, ZA 00000

Memo: Consulting Services @amuel Franklin

*000000 k2 K L23L56789C0L23L 56789

Figure 1.4

Bad Example: Serif font, non-fixed-width spacing, and a 12-14 bolded font font size is used.

e —— =

ABC Company

123 Main Street 1001
Cityville. A 00000

Date; 03012019

Amount: Five Thousand Three Humdred and 29/100 § _5300.2

hr to the Mark IV Servies

s>, [T

Mem: [onsaltung Services ajurnn-ﬂ‘ I.E‘*iunt-:lti.n

R T S A A A R . R W RS WS W 8 AN BTN R

*00000 MO k2 KL 23L56789120L23LSE 789
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Figure 1.5

Good Example: “Pay to the Order Of’ is horizontally printed at the same level as the payee name. The font is
not italicized or underlined.

ABC Company
123 Main Street 1001
Cityville, ZA 00000 i

Date: 03/01/2019 |

Amount: FIVE THOUSAND THREE HUNDRED AND 29/100 $.2300.29 |

Pay to the order of: | MARK IV SERVICES
505 ROAN STREET

MAINVILLE, ZA DDDOO

" = I 2 i
Memo: Consulting Services @amuel ranklin

*00000i0k 2 LL23L,56789001L23L56789

Figure 1.6
Bad Example: “To The Order Of” appears instead of “Pay To The Order Of’ and is not horizontally printed next
to the Payee Block. The font is italicized.

ABC Company 1001

flain Street .
i o )ate: 03/01/2019
Cityville, ZA 00000 Date: 03/01/2019

D amusl Frarklin

*DO0O0OL0 L2 3 23L567890C0L23L5E789"
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Figure 1.7

Good Example: Payee name and amount are surrounded by an area of white space. Payee name is left
aligned and single spaced. Payee name is printed in uppercase letters, and the payee name is not italicized,
bolded or underlined. The payee name is not split into non-adjacent parts and is printed only once on the check.

ABC Company I
123 Main Street 1001 |
Cityville, ZA 00000 |

Date: 03/01/2019 |

Amount: ' FIVE THOUSAND THREE HUNDRED AND 29/100 $ 5300.29

Payto the order of{ MARK IV SERVICES
505 ROAN STREET

MAINVILLE, ZA 00000

- -
. | 1L 3 i
Memo: Consulting Services Damuet & ranlebin

*0000040 L2 KN 123L5678900L23L56789»

Figure 1.8
Bad Example: Payee name is not surrounded by white space. The font is bolded and upper and lowercase

letters are used in the payee block. Payee name is in a separate area than the payee address and is not left
aligned.

ABC Company
123 Main Street 1001
Gifyville, ZA 00000 |
Date: 03/01/2019 |
Amont: Five Thousand Three Hundred and 29/100 S 5300.29
- MHark IV Servies 05 Roan Vireel
e o

Memo: Consilting Serraces ;';i'lr.lmu-c.r l.,l:‘l'" sankbin

#0000040 ke Ki23iL5E789%00423L 56789
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Following are examples of check formats causing processing errors and issues with payee scoring.

Bad Scans & Poor Image Quality

Poor image quality can interfere with scans.

It appears the check paper was inserted into the printer improperly, causing the payee name
information to print in a blurred/slanted condition. This caused issues with scanning. [Payor
name, Payee name, and bank name are partially removed for confidentiality]

e )

P&Y = CHECH MO |

- 3 1 =l SEE i Carg [

Ieven .I:l.--l'l'-‘-l'-.‘l'anlll:l [ T ;‘."_'MIJ'_“"_-_” m MET A0 LT |

=T Hmugpe 7

omenar  AERIEAN |
|30y '!\.ﬂ__r;.'-'_l Lr__r\l_\_\_\_‘—\—\_\_ 1

FOLEVILLE, Pig :ﬂ';-_:-m ASSOIC m|

AUTROACLD forat e |

- DDD .l_l L
¥ f_'l l:":l':l L] 1 Ju d':I i DD El - ﬂ 1

Poor Image Quality. Payee area only states “To the Order of” and is not horizontally printed. The
boxes around date and amount might cause issues with scanning.

/

Check# 2005746
Chack Amount ;
g1, 788,54

eriod 04/26/2020

mmmmemmm e~ US

ed Signature
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Poor image quality. Check fields are in non-serif fonts. Boxes around check fields may cause
issues with interpreting fields on the check. Pay To The Order Of is not horizontally printed.

PAYROLL ACCOUNT
f camem ]
( 06758 3931.0000 10573 06/03/20 $920.24
Crars b Ca 1D [ I bt B Bty b Fap Dura il Py

| Fay TPey A=y

*seessssssse s NINE HUNDRED TWENTY DOLLARS & 34 CENTS*#ssssssesns

J

Acme Commercial Bank

PAY  \IARK LEWIS
To The g47 Ridge Road
Ofodll:rf Frankhin, /£A (OO

- — e - e - - = - -
'y I R s
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D. Custom Payee Boxing

In certain circumstances, an FlI may need to designate payee analysis focus on a specific portion of a
client’s check stock. To assist with this, we have introduced a tool allowing Alkami (formerly ACH Alert)
personnel to draw a custom box for those accounts. For more information about the Custom Payee
Boxing functionality, please contact your Financial Institution.

Non-Negotiable

o - - -- " "-"" "-"—-—"-"-"-"—-"—-""-"-""-"""""""¥"="¥"—"¥"—-""—-"""""—""—"¥"—-"""—"="—"=—="—"=—"=—-= =™
James C. Morrison 1
12345 AnyWhere Circle ** Void ** Void ** Void **  gheck number: | gae7 T 1
Your City, State 12345 o —— e e e e e -

/' Date: :_ 01/28/2024 '

Pay To the Order Of Th‘_%% W $ 300.00
i ents —

PaY This Amount UU Lh U GMU u u Dollars

For __ISN: 46103593 signature S DEJ OOTE

HE - W L T tLEA0 2LEAOrE 267 0000030000

When the custom box is saved, future payee analysis will focus only on that portion of the client’s check
stock, and the payee scoring will be targeted to that area.

This functionality cannot be utilized on an account using multi-line payee handling or custom DPI
settings.
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Check Positive Pay (PRO-CHEX) can support customers with multiple payee names on issued
items. PRO-CHEX can score multiple names on a check against information provided in the

issuance file. Multiple payees can be listed on a single line or on two separate lines on the check.
Examples of correct formatting are shown below.

NOTE:

Multi-Line Payee Handling cannot be utilized on accounts that have a custom payee box enabled.

e ———— |
ABC Company Z
123 Main Street 1001 }

Cityville, ZA 00000

Date: 03/01/2019
Pay to the . E
orderof  Elaine Archeron and Nesta Archeron $5300.29

Five Thousand Three Hundred and 29/100 Dollars

: 3 v - 7 CT ’
Memo: Consulting Services @a”“wl C’a{adHK‘,{Ml

*000000 2™ 1Ki23L5E78910L23L 56789

—_— s ]
ABC Company 1
123 Main Street 1001 ]

Cityville, ZA 00000

: Date: 03/01/2019 |
Paytothe  Elaine Archeron 1

order of Nesta Archeron $5300.29

Five Thousand Three Hundred and 29/100 Dollars

: b c . G0 ).
Memo: Consulting Services @a”l“d é!\{a“’&h“

*00000M0 &2 1XL23L5BE789K0L23LSE 789
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ABC Company i
123 Main Street 1001 |

Cityyille, ZA 00000

Date: 03/01/2019 |

Amount: FIVE THOUSAND THREE HUNDRED AND 29/100 $ 5300.29

MARK I'V SERVICES
ABC COMPANY

205 ROAN STREET
MAINVILLE, ZA 00000

Memo: Consulting Services gjwm,lwf érmifm

Pay to the order of:

*00000 02" 1KL23L5E7890L23ILSE789"
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1. This section is designed to explain how to handle multiple payee names appearing on two separate
lines of the check.

a. Multiple Payee Handling setup in Issue Templates.

i.  The Multi-Line Payee Name Separator field is included in the Issue Template creation
screen allowing for recognition and recording of multiple payees on a check.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer Rows’ Template Level’
0 0 Client v

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if

that character will ever be presentin a
Payee Name. Allowed characters in
brackets[; | .-_/]

ii.  This feature allows the Fl or Client user to enter a character into the field to separate Multiple
Payee Names on separate lines of an issued item. Currently, the system restricts the allowed

characters to the following: ; |, - _/ . Using a separator character appearing elsewhere in
the payee name can cause issues. Examples of scenarios where problems might arise are
listed below.

Within a Comma Separated file (.csv), different data fields are separated by a comma.A
comma cannot be used in the data field itself, or the .csv will read the comma as a separator
before the next field. Therefore, listing two payees for an item in this way: “Elain
Archeron,Nesta Archeron” will cause issues reading the .csv file. In this scenario, the user
should select a multi-line payee name separator character that will not cause an issue, such
as a semicolon. “Elain Archeron;Nesta Archeron” in the Payee Name field of the .csv file will
process correctly.

If the user selects a separator character that would ever appear in a payee name field, such
as a dash (-), the system would then separate the data before and after the character as
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separate payees. For instance, if the user has selected a dash (-) as the Multi-Line Payee
Name Separator, and a common payee used is “In-and-Out Burger”, the system will flag this
as having multiple payees (In, and, Out, Burger). In this case, the user should select a
multi-line payee name separator that will not cause such issues, such as a pipe (|) or a

semicolon for cases of multiple payee names.

b. Multiple Payee Handling in Manual Issue Entry.

i.  When the Client user performs Manual Issue Entry, the Payee Name field supports up to four
Payees. When in the Manual Issue Entry screen, the names should be listed as shown
below. An Enter (carriage return) must be used to input the second, third, or fourth payee on
separate lines in the field for it to be distinguished as different payees. Example of Manual

Issue Entry and corresponding issue item below:

Manual Issue Entry

Account’

Auto populate next check number:

The One and Only - %1111 hd
Row Serial Number Amount Payee Name’ Status Issuance Date
! 12345 5000.00 Nesta Archeron ISSUED A =] 01/18/2022
Elain Archeron
— 4
ABC Company 12345!
123 Main Street E
Cityville, ZA 00000 |

Amount: FIVE THOUSAND AND 00/100

Pay to the order of:  nesta archeron
Elain Archeron

—-

3 1] i i 7 Gl 7 7
Memo: Consulting Services @ amuel C_S sevndzlin

Date: 01/18/2022 |

S 5000.00

*00000 02" 1K 23L5678910L23L56789
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ii. If the multiple payees are listed on a single line of the check, putting the names on separate
lines is not applicable. Example of Manual Issue Entry and corresponding issue item below:

Manual Issue Entry
Account’ Auto populate next check number:
Clear
Row Serial Number Amount Payee Name’ Status Issuance Date
1710 26000 Mate Archeron and Nesta / ISSUED A = 06/30/2020
)
ABC Company |
123 Main Street 1710
Cityyille, ZA 00000 |
Date: 06/30/2020 |
Amount:  TWENTY-SIX THOUSAND AND 00/100 $.26000.00

Pay to the order of: Nate Archeron and Nesta Archeron

- 3 ; 53 v On 7 (0
Memo: Consulting Services @ anvued C.H sand=lin

®*00000a0 &2 1L 23L5E7B89N0L23L 56789

iii. The Payee Name field currently supports 100 characters in total. This character limit

includes the carriage returns separating multiple payees. The 100-character limit is for
the entire field and not per payee.

Manual Issue Entry is covered in depth in the Check Positive Pay (PRO-CHEX) Client
User Guide. Please refer to this document for more general information about Manual
Issue Entry.

c. Multiple Payee Handling when Loading Issue Files.

i.  When the Client user loads issue files to the system, the loaded file is processed with an
Issue Template set up within Check Positive Pay (PRO-CHEX). The Issue Template allows
for selection of a Multi-Line Payee Separator, a character chosen to separate the names of
multiple payees in the issue file.
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ii. If multiple payees are listed on a single line of a check, no action needs to be taken.

iii.  If multiple payees are listed on two or more separate lines on a check, the multiple payee
separator character (which should match the one designated in the template), must be used
between each name. Example of an issue file and corresponding issue item below:

A B C D E F
1 Num Date Mame Account Onginal Amount Status
2
3
4 .'II'I:I-1'III!- 11092 Cisco Webex, LLC 1M $65.55 ISSUED
5 1111” 1109 | Jonathan Copeland | Michasl Copéland 1M $600.00 15SUED
& 113118 11020 Office Pride 1367943579 $260.00 1SSUED
T 11111& 1MW Richard Canova 1357913519 $30.00 ISSUED
8 ""l-‘lN 10 Waller Lansden Dortch & Davis, LLP 1M $932.00 ISSUED
g r'I'lil-‘li"l 10V Advanced Mecdical 13613600 $24.00 ISSUED
10 r'l'lj-'ﬂ'? 1M0WHMM Citizens Union Bank 13619359 $6.130.00 ISSUED
1" lI'.H:]-‘II‘:]- 10V Covey Seminars 138 $53.36 ISSUED
12 r'l'll‘li*'l- 110WHHM Cuyahoga County Clerk 1363619 $191.90 ISSUED
13 112s 102021 Michael Farrell 135793579 $2,800.00 1SSUED
14 l"II'I:I-H'(!- 109201 Nesta Archeron | Elsin Archeron 1357913579 §$150.00 ISSUED
15 r'l'll‘ll‘f 1MW Jake Chambers 13536 $150.00 ISSUED
16 r"J-‘IH 10V ABC Carpentry 13559 $750.00 ISSUED
17 11111‘9 11092 Fedix 1367913519 §180.00 ISSUED
18 r'I'I:I.'I:HJ 110V UPS 15T 35T $90.00 ISSUED
ABC Company
123 Main Street 113117
Cityville, ZA 00000 |
|
Date: 11/09/2021 |
Amount: §|X HUNDRED AND 00/100 $.600.00 1
Payto the orderof: j5athan Copeland
Michael Copeland

Memo: Consulting Services éwmuuf éTmEtjm

®*00000M0 k2™ XL 23L567891X0L23IL5E 789

Loading Issue Files is covered in depth in the Check Positive Pay (PRO-CHEX) Client
User Guide. Please refer to this document for more general information about Loading
Issue Files.
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d. Things to Remember: Multiple Payee Name Separators.

To recap the information covered above, remember:

The Multi-Line Payee Name Separator character designated in the Issue Template must
match what is used in the Issue Files loaded to the system. The system will recognize that
character and when encountered in an Issue File, the system will record the data appearing
after that character as a separate payee.

The allowable characters are: ; |, -_1 .
Some characters may cause problems when used as a separator. Do not use a character as
a separator if that character will ever be present in a Payee Name, or is a character used in a

specific file type (i.e., Comma Separated files).

Payee Name Separators are only necessary when payee names are listed on two or more
separate lines of a check.

Payee analysis is not a perfect technology. The Review Payee functionality in the Client portal has been
introduced to allow users to visually inspect presented items to ensure fraudulent transactions that may
not have triggered any exceptions are identified. For more information on the Payee Review feature,
please refer to the Section VI, Managing Check Presentment.
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Xl. PREFERENCES

A. Preferences

1. From within the Dashboard or Check Positive Pay (PRO-CHEX) Module, click User's Name >

Preferences.

View ~ Change Module ~ = & Mick Fleetwood ~

= asBank Client 1

‘ | /# preferences

® Logout

¥ API Tokens

2. The Preferences page appears.

Preferences

Default Pages

Default Module

- select - v

Default PRO-CHEX Page

- default - v

Default Dashboard Page

- default - v

Save

3. Default Module gives the User the ability to choose the default landing page.

Preferences
Default Pages

Default Module

- select - v

PRO-CHEX
Dashboard
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4. Default Check Positive Pay (PRO-CHEX) Page allows the user to select the default landing page

within PRO-CHEX.

Preferences
Default Pages

Default Module

PRO-CHEX ¥

Default PRO-CHEX Page

- default - v

Manage / Additional Issue Fields
Manage / Issue Templates
Perform / Issue File Load
Perform / Manual Issue Entry
Reports / Issue Item Status

Reports / Scheduled
View / Issue File Status
View / Issue Warehouse

View / Item Lookup
View / Transaction History

5. Default Dashboard Page allows the user to select the default landing page within the Client

Dashboard.

Preferences
Default Pages

Default Module

PRO-CHEX v

Default PRO-CHEX Page

- default - v

Default Dashboard Page

- default - v

Manage Users

Reports / Audit Report
Reports / Notification Delivery Report

Transaction View

6. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved
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APPENDIX A — CHECK POSITIVE PAY (PRO-CHEX) MESSAGE ALERTS

This Appendix illustrates the different types of alerts users may receive while using Check Positive Pay (PRO-CHEX).

Please note the following:

e |[f a cell phone number is entered in the Cell Phone Number field in the user’s setup (FI or Client user), the user may receive SMS/Text Alerts
if the user is set up for Check Positive Pay (PRO-CHEX) and/or ACH Credit Origination Protection (C.O.P.S.).

e Service Level Alerts are not included in this list, since they apply only to Check Positive Pay (PRO-CHEX), ACH Positive Pay (PRO-TECH,
PRO-TECH CR), and EDI Translation (EDI TransAlert). If a user is set to receive Service Level Alerts, the user will receive a service level
alert for all the client’s accounts, which may include accounts a user is not assigned to work with.

e Alkami (formerly ACH Alert) uses a 10-digit long code (10DLC) number for generating SMS/Text Alerts. The long code number, which will
appear in any SMS/Text Alerts received, is 12029808159. This phone number may appear formatted as a ten-digit phone number
(1-202-980-8159).

© 2024 Alkami Technology, Inc.
Proprietary and Confidential Information

Alert Type Example Image Description Recipient
PRO-CHEX An alert per account sent to FI & Client
Cleanup [EXTERNAL] PRO-CHEX Cleanup Reminder Alert (&l & | | users when afile is loaded
Reminder after the cleanup deadline,
Alert (Emall) @  support@achalert.info Tue, Nov1,2022, 415PM & which rGQUireS attention
@ o before EOD.

Thank you for using PRO-CHEX]!

Afile loaded after the cleanup deadline requires attention before EOD. Your EOD is at 11/01/2022 06:00 PM US/Eastern.

Have a fabulous cjay!
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Alert Type Example Image Description Recipient
PRO-CHEX An alert per account sent to Fl & Client
Cleanup o Tie Badariarer users when a file is loaded
Reminder . after the cleanup deadline,
the cleanup deadline ; ; )
Alert . : which requires attention
(SMS/Text) [EHHITES SuSTon before EOD.
before EOD. Your EOD
is at 03/04/2022 03:00
PM US/Eastern. "
PRO-CHEX An alert notifying EOD has Fl & Client
EOD [EXTERNAL] PRO-CHEX EOD Completed been completed and listing
Completed the day’s return count.
(Emall) & support@achalert.info
. tome -
Thank you for using PRO-CHEX]
PRO-CHEX EOD Completed.
Today's Return Count: 11
Please do not reply to this email. If you have questions about your account, please visit our website at the link below.
Contact Us
Have a Wonderful Day!
PRO-CHEX If the FI has enabled the FI & Client
Issuance EQD [EXTERNAL] PRO-CHEX Issuance EOD Completed Release Issue Files flag in
Completed the admin portal, issue files
(Email) voachalert.inf will be held until the issuance
; tsoulf:':c't @achalert.info file deadline hour. This alert
is sent notifying that Issuance
PRO-CHEX Issuance EOD Completed. EOD has been reached.
Please do not reply to this email. If you have guestions about your account, please visit our website at the link
below.
Contact Us
Version 2.2.0
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Alert Type Example Image Description Recipient
PRO-CHEX If Fl is sending issue files to FI & Client
EalmnEe e [EXTERNAL] PRO-CHEX Issuance File Generated i
Generated on behalf of Clients, this alert
(Email) ‘ is sent to users with the

:”"""”@““a'e”"“h system alerts flag enabled

ome when an issue file is

Thank you for using PRO-CHEXI generated'

PRO-CHEX Issuance File Generated.

Please do not reply to this email. If you have questions about your account, please visit our website at the link

below.

Contact Us

Have a Wonderful Day!
PRO-CHEX An alert per account sent to Client
Account Level [EXTERNAL] Check Positive Pay Alert (&l a [ || users for exceptions and any
Notification matched items.
for A" CheCks prochex@fphq.us Wed, Apr 5, 8:27AM (1day ago) % “
(Email) tome

We have received one or more checks to Bob's Grocery ending In X¥xx1525.

Log in to Check Positive Pay to review.

Smcerely.

ACH Alert Sales

Contact Us

Please do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or

email us at support@example.com

ACH Alert Sales

123 Any st

Chattanooga, TN 37421
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Alert Type Example Image Description Recipient
PRO-CHEX An alert per account sent to Client
Account Level Checks received for users for exceptions and any
Notification XXXX2222. matched items.
for All Checks
Sl EE, Log in to PRO-CHEX to
review.

PRO-CHEX An alert per account when Client
Account Level [EXTERNAL] Check Positive Pay Alert (& one or more exceptions exist
Notification requiring a decision.
for prochex@fphg.us
Exceptions ome v
(Emall) We have received one or more checks to Bob's Grocery ending in xox1525.

Log in to Check Positive Pay to review.

Sincerely,

ACH Alert Sales

Contact Us

Please do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or

email us at support@example.com

ACH Alert Sales

123 Any st

Chattanooga, TN 37421
PRO-CHEX An alert per account when Client
Account Level Checks received for one or more exceptions exist
Notification XXXX2222. requiring a decision.
for
FS"G‘;I;';:’X';)S Log in to PRO-CHEX to

review.
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Alert Type Example Image Description Recipient
PRO-CHEX An alert per transaction that a | Client
I;a:,r;slactlon [EXTERNAL] PRO-CHEX Alert (@il = check may require a decision
NOtiﬁcation ® support@achalert.info Wed, Apr 5, 4:46 PM (1day ago)
for All Checks ® v
(Email)

Thank you for using PRO-CHEX!

We have received a check with serial #418511 fo Quattro Formaggi ending in xxxx4444 for $.75.

Log in to PRO-CHEX to review.

Have a great day!
PRO-CHEX An alert per transaction that a | Client
Transaction Check received check may require a
e for xxxx1111 for decision:
:k:tzllfa(l:taonk $15.00 from The One
(gMS ITexte)c S Restaurant & Bar.

Login to Check Positive
Pay to review.

PRO-CHEX An alert per transaction when | Client
Transaction [EXTERNAL] PRO-CHEX Alert (@i z | | @an exception exists that
Level requires a decision.
Notification ® support@achalert.info Wed, Apr 5, 4:46 PM (1day ago)
fOI‘ . tome =
Exceptions _
(Email) Thank you for using PRO-CHEXI

We have received a check with serial #418511 to Quattro Formaggi ending in xxxx4444 for $.75

Log in to PRO-CHEX to review.

Have a great day!
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Alert Type Example Image Description Recipient
PRO-CHEX An alert per transaction when | Client
Transaction Check received an exception exists that
Level for 1111 for requires a decision.
:f;t'ﬂcat'on $15.00 from The One
Exceptions Restlaurant & Bar. N
(SMS/Text) Login to Check Positive
Pay to review.
PRO-CHEX If the FI has enabled this Client
Issuance [EXTERNAL] PRO-CHEX Issuance Load Failed @i & || feature for Clients, this alert
Load Failure will be sent to Clients with the
Client Alert stansec@achalert.net 3:29PM (2hoursago) ¢ & issue load alerts priViIege
. [ 4 - d . .
(Email) @ oldelzere ~ enabled when an issue file
_ loaded through the Client
The Issuance file 04.06.2023 - Upload.csv loaded for 1001 was not processed successfully. Please log in to review. portal has issues that prevent
Sincerely it from loading successfully.
Standard Security
Contact Us
Please do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or
email us at stansec@achalert.net
Standard Security
213 Main
any, TN 12345
PRO-CHEX If the FI has enabled this Client
Issuance o I nee File: feature for Clients, this alert
Load Failure ssua Ee & will be sent to Clients with the
Client Alert ASBank_CSV_lssue_04 issue load alerts privilege
(SMS/Text) 13__ASBC1_.csv enabled when an issue file
Client Code: ASBC1 loaded through the Client
Successful: No portal has issues that prevent
Please log in to review. W it from loading successfully.
Version 2.2.0
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Alert Type Example Image Description Recipient
PRO-CHEX If the FI has enabled this Client
Issuance feature for Clients, this alert
Load Success [EXTERNAL] PRO-CHEX Issuance Load Completed will be sent to Clients with the
Client Alert . issue load alerts privilege
(Email) O f”"':°""@a°ha'e”"“'° enabled when an issue file
® o loaded through the Client

Thank you for using PRO-CHEX! portal loads successfully.

The Issuance file JP01 Issue 0422-001 xlsx loaded by All Services Bank was successfully processed.

Iltem Count: 15

Total: 12409.84

Please do not reply to this email. If you have questions about your account, please visit our website at the link below.

Contact Us

Have a Wonderful Day!
PRO-CHEX ) If the FI has enabled this Client
Issuance Issuance File: feature for Clients, this alert
Load Success ASBC1_Evens_|ssue will be sent to Clients with the
Client Alert 10142022-001.xIsx issue load alerts privilege
(SMS/Text) Client Codg: ASBCT enabled when an issue file

ﬁg;cgsos‘cxl- I‘;S loaded through the Client

unt:
Total: $12.409.84 portal loads successfully.
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Alert Type

Example Image Description Recipient
PRO-CHEX If the FI has enabled this Client
Issuance [EXTERNAL] Check Positive Pay Issuance Load Contains Ineligible & @ || feature for Clients, this alert
Load with tems (EHEE will be sent to Clients with the
Ineligible issue load alerts privilege
Items — Client = et A (9 heure s enabled when an issue file
. prochex@fphg.us B:5TAM (9 hoursago) ¢y € . e
Alert (Email) tome = loads with errors requiring
review.

The Issuance file 0001_Issue 04062023-001 xIsx loaded by ACH Alert Standard Security FI processed with errors. Please log in

to review

Iltem Count: 35

Total: $26,708.23

Sincerely,

ACH Alert Standard Security FI

Contact Us

Please do not reply to this email. If you have guestions about your account, please call Customer Service at (800) 555-1234 or

email us at prochexsupport@fphq.us

ACH Alert Standard Security FI

8916 Transport Lane

Coltewah, TN 37363
PRO-CHEX ) If the FI has enabled this Client
Issuance Issuance File: ASBCT feature for Clients, this alert
Load with Issue 0422-001.xIsx will be sent to Clients with the
Ineligible Client Code: ASBCT1 issue load alerts privilege
Items — Client Errors: Yes enabled when an issue file
Alert Please login to review. loads with errors requiring
(SMS/Text) review.
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Alert Type Example Image Description Recipient
PRO-CHEX If Active Reconciliation has Client
Reconciliation [EXTERNAL] UAT PRO-CHEX Recon Period Finalization failed (E&ma inbox « & m | | been enabled for Clients, this
Period alert will be sent to Client
Finalization @  ACHAlert-uepl o “oPM@mnuesage) A Admin users when
Falled Finalization of the active recon period failed. f|na||zat|0n Of a reconCIIIatlon
period fails.
Fl: ASBank
Client Code: ASBC1
Account: OctaTest (***5868)
Plzase contact the development team and the FI
Sincerely,
ACH Alert
PRO-CHEX This alert will be sent to Client
EOD [EXTERNAL] PRO-CHEX Reminder Alert (&l & | | Client users with the Change
Reminder Transaction Status user
Alert (Emall) ® support@achalert.info Wed, Apr 5, 5:00PM (1dayago) f & priVilege if exceptions exist
@ - and a user with Change
Transaction Status has not
Thank you for using PRO-CHEX! Iogged into the SyStem at the
The deadline for check positive pay decisions is 04/05/2023 06:00 PM US/Eastem. Log in to review. Fl's designated time. This
Have a great day! alert option will only be
available if enabled by the
financial institution.
If alert method for
PRO-CHEX is set to “None”
for a Client user, they will not
receive the EOD reminder
alert.
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Alert Type Example Image Description Recipient
PRO-CHEX This alert will be sent to Client
EOD o The deadline for check Client users with the Change
Reminder aaitive bav detisions Transaction Status user
Alert p 04 25p2()),22 530 PM privilege if exceptions exist
(SMS/Text) = —L; and a user with Change
US/Eastern. Login to Transaction Status has not
review. 8:30 AM logged into the system at the
FI's designated time. This
alert option will only be
available if enabled by the
financial institution.
If alert method for
PRO-CHEX is set to “None”
for a Client user, they will not
receive the EOD reminder
alert.
PRO-CHEX An alert sent to inform user Client
Dual Decision [EXTERNAL] PRO-CHEX Approval Reminder Alert that transactions involving
Approval dual decision approval are
Reminder ‘achalertinf waiting to be approved or
Alert (Email) ; suppori@achalertinte rejected.
Thank you for using PRO-CHEX!
The deadline to approve check transactions is 03/28/2022 05:00 PM US/Eastern. Log in to review and/or
approve.
Please do not reply to this email. If you have questions about your account, please visit our website at the link
below.
Contact Us
Have a Wonderful Day!
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Alert Type Example Image Description Recipient
PRO-CHEX An alert sent to inform user Client
Dual Decision o The deadline to approve that transactions involving
Approval check transactions is dual decision approval are
Reminder 03/28/2022 06:00 PM waiting to be approved or
geMréIText) US/Eastern. Login to rejected.
review and/or approve.

PRO-CHEX An alert sent to inform user Client
Issuance Dual [EXTERNAL] PRO-CHEX Issue File Pending Approval that an issuance file involving
Approval dual approval is waiting to be
Reminder @ support@achalertinfo approved or rejected.
Alert (Email) . tome ™

Thank you for using PRO-CHEXI

An issue file is pending approval. Log in to review.

Please do not reply to this email. If you have guestions about your account, please visit our website at the link

below.

Contact Us

Have a Wonderful Day!
PRO-CHEX An alert sent to inform user Client
Issuance Dual O An issue file is pending that an issuance file involving
Approval approval. Log in to dual approval is waiting to be
Reminder taviow ' approved or rejected.
Alert i
(SMS/Text)
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Alert Type

Example Image

Description Recipient
PRO-CHEX A service level alert sent to Client
Service Level [EXTERNAL] Check Positive Pay Alert (i ]| LSOO BT el
Alert (Email) transactions are available to
O prochex@fphgq.us Thu, Apr 6, :04AM (1dayago) f 4 decision.
. to ldelagre -

Transactions for Check Positive Pay are available to decision.

Sincerely,

ACH Alert Standard Security FI

Contact Us

Please do not reply to this email. If you have guestions about your account, please call Customer Service at (800) 555-1234 or

email us at prochexsupport@fphg.us

ACH Alert Standard Security Fl

8916 Transport Lane

Ooltewah, TN 37363
PRO-CHEX A service level alert sent to Client
Service Level o Transactions for users to notify that
Alert PRO-CHEX are available transactions are available to
(SMS/Text) to decision. decision.
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APPENDIX B — DOCUMENT REVISION INDEX

A comprehensive list of all revisions made to this document since last publication.

Previous Version: 2.1.9 rev 1 (published 03/04/2024 — Release # a2024.1)
Current Version: 2.2.0 (published 04/30/2024 — Release # a2024.2)

Section Pages Description

Entire Document Miscellaneous screenshots updated to reflect minor
changes in user interface.

p. 2 Added NOTE box informing that the FPHQ Platform
screens are best viewed and supported for desktops
and laptops using approved browsers.

Section IV — Managing Issue Items p. 51 D. Issue Templates — Updated Issuance Date
definition to add more clarity about issuance date
formatting.

p. 96 L. Other Options After Iltem Presentment — Updated

paragraph 3 to note that if a client user does not
have the Pay & Adjust user privilege, the Pay &
Adjust button should not display in the Transaction
History interface for that user.

Section V — Exception Identification | p. 98 Added “Treated as Exception” to table of Exception
Reasons.

Section VI — Managing Check p. 101 A. Transaction History — Updated Serial Number

Presentment definition to note that while check-related MICR,

amount, and payee data are retained for at least
365 days, Check Positive Pay stores check images
for up to 60 calendar days.

p. 102 A. Transaction History — Added “Treated as
Exception” to table of Exception Reasons.

p. 119 B. Optional Actions — Added NOTE box indicating if
a client user does not have the Pay & Adjust user
privilege, the Pay & Adjust button should not display
in the Transaction History interface for that user.

APPENDIX B - QUICKBOOKS ISSUE Removed from Client Guide; will be updated and
FILE EXPORT released as a separate, supplementary guide.
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APPENDIX C — CLIENT USER TRAINING VIDEOS

Client users can access the information contained in the Check Positive Pay (PRO-CHEX) Client
User Guide, presented in training video form, by navigating to the following link.

FPHQ Client Training Videos Main Page (Clicking on the PRO-CHEX button at the top of the screen will filter
only PRO-CHEX videos):
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APPENDIX D —- GENERAL SCHEDULED REPORT FORMATS

The system offers standard scheduled reports for the Fl to configure at the account level.

A.BAIl 2 Report Format

File Format

Delimited flat file

Record Delimiter | Comma ¢,

File Name [Client Code] [Masked Account Number] BAI_[File ID]_YYYY-MM-DD.txt
Example ASBC1_xxxx4680_BAI 72785 2023-12-13.txt
Field Field Name Description Purpose
Code
01 File Header 01,Routing Number,Client Code,YYMMDD,File The file header marks the beginning of a file. It
ID,80,,2/ identifies the sender and receiver of the transmission,
and it describes the structure of the file.
02 Group Header 02,ClientCode,Routing The group header identifies a group of accounts that
Number,1,YYMMDD,HHMM,Currency Code,2/ are from the same originator and includes the same
as-of-date and as-of-time.
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03 Account Identifier and 03,Customer Account Number,,,,,/ This record identifies the account number and reports
Account Status activity summary and account status information.
Summary Summary information may be accompanied by an
item count and funds availability distribution.

16 Transaction Detail 16,Type Code,Amount,Funds Type,Serial This record is used for transmission of detail
Number,Client Code,/ transaction information. Transaction detail may
include two reference numbers and a free-form
alphanumeric text.

88 Continuation Record A Continuation record is used when data exceed the
maximum physical record length, or whenever it is
desirable to continue data into an additional record. It
may follow any record type, including another
“continuation” (88) record.

49 Account Trailer 49,Account Control Total,Number of Records/ The Account Trailer record provides account control
totals.
98 Group Trailer 98,Group Control Total,Number of Accounts,Number This record provides group control totals.
of Record,/
99 File Trailer 99,File Control Total,Number of Groups,Number of This record provides file control totals.
Records/

For more information on the BAI2 format, please visit Microsoft Word - Cash Management 2005.doc (bai.org).

B. Global Template

File Format Delimited flat file

“w

Record Delimiter | Comma ¢,

File Name [Client Code]_[Masked Account Number]_BAI_[File ID]_YYYY-MM-DD.txt
Example ASBC1_xxxx4680_BAIl_72785_2023-12-13.txt
Version 2.2.0
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https://www.bai.org/docs/default-source/libraries/site-general-downloads/cash_management_2005.pdf

Field Field Name Description

Numb

er

1 Client Name Client Name configured during client profile setup

2 Client Code Client Code configured upon client profile setup

3 Acct Name Name of the account the report is generated for

4 Acct Number Account Number the report is generated for

5 Original Serial Serial number on the paid item
Number

6 Serial Number Serial number on the item

7 Issuance Serial | Serial number loaded to the system with the issuance data
Number

8 Original Amount of the incoming paid item
Transaction
Amount

9 Amount Amount on the item

10 Issuance Amount as found in the loaded issuance data
Amount

11 Transaction The date the transaction came in
Date

12 Payment Date Amount the incoming item paid for, if applicable

13 Payee Match Payee match score as calculated by the system, if applicable
Score

14 Payee Match Was payee comparison run for the item, if applicable
Status Name

15 Exception Flag |Y =Yes

N = No
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16 Exception Who identified the exception - Full, FI or Hybrid Matching
Source
17 Returned Date Date the item was returned
18 Return Reason | Descriptions match the return reason descriptions configured for the FI during implementation
Description
19 Pay Reason N/A
Description
20 Issuance Payee | Payee name as loaded the system with the issuance item(s)
Name

C.Global Issuance Template

File Format Delimited flat file
Record Delimiter | Comma “”
File Name [Client Code] [Masked Account Number]_test-issuance_[File ID]_YYYY-MM-DD.csv
Example ASBC1_xxxx4680_test-issuance 74819 2024-01-16.csv
Field Field Name Description
Number
1 Issuance ID Internal ID given to the issuance record
2 Client Code Client Code configured upon client profile setup
3 Client Name Client Name configured during client profile setup
4 Acct Number Account Number the report is generated for
5 Original Serial Serial number on the paid item
Number
6 Issuance Serial Serial number loaded to the system with the issuance data
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Number

7 Issuance Payee Payee name as found in the loaded issuance data, if applicable
Name
8 Issuance Amount Amount as found in the loaded issuance data
9 Issuance Status Status of the issue item - ISSUED, VOIDED, STOPPED (if applicable)
10 Load Date Date the issuance item(s) was loaded to the system
11 Issuance Date The date on the issuance item
12 Match Status The match status of the issuance item when the report was generated - OUTSTANDING, PAID, RETURNED
13 Transaction ID Transaction ID of the incoming paid item, if applicable
14 Transaction Amount of the incoming paid item, if applicable
Amount
15 Payment Date Amount the incoming item paid for, if applicable
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